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Summary of Winter '11 Features and Impact on Salesforce.com Users

Summary of Winter '11 Features and Impact on
Salesforce.com Users
Winter '11 has features that immediately impact all users after the release. You might want to communicate these changes to
your users beforehand so they are prepared. Other features require direct action by an administrator before users can benefit
from the new functionality.
The following table summarizes the Winter '11 features and their impact on users. Review the feature details for the applicable
Salesforce.com Editions.

Chatter the Collaboration Cloud Enhancements
Chatter
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Chatter Search
Files Tab
Chatter Central: Chatter Tab
Using Chatter Filters
View Your People Recommendations
View Your Group Recommendations
Add Chatter Topics to Posts and
Comments
Viewing a Single Update
View Chatter Feeds
Share Chatter Files on Records to
Chatter Feeds
Share Private Files to Chatter Feeds
Perform Actions on the Group Files List
on a Chatter Group
Groups List on Profiles
Group Member Count
Perform Actions on the Files Owned List
on a Chatter Profile
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Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Chatter Groups Enhancements
Chatter Email Digests
Additional Chatter Enhancements
Events and Tasks in Chatter
Events, Tasks, Reports, and Dashboards
Added to Feed Tracking
What To Do Next

Sales Cloud Enhancements
Sales Productivity
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Salesforce for Outlook—Generally
Available
Event and Task Subject Limits Increased
Attachments on Activities
Link to File Detail Page for Chatter Feed
Attachments on Notes and Attachments
“View” is Now “Preview” for Chatter
Feed Attachments on Notes and
Attachments

Quote Templates
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Quote Templates—Generally Available
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Partner Relationship Management
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Caching for Salesforce to Salesforce

Service Cloud Enhancements
Call Center
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Computer-Telephony Integration (CTI)
3.0: Service Cloud Console Integration

Case Management
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.
Available to
Enterprise and
Unlimited
Editions with the
Service Cloud.

Service Cloud Console
Web-to-Case Limit Increased
Daily Limit for On-Demand
Email-to-Case Updated
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Customer Portal
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Portal Usage Analytics
Customizable My Profile Page
High Volume Customer Portal User
License—Generally Available
Security Sharing Sets
Users Field Removed from Customer

Portal Settings

Entitlement Management
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.
Available to
Enterprise and
Unlimited
Editions with the
Service Cloud.

Service Contract Fields Available in
Custom Report Types
Dynamic Milestones for Entitlement
Processes
Updated Status Icons for Entitlements,
Service Contracts, and Contract Line
Items

Salesforce Knowledge
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Chatter Feeds on Articles
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Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

New Visualforce Components for
Improving Custom Article-Type
Templates
New Apex Option for Automatically
Filling Article Fields
Improved PDF Generation on Case
Emails
New API Object for Article Views
New API Object for Article Votes
Weekly Export Includes Salesforce
Knowledge Articles
New Fields on Custom Report Types

Force.com Cloud Apps Enhancements
Analytics
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Real-Time Report Builder—Generally
Available
Dashboard User Switching
Reports and Dashboards Chatter
Chatter Analytics
API Access for Reports and Dashboards
Click-to-Detail for Dashboard
Components
Metric Inline Editing
Improved Chart Validation on Reports
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Globalization
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Language Translation for Force.com
Arabic and British English Support

Apex and Visualforce
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Force.com Apex Code Enhancements
Improved System Log Console
Visualforce Enhancements

Customization
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

API Name Shown for Custom Fields
Rich Text Area Field Enhancements
Changes to rounding in number fields

Search
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Global Search
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Sites
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Sites Self-Registration
Customizable My Profile Page
Sites URL Redirects

Security
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Identity Providers and Service Providers
Configure Start, Login, and Logout
Pages Using Single Sign-On
Federation ID Only Displays To Users
With Adequate Permission
Session Time Out Clarification
Remote Access Application Logo URL
Size Defined
OAuth Version 2.0 Supported
Enforce Password History Now Can
Remember Up To 10 Passwords

User Interface and Other Force.com Platform Enhancements
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No available requires enable this feature.
setup required.
some setup.

User Interface Setting Name Change
New User Interface Header
Browser Support Updates
Custom Settings Data Limits Change
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Web Services API and Developer Tools
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Force.com Flex Framework—Generally
Available
Web Services API Enhancements
Force.com Development as a Service
API Access Privileges on Unmanaged
Packages

Workflow and Approvals
Feature

Automatically
Automatically
Not automatically
Contact
visible to all users.
visible to all
visible. Feature is salesforce.com to
No setup required. administrators. No
available but
enable this feature.
setup required.
requires some
setup.

Visual Process Manager—Pilot
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CHATTER THE COLLABORATION CLOUD

Chatter Search
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

With Winter '11, you can search for Chatter feeds, files, groups, and people in Global Search.

Implementation Tips
•
•
•
•

Enabling and disabling Chatter in your organization automatically enables and disables Global Search.
Enable Chatter by clicking Your Name ➤ Setup ➤ Customize ➤ Chatter ➤ Settings, then clicking Edit and selecting
Enable.
Global Search is not supported in partner portal or Customer Portal.
Only users with supported browsers can use Global Search. See “Supported Browsers” in the Salesforce.com online help.

Searching for Chatter
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

To find Chatter feeds, files, groups, and people:
1. Enter your search terms in the header search box.
You can also search for topics by entering # followed by the topic (such as #SalesReport). In the search results, click Chatter
Feed Results to see all posts and comments that refer to that topic.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.
Chatter files, groups, and people appear on the records search results page. Click Chatter Feed Results at the top of the
page to view Chatter feed search results that include your search terms.
To find all posts and comments on a specific topic:
1. Locate a comment or feed that contains a topic link you're interested in.
2. Click the topic link to view all related posts and comments.
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Chatter Feed Search Results
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Chatter feed Search Results page displays Chatter users' posts and comments that include your search terms.
Note: Feed-tracked changes on records and fields aren't included in search results. For example, if you've enabled
feed tracking on the Billing Address field for the Acme account and modified the Acme billing address, search
results for Acme include Acme — Suzanne Powell Looking for volunteers to help with the Acme account but don't include
Acme — Suzanne Powell changed Billing Street to 10 Main Road.
•
•
•
•

To view the detail pages for Chatter files, groups, and people, click the respective name in the update.
To view a single feed update, click the timestamp below the update, for example, Yesterday at 12:57 AM.
To download or preview files, click Download or Preview next to the file. Preview lets you see the file without downloading
it.
To refine your search, click the search box and select Search Options....
Search options aren't available to Chatter Only users.

To view search results for records, such as accounts, contacts, and Chatter files, groups, and people, click Record Results at
the top of the page.

Files Tab
You can easily upload, store, find, and follow Salesforce.com files in the cloud using the Files tab. This includes files you own
or have access to from Chatter and Salesforce CRM Content. All file types, up to 100 MB, are supported, including everything
from Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs, image files, audio files, and video files.
All files you own or have access to from the All Files, My Files, Files in My Groups, or Files in My Workspaces list views
are available to attach to posts on Chatter feeds. Files are automatically included in All Files, My Files, Files in My Groups,
or Files in My Workspaces when:
•
•

•
•
•

You upload a file to My Files. The file is private and not shared with anyone, but you can view it, perform actions, and
attach it to Chatter feeds.
You or someone else attaches a file to a Chatter feed on the Home tab, Chatter tab, a profile, a group, or a record. This
includes files attached to all public groups, whether you're a member or not, and private groups you're a member of, but
not private groups you're not a member of.
You upload a file to a Salesforce CRM Content workspace.
Someone else uploads a file to a workspace you're a member of.
You or someone else creates a content pack or uploads a Web link in Salesforce CRM Content. You only see content packs
and Web links you have access to.

Implementation Tips
The Files tab is included with Chatter, which is enabled by default after Winter '11.
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Best Practices
•
•
•
•

Get started by viewing the Files tab lists to see files you own or have access to. If you don't see any files, click Upload a
File to upload one to My Files.
Preview, download, and find files to follow. When you follow a file, you see updates to the file in your Chatter feed on the
Home tab.
Search for files using specific list views and by typing terms in the Files tab search box, or the search box at the top of the
page.
Click on the name of a file to see the file detail page.

Files Tab Overview
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Microsoft Office 2007 file previews are currently available through a pilot program.

You can easily upload, store, find, and follow Salesforce.com files in the cloud using the Files tab. This includes files you own
or have access to from Chatter and Salesforce CRM Content. All file types, up to 100 MB, are supported, including everything
from Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs, image files, audio files, and video files.
All files you own or have access to from the All Files, My Files, Files in My Groups, or Files in My Workspaces list views
are available to attach to posts on Chatter feeds. Files are automatically added to one or more of the list views on the Files tab
when:
•
•

•
•
•

You upload a file to My Files. The file is private and not shared with anyone, but you can view it, perform actions, and
attach it to Chatter feeds.
You or someone else attaches a file to a Chatter feed on the Home tab, Chatter tab, a profile, a group, or a record. This
includes files attached to all public groups, whether you're a member or not, and private groups you're a member of, but
not private groups you're not a member of.
You upload a file to a Salesforce CRM Content workspace.
Someone else uploads a file to a workspace you're a member of.
You or someone else creates a content pack or uploads a Web link in Salesforce CRM Content. You only see content packs
and Web links you have access to.

On the Files tab:
•

See all the files you own or have access to and click on specific list views on the sidebar to see a certain group of files:
-

•

•

All Files shows all of the files you own or have access to.
My Files shows all of the files you own.
Files in My Groups shows all files you or other people attached to groups you're a member of.
Files in My Workspaces shows all files you and other people uploaded to workspaces you're a member of and all files
you uploaded to your personal workspace.

Search for files using specific list views and by typing terms in the Files tab search box, or the search box at the top of the
page. The titles, descriptions, and contents of the files are searched. The search results are filtered based on the terms
entered.
Click Upload a File to upload a private file to My Files. You own files you upload.
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•

Files Tab

Click
Follow to receive updates about a file in the Chatter feed. Click in the Following column next to the file
you're following to stop receiving updates about the file.
Click a file name to view the file detail page. You can view detail pages for all files, but you'll only see updates in the Chatter
feed for files you follow.

•
•

Click the Download icon or Preview
icon next to a file. Preview lets you see the file without downloading it.
Click a file owner's name to see his or her profile.

•

To learn who can perform which actions on a file, see the File actions table.
Note:
•
•

For more information about Chatter files and Salesforce CRM Content files, see “What is the difference between
a Chatter file and a Salesforce CRM Content file?” in the Salesforce.com online help
Not all files can be previewed, such as copy-protected PDFs, unknown file types, and any file larger than 25 MB.
For files that can't be previewed, the Preview option isn't available on feeds or list views, and files appear as generic
file type icons in the feed. Some Microsoft Office 2007 features don't display correctly in previews.

Uploading Files
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Upload a file to My Files on the Files tab where you can store, preview, download, follow, and search for the file. Files are
uploaded as private, not shared with anyone, and you are the file owner. Only file owners and users with the “View All Data”
permission can see private files. Private files are indicated by the word “Private” and a lock icon on the file's detail page, and
by a lock icon on file lists. You can search for your private files in Chatter and on the Files tab. You can also share private
files by attaching them to a Chatter feed on the Home tab, Chatter tab, a profile, a group, or a record. When you share a
private file, it's no longer private. All file types, up to 100 MB, are supported, including everything from Microsoft® PowerPoint
presentations and Excel spreadsheets, to Adobe® PDFs, image files, audio files, and video files.
To upload a file to My Files:
1.
2.
3.
4.

Click Upload a File.
Click Browse and select a file from your computer. The file name populates automatically when you select a file.
Optionally, change the file name or add a description.
Click Upload to My Files. The file detail page displays.

Files are also automatically included in All Files, My Files, Files in My Groups, or Files in My Workspaces by:
•
•
•

Attaching a file to a Chatter feed on the Home tab, Chatter tab, a profile, a group, or a record.
Uploading files to Salesforce CRM Content personal and shared workspaces.
Creating content packs or uploading Web links in Salesforce CRM Content.

The Files tab doesn't include:
•
•
•

Documents from the Documents tab
Links attached to a Chatter feed
Attachments, notes, and Google docs from the Notes and Attachments related list

14

Chatter the Collaboration Cloud

Files Tab

Note:
•
•
•
•

The maximum file size you can upload is 100 MB.
You automatically follow files you upload to My Files, attach to a Chatter feed, or upload to a Salesforce CRM
Content workspace.
Files without a file extension or with an unrecognized file extension are listed as “unknown” in the Type column.
To learn who can perform which actions on a file, see the File actions table.

Searching for Files
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Clicking on the Files tab displays Chatter and Salesforce CRM Content files you own and have access to. The twenty-five
most recently modified files are listed by default. You can see a certain group of files by clicking a specific list view on the
sidebar:
•

All Files—All files you own or have access to from Chatter and Salesforce CRM Content, including:
-

-

•

For example, if another Chatter user in your organization shares a file with a group you're a member of, that file shows up
in your All Files list.
My Files—All files that you own from Chatter and Salesforce CRM Content, including:
-

•
•

Files you uploaded to My Files. These files are private and not shared with anyone, but you can view them, perform
actions, and attach them to Chatter feeds.
Files you attached to a Chatter feed on the Home tab, Chatter tab, a profile, a group, or a record.
Files you uploaded to Salesforce CRM Content workspaces you're a member of and your personal workspace.
Files attached by other people to a Chatter feed on the Home tab, Chatter tab, a profile, a group, or a record. This
includes files attached to all public groups, whether you're a member or not, and private groups you're a member of,
but not private groups you're not a member of.
Files uploaded by other people to Salesforce CRM Content workspaces you're a member of.

Files you uploaded to My Files. These files are private and not shared with anyone, but you can view them, perform
actions, and attach them to Chatter feeds.
Files you attached to a Chatter feed on the Home tab, Chatter tab, a profile, a group, or a record.
Files you uploaded to Salesforce CRM Content workspaces you're a member of and your personal workspace.

Files in My Groups—All files you and other people attached to groups you're a member of. The first five groups you're
a member of are listed. If you're a member of more than five groups, click More to see a complete list.
Files in My Workspaces—All files you and other people uploaded to workspaces you're a member of and all files you
uploaded to your personal workspace. The first five workspaces you're a member of, including your personal workspace,
are listed. If you're a member of more than five workspaces, click More to see a complete list.

To search for files using the Files tab search:
1. Optionally, click a list view on the sidebar to restrict your search to a specific set of files.
2. Enter your search terms in the box on the Files tab. The titles, descriptions, and contents of the files are searched.
3. Click Search to see a filtered list of all relevant files based on your search terms. Or click to clear your search terms.
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You can also search for feeds, files, groups, and people by entering search terms in the search box on the top of the page.
The Files tab doesn't include:
•
•
•

Documents from the Documents tab
Links attached to a Chatter feed
Attachments, notes, and Google docs from the Notes and Attachments related list

The following file types and sizes are supported for file search. Files that exceed the maximum size aren't searched.
File Type

File Extensions

Maximum Size

HTML

.htm, .html, .xhtml

5 MB

PDF

.pdf

25 MB

PPT

.ppt, .pptx, .pptm

25 MB

RTF

.rtf

5 MB

Text

.c, .cpp, .css, .csv, .ini, .java,
.log, .sql, .txt

5 MB

Word

.doc, .docx, .docm

25 MB

XML

.xml

5 MB

XLS

.xls, .xlsx, .xlsm

5 MB

Viewing the File Detail Page
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: Microsoft Office 2007 file previews are currently available through a pilot program.

Open a file detail page by clicking a file name on the Files tab, on a Chatter feed, or on a group or profile files list. On the file
detail page, you can see details about Chatter files and Salesforce CRM Content files, but you can only perform actions on
Chatter files. To perform actions on files that originated in Salesforce CRM Content, click Go to Content Detail Page.
From a file detail page, you can:
•

Preview the file without downloading it. If the file has multiple pages, click on the enhanced document player or use the
arrow keys on your keyboard to see each page, zoom in or out, or change the preview width and screen size. Files owners
and anyone with access to the file can preview it.
Note: Not all files can be previewed, such as copy-protected PDFs, unknown file types, and any file larger than
25 MB. For files that can't be previewed, the Preview option isn't available on feeds or list views, and files appear
as generic file type icons in the feed. Some Microsoft Office 2007 features don't display correctly in previews.
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•

See if your file is private. You'll see the word “Private” and a lock icon next to the file name if you haven't shared the file
with anyone. When you upload a file to My Files, it is private. When you attach a private file to a Chatter feed, it is no
longer private.

•

Click Download to open or save the file. File owners and anyone with access to the file can download it.
Click Upload New Version to update the file with a newer version. Only file owners can upload a new version of their
file.
Click Delete to delete the file. File owners and users with the “Modify All Data” permission can delete files.
See who the file is owned by and when it was last modified.

•
•
•
•

Click
Follow to follow the file or click to stop following the file.
See who's following the file.
Click Go to Content Detail Page to see the content detail page of a file that originated in Salesforce CRM Content. Any
actions performed on files that originated in Salesforce CRM Content must be done on the file's content detail page instead
of the file detail page.

•
•

This table describes the actions that can be performed by users with the “View All Data” or “Modify All Data” permission,
and owners of files:
Actions

User with “View All Data”
Permission

User with “Modify All Data”
Permission

Owner

View/Preview

Yes

Yes

Yes

Download

Yes

Yes

Yes

Upload New
Version

Yes

Attach

Yes

Yes

Delete

Yes

Yes

Uploading a New Version of a File
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Upload a new version of a file that you previously uploaded to My Files or attached to a Chatter feed so the latest version is
available on the Files tab and in Chatter. You may want to upload a new version of a file if the contents of the previous version
have changed or if you want to change the title or description of a file. When you upload a new version, a notification is posted
to your Chatter feed on the Home tab and the Chatter tab, and anyone following the previous file will also get a notification
in their Chatter feed. Uploading a new version replaces all previous versions in Chatter.
To upload a new version:
1.
2.
3.
4.

Click Upload New Version on the file detail page.
Click Browse and select a file from your computer. The file name populates automatically when you select a file.
Optionally, change the file name and description.
Click Upload New Version.
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The detail page view now shows your updated file and all previous versions are updated.
Note:
•
•

Only file owners can upload new versions. To learn who can perform which actions on a file, see the File actions
table.
If the file is from Salesforce CRM Content, you can't upload a new version from the file detail page. You can click
Go to Content Detail Page and upload a new version there.

Following Files
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Follow files so you can see updates in your Chatter feed on the Home tab and Chatter tab, including when a new file version
is uploaded. If you stop following a file, the file remains in your Files tab list, you just won't see updates in your feed anymore.
Click
•
•
•
•

Follow to start seeing updates, or click

to stop seeing updates:

On the file's detail page
Next to the file on the All Files, My Files, Files in My Groups, or Files in My Workspaces lists on the Files tab
Next to the file on the Group Files list on a group
Next to the file on the Files Owned list on a profile
Note:
•
•

You automatically follow files you upload to My Files, attach to a Chatter feed, or upload to a Salesforce CRM
Content workspace.
If you follow a file in Chatter that you have previously subscribed to in Salesforce CRM Content, you can unsubscribe
from the file in Salesforce CRM Content because you'll now be receiving updates about it in your Chatter feed.

Deleting a File from the File Detail Page
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Click Delete on a file's detail page to delete the file and remove it from all locations where it's been shared. To restore the
deleted file, click on the Recycle Bin link on the Home tab. Select the file and click Undelete.
Note: Only file owners and users with the “Modify All Data” permission can delete files. To learn who can perform
which actions on a file, see the File actions table.
For more information about deleting files from other places in Chatter, see “Removing and Deleting Files and Links from a
Chatter Feed” in the Salesforce.com online help.
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Understanding Files in Salesforce.com
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

There are several different ways you can use files in Salesforce.com depending on what you want to do and what part of the
app you're in. For example:
•
•
•
•

Upload a file to My Files and store it there privately until you're ready to share it. Share the file by attaching it to a Chatter
feed on the Home tab, Chatter tab, a profile, a group, or a record.
Create, clone, or modify a presentation in Salesforce CRM Content, and then save it so only you can see it or publish it
so other users in your organization can see it.
Add a custom logo to meeting requests by uploading your logo to the Documents tab.
Store pertinent information on a lead's detail page by attaching a note or image to the lead's Notes and Attachments related
list.

For more information about Chatter files and Salesforce CRM Content files, see “What is the difference between a Chatter
file and a Salesforce CRM Content file?” in the Salesforce.com online help
See the following definitions to determine how you want to use files:
Files Tab
You can easily upload, store, find, and follow Salesforce.com files in the cloud using the Files tab. This includes files you
own or have access to from Chatter and Salesforce CRM Content. All file types, up to 100 MB, are supported, including
everything from Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs, image files, audio files,
and video files. All files you own or have access to from the All Files, My Files, Files in My Groups, or Files in My
Workspaces list views are available to attach to posts on Chatter feeds.
The Files tab requires no administration and can be used right away. Files are automatically included in All Files, My
Files, Files in My Groups, or Files in My Workspaces when you or other people share or upload files in Chatter or
Salesforce CRM Content. Files can be shared with a Chatter group or all Chatter users in your organization. If you want
to share a private file (that you uploaded to My Files) with certain people to get their feedback, you can create a private
group, add group members, and then share the file with the group. The group members can preview, download, and
collaborate on the file by sharing comments in the group's feed. You can incorporate their feedback into the file on your
computer and then upload a new version for the group to see. For more information, see Files Tab Overview on page
13.
Salesforce CRM Content
Salesforce CRM Content is where you publish, share, and deliver corporate files.
With Salesforce CRM Content you can organize, share, search, and manage content within your organization and across
key areas of the Salesforce.com application. Content can include all file types, from traditional business documents such
as Microsoft® PowerPoint presentations to audio files, video files, Web pages, and Google® docs.
Salesforce CRM Content requires set up by your administrator and includes workspaces, content packs, and content
deliveries. Users can contribute, search, tag, provide feedback, share, and subscribe to files. Files are stored in fully
searchable file repositories known as workspaces. Administrators can create multiple workspaces based on any classification,
such as department name, job function, or team, then configure user permissions within the workspace to balance content
access with security. Authors assign descriptive labels called tags to help classify and organize content across workspaces.
You can view a list of all content that belongs to a particular tag or filter search results based on a tag or tags. One example
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of how you can use Salesforce CRM Content is to create and deliver content packs. You may want to create a content
pack with a product list, price quote, and contract to send to a particular customer. Using email or instant messaging,
you can distribute the content pack to colleagues in your organization or leads and contacts outside your organization.
The recipient of a content delivery can click a single URL to open a preview player with which he or she can preview and
download the content. You can then view tracking information to see how often the content pack was viewed and which
documents were downloaded. For more information, see “Salesforce CRM Content Overview” in the Salesforce.com
online help.
Documents Tab
The Documents tab is where you store Web resources, such as, logos, DOT files, and other Visualforce materials.
A document library is a place to store files without attaching them to accounts, contacts, opportunities, or other records.
Each document in the document library resides in a folder. The folder’s attributes determine the accessibility of the
folder and the documents within it.
For more information, see “Document Library Overview” in the Salesforce.com online help.
Notes and Attachments
The notes and attachments related list is where you attach and store files related to a specific account, contact, opportunity,
or other record. When you attach a file to a Chatter feed on a record, it's automatically added to the record's notes and
attachments related list as a Feed Attachment. You can also add files directly to the notes and attachments related list.
You can create, view, and edit notes and add attachments from the Notes and Attachments related list on selected detail
pages such as accounts, contacts, leads, opportunities, and products. You can also add attachments from the Attachments
related list on selected detail pages such as cases, solutions, and campaigns.
If Chatter is enabled for your organization, files posted to a feed on a record are added to the record's Notes and
Attachments related list as feed attachments. You can preview (if available), download, and delete feed attachments from
the Notes and Attachments related list, but you can't edit them. You can view feed attachment details by clicking on
the title of the file.
For more information, see “Viewing and Editing Google Docs, Notes, and Attachments” in the Salesforce.com online
help.

Chatter Central: Chatter Tab
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Chatter tab shows updates for all the records and people you're following as well as for the groups you've joined. From
the Chatter tab you can:
•
•
•

Filter your feed
View Your People Recommendations
View Your Group Recommendations

Implementation Tips
Enabling Chatter in your organization automatically inserts the Chatter tab next to the Home tab in most apps.
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Using Chatter Filters

You asked for it! This enhancement is from an idea on the IdeaExchange.
Feed filters display a subset of updates in your Chatter feed on the Chatter tab.
All Chatter
Displays all Chatter feed updates, including posts, status updates, group updates, and record updates.
To: Me
Displays posts others make to your Chatter feed.
People
Displays only updates for people you follow. Because you follow yourself, your own updates also display in the People
filter.
Groups
Displays only updates for groups you are a member of.
Records (for example, Accounts or Opportunities)
Displays only updates for records you are following, including custom object records. You'll only see a filter if you're
following at least one of that type of record. For example, if you're not following any contacts, then no Contact filter
will display.

View Your People Recommendations
Chatter recommends people in your organization that you might want to follow based on similar interests. For example,
Chatter recommends people who:
•
•

Follow the same people as you. This means you have connections in common.
Are in your management hierarchy, such as your manager, people who report to your manager, and people who report to
you.
Salesforce.com uses the Manager field on the personal information page to determine these recommendations. If this field
is blank, Chatter won't recommend people based on your management hierarchy. Only your Salesforce.com administrator
can edit the Manager field.

•
•

Are popular, which means they have many followers.
Are new to Chatter.

View your recommendations on the right side of the Chatter and People tabs. To see an expanded list of your recommendations,
click More. If no recommendations appear, then you're already following all the recommended people.
When viewing your recommendations, you can:
•
•
•
•

Click Follow to follow a person.
Click “x” to dismiss a recommendation so it doesn't appear again. You can always go to the People tab and find that person
if you want to follow them later.
Click the link below the person's name to see the connections you have in common.
Click the person's name to view his or her profile.
Note: If your organization has fewer than 16 people, you automatically follow everybody, so no people are recommended.
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View Your Group Recommendations
Chatter recommends groups that you might want to join based on:
The popularity of the group determined by the number of members.
The number of people you're following in the group. Chatter recommends groups with the most members that you're
following.
If the group is new (created in the last month).

•
•
•

View your recommendations on the right side of the Chatter and Groups tabs. To see an expanded list of your recommendations,
click More.
Chatter only recommends public groups. Private groups aren't included in recommendations. If no recommendations appear,
then you're already a member of all the recommended groups.
When viewing your recommendations, you can:
Click Join to become a group member.
Click “x” to dismiss a recommendation so it doesn't appear again. You can always go to the Groups tab and find that group
if you want to join it later.
Click the group's name to view more information about the group, including recent posts.

•
•
•

Chatter Feeds Enhancements
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Events, Tasks, Reports, and Dashboards Added to Feed Tracking
In Winter '11, you can enable feed tracking on events, tasks, reports, and dashboards. Now your users can track the progress
of important tasks and get notified of calendar and meeting updates directly in their feeds. They can also be notified about
changes to reports and dashboards.
Unlike other records, you don't auto-follow events, tasks, or dashboards in Chatter after you create them.
Note: Feed tracking for events doesn't include requested meetings. Once a requested meeting is confirmed and
becomes an event, then it can be included in feeds.
To set up feed tracking:
1.
2.
3.
4.
5.
6.

Click Your Name ➤ Setup ➤ Customize ➤ Chatter ➤ Feed Tracking.
Select an object.
Select Enable Feed Tracking. The user and Chatter group objects don't have this checkbox.
Select up to 20 fields to track. You can't select fields for article types.
Click Save.
Optionally repeat steps 2 through 5 for additional objects.

For more information on feed tracking in Chatter, see “Customizing Chatter Feed Tracking” in the Salesforce.com online
help.

View Chatter Feeds on Articles
If Salesforce Knowledge article types are enabled for Chatter feed tracking, knowledge base users can follow a published article
and see updates in their Home tab feed when the article is removed from publication, republished, or archived. New in Winter
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'11, enabling an article type for feed tracking also creates a Chatter feed in published articles. The feed allows readers to get
a sense of the article's history, contribute comments, and see comments from other readers.

Share Chatter Files on Records to Chatter Feeds
You can now share a Chatter file on a record by attaching it to a Chatter feed on the Home tab, Chatter tab, a profile, a group,
or a record. On a feed, click File and Select a file from Salesforce. Search for your file from the Select a File to Attach list,
click Attach, and then click Share.
Note:
•
•

You only see files on records that you have access to.
Files attached to a Chatter feed on a record are automatically added to the record's Notes and Attachments related
list and are called Feed Attachments. Feed Attachments are included in search results and available to attach to
other Chatter feeds. Files attached directly to a record's Notes and Attachments related list are called Attachments.
Attachments aren't included in search results and aren't available to attach to Chatter feeds. If you don't see the
Notes and Attachments related list on your page layout, contact your administrator.

Share Private Files to Chatter Feeds
With Winter '11, you can upload a file to My Files so you can store, preview, download, search for, and share the file. When
you upload a file to My Files, it's added as private, not shared with anyone, and you are the file owner. Private files are indicated
by the word “Private” and a lock icon on the file's detail page, and by a lock icon on file lists. You can search for your
private files in Chatter and on the Files tab, and share them by attaching them to a feed on the Home tab, Chatter tab, a
profile, a group, or a record. On a feed, click File and Select a file from Salesforce. Search for your file from the Select a File
to Attach list, click Attach, and then click Share. When you share a private file, it's no longer private.

Add Chatter Topics to Posts and Comments
In Winter '11, when you post an update in Chatter, you can associate your update with all other posts and comments on the
same topic by adding a topic link. A topic link is a way to tag and categorize your update so other people can find it more
easily. Topic links are similar to hashtags used in other social networking sites.
For example, if you post an update that you're working on a sales presentation for your customer Universal Paper, you might
want to add the topic link #UniversalPaper in your update. If your coworkers use the same topic link in their updates, anyone
can click the topic link to view all related comments and posts. Topic links become more valuable as more people use them.
To create a topic link in an update:
1. Enter # followed by any word. Spaces, tabs, and new lines automatically end a topic link, as well as the special characters
noted below.
Topic links aren't case-sensitive, so #UniversalPaper is the same as #universalpaper.
2. Post your update.
The word you entered after “#” becomes a link that others can click on to view all posts and comments that use the same
topic link.
Once you post an update, the only way to delete a topic link is to delete the entire post or comment. Chatter administrators
can't restrict which topic links are used.
The following characters can't be included in a topic link. For example, if you enter “#Sales.Report” in your update, only
“#Sales” becomes a topic link.
•
•
•

. (period)
, (comma)
; (semi-colon)
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: (colon)
( ) (left and right parenthesis)
& (ampersand)
! (exclamation point)
“” (beginning and ending quotes)
' (apostrophe)
/ \ (back and forward slashes)
| (pipe)
# (hash)
@ (at sign)
% (per cent)
+ (plus)
= (equals)
$ (dollar)
^ (caret)
~ (tilde)
[ ] (left and right square bracket)
{ } (open and close curly brace)
< > (left and right angle bracket)
* (asterisk)

Viewing a Single Update
You can view a single Chatter update in a feed for a user, record or group.
•
•
•

In a Chatter feed, click the timestamp displayed below the update, for example, Yesterday at 12:57 AM.
In a Chatter email notification, click the link in the body of the email to view only the related update.
To view the full feed, above the update, click All Updates.

Chatter Groups Enhancements
Group Recommendations
The right side of the Groups tab lists the groups that Chatter recommends you join based on:
•
•
•

The popularity of the group determined by the number of members.
The number of people you're following in the group. Chatter recommends groups with the most members that you're
following.
If the group is new (created in the last month).

For more information, refer to “Viewing Your Chatter Group Recommendations” in the Chatter Central: Chatter Tab section
of these release notes.

Perform Actions on the Group Files List on a Chatter Group
The Group Files list on a Chatter group shows the five most recent files posted to that group. You can preview or download
files directly from this list.
To see a list of all the files posted to a group or to search for a specific file, click Show All. The twenty-five most recently
modified files are listed by default. On the Files Shared with list you can:
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•

Search for files that have been posted to the group. The list includes files that you and other people have attached to the
Chatter feed on the group. The list doesn't include:
-

•
•
•
•

Chatter Groups Enhancements

Documents from the Documents tab
Links attached to a Chatter feed
Attachments, notes, and Google docs from the Notes and Attachments related list

Click
Follow to receive updates about a file in the Chatter feed. Click in the Following column next to the file
you're following to stop receiving updates about the file.
Click a file name to view the file detail page. You can view detail pages for all files, but you'll only see updates in the Chatter
feed for files you follow.
Click the Download icon or Preview
icon next to a file. Preview lets you see the file without downloading it.
Click a file owner's name to see his or her profile.
Note:
•

•

Not all files can be previewed, such as copy-protected PDFs, unknown file types, and any file larger than 25 MB.
For files that can't be previewed, the Preview option isn't available on feeds or list views, and files appear as generic
file type icons in the feed. Some Microsoft Office 2007 features don't display correctly in previews.
Files without a file extension or with an unrecognized file extension are listed as “unknown” in the Type column.

Groups List on Profiles
The Groups list on your profile shows you the Chatter groups you're a member of. If you're not a member of any groups, click
Join or create groups to view the Groups tab and join some groups. You can also view the Groups list on other people's profiles
to see their group memberships.
Click Show All to view the full list in alphabetical order.
•
•
•
•
•

Use the Next and Previous links to see more of the list.
Click to leave a group you're a member of.
On another person's groups list, click Join to join a public group.
On another person's groups list, click Ask Owner next to a private group to view the group owner's profile. You can then
ask the owner to add you to the group.
Click Done to close the window.

Group Member Count
The new Members column on the Groups tab allows you to view the number of members in each group, and to sort the list
by member count. Additionally, the MemberCount field is available on the CollaborationGroup API object; see Web Services
API Enhancements.

Group Email Digests
In Winter '11, you can receive Chatter email digests from your groups. Group digests include updates about a particular group,
and are configureable on a group-by-group basis. See Chatter Email Digests on page 26.
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Chatter Profiles Enhancements
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Perform Actions on the Files Owned List on a Chatter Profile
The Files Owned list on a profile shows the five files the profile owner attached most recently to a Chatter feed on the Home
tab, Chatter tab, a profile, a group, or a record. It also includes files the profile owner has uploaded most recently to Salesforce
CRM Content workspaces. You can preview or download files directly from this list.
To see a list of all the files the profile owner has attached and uploaded, or to search for a specific file, click Show All. The
twenty-five most recently modified files are listed by default On the Files Owned by list you can:
•

Search for files the profile owner has attached and uploaded in Chatter and Salesforce CRM Content. The list doesn't
include:
-

•
•
•
•

Documents from the Documents tab
Links attached to a Chatter feed
Attachments, notes, and Google docs from the Notes and Attachments related list

Click
Follow to receive updates about a file in the Chatter feed. Click in the Following column next to the file
you're following to stop receiving updates about the file.
Click a file name to view the file detail page. You can view detail pages for all files, but you'll only see updates in the Chatter
feed for files you follow.
Click the Download icon or Preview
icon next to a file. Preview lets you see the file without downloading it.
Click a file owner's name to see his or her profile.
Note:
•
•

•

Only files you have access to are listed. For example, if the profile owner posted a file to a private group or workspace
you're not a member of, you won't see that file in the list.
Not all files can be previewed, such as copy-protected PDFs, unknown file types, and any file larger than 25 MB.
For files that can't be previewed, the Preview option isn't available on feeds or list views, and files appear as generic
file type icons in the feed. Some Microsoft Office 2007 features don't display correctly in previews.
Files without a file extension or with an unrecognized file extension are listed as “unknown” in the Type column.

Groups List
See Groups List on Profiles.

Chatter Email Digests
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

In Winter '11, you can receive Chatter user email digests, as well as digests from your groups.
User digests include updates from your Chatter feed, such as updates about the people, files, and records you follow and your
groups. Group digests include updates about a particular group, and are configureable on a group-by-group basis.
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When configuring your user and group digests, specify whether you want to receive each digest daily or weekly. Daily digests
include the 25 latest posts from the previous day while weekly digests include the 50 latest posts from the week. Both include
the three latest comments on each post. Alternatively, when configuring group digests, you can choose to receive an email
every time someone posts to the group.
To configure your email digests:
1. Click Your Name ➤ My Settings at the top of any page, then click Email Settings. You can also click Your Name ➤
Setup ➤ My Chatter Settings ➤ Chatter Email Settings.
2. Select Receive Chatter Emails to receive Chatter email.
Caution: Deselecting this option prevents you from receiving all Chatter email notifications.

3. Use the checkboxes and radio buttons to indicate the types of Chatter email you want to receive. You can configure different
digest settings for each group.
4. Click Save.

Additional Chatter Enhancements
Events and Tasks in Chatter
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

In Winter '11, you can now follow individual tasks and events. Follow a task you've assigned to someone else to track its
progress, or follow an event to get notified of scheduling changes.
When you follow an activity, your Chatter feed on the Home tab includes field changes and activity feed updates.
•
•

To follow an activity, click
Follow. To stop following, click Following .
The Followers list shows you who is following the activity. To view a full list, click Show All.

When following tasks or events in Chatter, consider that:
•
•
•

You can't follow recurring events and tasks in Chatter, nor individual instances of recurring events and tasks. Changes to
an individual event or task in a recurring series or to the series itself won't show up in your Chatter feed.
Unlike other records, you don't auto-follow events or tasks in Chatter after you create them.
Feed tracking for events doesn't include requested meetings. Once a requested meeting is confirmed and becomes an event,
then it can be included in feeds.

Packaging Applications that Use Chatter
Available in Developer Edition

The objects, field settings, and field settings history of Chatter are packageable. However, an object's field is only tracked if
the object itself is tracked. For example, you can create a new custom field on the Account standard object, but the field will
only be tracked if you have enabled feed tracking on Accounts.
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When developing applications that use Chatter, it's important to be aware that some organizations may not have Chatter
enabled. By default, when you upload Chatter applications, the package is only available to organizations that have Chatter
enabled. You can change this behavior and allow organizations to install the package even if they don't have Chatter. Note
the following:
•
•

•

You must use a managed package. Unmanaged packages that include Chatter functionality can only be installed in
organizations that have Chatter enabled.
All DML, SOSL, and SOQL exceptions will throw a runtime exception if the subscriber organization does not have
Chatter enabled. You must catch and handle any Apex exceptions that are thrown as a result of the missing Chatter feature.
These exceptions are of the type REQUIRED_FEATURE_MISSING for SOSL and SOQL calls. For DML calls, you must
check for the specific REQUIRED_FEATURE_MISSING status code on a DML Exception. The following code sample
illustrates one way to handle this type of exception.
When you upload the package, deselect the Chatter required checkbox (this is automatically selected if you have an Apex
reference to Chatter).
Note: If the Chatter required checkbox can't be deselected, then some component in the package has a special
requirement for Chatter. This may happen, for example, if you package a custom report type that relies on Chatter.
If the Chatter required checkbox can't be disabled, then the package can only be installed in organizations that
have Chatter enabled.

The following example tries to post to feeds and get a user's feed. If Chatter is not enabled in the organization, the code catches
the REQUIRED_FEATURE_MISSING exception. Note that this is an incomplete code example and does not run.
public void addFeedPost(String post, Id objId) {
FeedPost fpost = new FeedPost();
// Get the parent ID of the feed, such as an Opportunity ID
// or a custom object ID.
fpost.ParentId = objId; .
fpost.Body = post;
try{
insert fpost;
} catch (System.DmlException e) {
for (Integer i = 0; i < e.getNumDml(); i++) {
// Chatter not endabled in the organization
// do not insert record
System.assertEquals(StatusCode.REQUIRED_FEATURE_MISSING, e.getDmlType(i));
System.Debug('Chatter not enabled in this organization:' + e.getDMLMessage());
}
}
}
public List<NewsFeed> getMyFeed() {
List<NewsFeed> myfeed;
try{
myfeed = [SELECT Id, Type, CreatedById, CreatedBy.FirstName,CreatedBy.LastName,
CreatedDate, ParentId, Parent.Name,FeedPostId, FeedPost.Body,
FeedPost.Title, FeedPost.CreatedById, FeedPost.LinkUrl,
(SELECT Id, FieldName, OldValue, NewValue
FROM FeedTrackedChanges ORDER BY Id DESC),
(SELECT Id, CommentBody, CreatedDate, CreatedById,
CreatedBy.FirstName, CreatedBy.LastName
FROM FeedComments ORDER BY CreatedDate DESC, ID DESC LIMIT 10)
FROM NewsFeed
ORDER BY CreatedDate DESC, ID DESC
LIMIT 20];
} catch(System.RequiredFeatureMissingException e){
// The above has returned an empty NewsFeed
// Chatter is not enabled in this organization
myfeed = new List<NewsFeed>{};
System.Debug('Chatter not enabled in organization:' + e.getMessage());
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}
return myfeed;
}

Visualforce Components for Chatter
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Visualforce now supports the following Chatter components:
•
•

<chatter:feed>: Displays the Chatter feed for a record.
<chatter:feedWithFollowers>: An integrated UI component that displays the Chatter feed for a record, its list of

•
•

followers, and optionally, a header bar that allows users to show or hide the Chatter feed and subscribe to it.
<chatter:follow>: Renders a button for a user to follow or unfollow a Chatter record.
<chatter:followers>: Displays the list of Chatter followers for a record.

In addition, the <apex:detial> component has a new showChatter attribute that specifies whether to display the Chatter
feed, followers list, and header bar for the record.
Note: Chatter components don't render for organizations that aren't Chatter enabled. Chatter components don't
render for Visualforce pages using Force.com sites.

What To Do Next
In Winter '11, we're introducing a new way to help you get started using Chatter. The What To Do Next checklist provides
suggested tasks based on where you are in Chatter. Click a task and you are taken to the right place and given further instruction.
As you complete the tasks, they are crossed off the list. Additionally, if you want to skip a task, you can click the x next to it
and it is removed from the list. Once you complete all tasks, the list disappears.
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Salesforce for Outlook—Generally Available
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions
With Winter '11, Salesforce for Outlook is generally available! Salesforce for Outlook is a Microsoft® Outlook® integration
application that lets you log emails in Salesforce.com and sync contacts and events between Outlook and Salesforce.com.
With Salesforce for Outlook, you can:
•
•
•

Sync data automatically in the background
Add email to Salesforce.com in a single click
Manage administration settings in the cloud

Get started with Salesforce for Outlook in a few simple steps.
Administrators of Professional, Enterprise, Unlimited, or Developer Editions
1. Create a configuration and assign users to it.
2. Define settings and add data sets.
3. Activate the configuration and have users install.
Administrators of Contact Manager or Group Editions
1. Review the default configuration for your organization.
2. Have users install.
Users
1. Review your configuration.
2. Install and set up Salesforce for Outlook.

You asked for it! Salesforce for Outlook addresses the following ideas on the IdeaExchange: add sync for multi-day
events, add “email added” indicators, enhance filtering of synced contacts, prevent duplicate contacts, move administration
settings to the cloud, search contact roles when adding emails, allow syncing all events, provide simple contact sync, and provide
support for Windows 7 64-bit and Outlook 2010.

Salesforce for Outlook vs. Connect for Outlook
If you're upgrading from our previous Outlook integration application, Connect for Outlook, note these key differences.
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Connect for Outlook

Salesforce for Outlook

What syncs?

Only the contacts, tasks, and events that All data from the contact and calendar
you manually mark for sync.
folders that you select. Tasks don't sync.

How does it sync?

You manually click Sync. You may be
configured to automatically sync.

You do nothing. Your data syncs
automatically in the background.

How are contacts and emails associated In Outlook, you manually specify related Records are associated automatically in
with Salesforce.com?
records for each item you're syncing.
the cloud. Items we're not sure how to
associate go to your My Unresolved
Items page in Salesforce.com, where you
can easily select related records.
How are emails associated with
Salesforce.com?

In Outlook, you manually specify related Emails are automatically associated to
records for each email you're adding.
related records based on your Email to
Salesforce settings.

Where are administration settings
managed?

In Outlook by the user.

Do recurring events and event attendees Recurring events sync as individual
sync?
events. Event attendees don’t sync.

In Salesforce.com by the administrator.
Administrators can grant permission to
users to customize their settings.
Recurring events and event attendees
don't sync.

Implementation Tips
•
•
•
•

You can define Salesforce for Outlook configurations for sets of users in Salesforce.com based on job function. For example,
you may have separate configurations for Sales Managers, Sales Engineers, and Account Executives.
Mark a configuration Active when you're ready to use it.
Set up a data set for every object that is configured to sync.
Use field mappings to link Salesforce.com fields with Outlook fields.

Best Practices
•

•
•

Salesforce for Outlook uses Outlook folders to limit which records sync with Salesforce.com. Before you complete the
Salesforce for Outlook setup wizard, make sure the folders you want to sync contain the right records. If you're syncing
both ways or syncing Outlook to Salesforce.com, moving a record out of a synced Outlook folder deletes that record in
Salesforce.com. If you're syncing both ways or syncing Salesforce.com to Outlook, removing a record from Salesforce.com
deletes that record in Outlook.
Salesforce for Outlook uses data sets to limit which contacts sync from Salesforce.com to Outlook. Work with your
administrator to set up the data set that works best for you.
Enter a company name when you create a contact in Outlook. This helps us automatically assign that contact to its related
Salesforce.com account so you don't have to manually assign it in Salesforce.com.

Limitations
•
•
•

Events aren't automatically associated with related Salesforce.com records when they sync from Outlook. Users must
manually assign an event to related records using My Unresolved Items.
The following items don't sync: events with locations longer than 80 characters, recurring events, all-day events beginning
on the first day you're configured to sync, and event attendees. Multiday events sync as single events in either direction.
Rich-text formatting from Outlook doesn't sync. If an Outlook event with rich-text formatting syncs both ways, it syncs
back to Outlook as plain text, overwriting any formatting in the original version.
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The Windows time zone must match the time zone set in the user's Salesforce.com profile. For supported time zones, see
“Salesforce for Outlook System Requirements” in the Salesforce.com online help.
When selecting sync folders in the setup wizard, follow these guidelines: You can use your default folders or click Change
Folder and select or create a folder that's within your default folders or the main Mailbox folder.
You must define a data set for any object that has a sync direction. Otherwise, the object won't sync, and the user's
configuration won't display a filter for that object.
You can't map picklist values in Salesforce for Outlook configurations.
Advanced filters aren't available in Salesforce for Outlook configurations. This means you can't combine filters, as in
filter 1 OR (filter 2 AND filter 3).
Add Email limitations:
-

•
•
•
•
•

Email attachments aren't added to Salesforce.com.
If you configure Email to Salesforce to associate emails to matching opportunities, Salesforce.com searches the To and
CC fields for the email addresses of your contacts. If contacts are found, Salesforce.com saves the email to the Activity
History related list on all open opportunities for which the contact is assigned a contact role.

Salesforce for Outlook isn't fully 508-compliant.
Salesforce for Outlook doesn't currently support single sign-on (SSO).
If you rename tabs in Salesforce.com, such as changing Contacts to Candidates, those new names aren't reflected in
Outlook or the scopes and filters of data sets.
A shortcut to Salesforce for Outlook remains in the Start menu of Microsoft Vista users who upgrade and then remove
Salesforce for Outlook. The shortcut is removed when they restart their system.
Microsoft Vista and Windows 7 users who want to use the .msi installer must run the command prompt an administrator
and then launch the installer from the command line, such as from the command msiexec /i
SalesforceForOutlook.msi.
Note: For details on what has changed since the Summer '10 pilot, see What's New with Salesforce for Outlook? For
answers to frequently asked questions, see “Salesforce for Outlook FAQ” in the Salesforce.com online help.

Administering Salesforce for Outlook
Salesforce for Outlook System Requirements
Available in: Group, Professional, Enterprise, Unlimited, Developer, and Contact Manager Editions; and Trial
organizations

System Requirements
•
•
•

Microsoft® Outlook® 2007 or 2010 (32-bit only; 64-bit isn't supported). If you're using Outlook 2010, Outlook 2010
.NET programmability support is also required.
Microsoft Windows® 7 (32-or 64-bit), XP (32-bit only), or Vista™ (32-bit only)
Adobe® Acrobat® Reader® 7.0 or later
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Note: IMAP and Pop3 email servers are not supported.
Salesforce for Outlook is supported on systems that connect to the internet through a proxy server. We support
automatic proxy detection, manual proxy, and NTLM proxy authentication.
.msi Installer Requirements

You may have to install the following additional tools if you use the .msi installer. They're installed automatically when
you use the standard .exe installer.
•
•
•

Microsoft .NET Framework 2.0 Service Pack 2
Office 2007 Primary Interop Assemblies
Visual Studio® 2005 Tools for Office Second Edition Runtime

Microsoft Vista and Windows 7 users who want to use the .msi installer must run the command prompt an administrator
and then launch the installer from the command line, such as from the command msiexec /i
SalesforceForOutlook.msi.
Time Zone Requirements
The Windows time zone must match the time zone set in the user's Salesforce.com profile. Salesforce for Outlook
supports all Salesforce.com time zones except custom time zones and the following.
•
•
•
•
•
•
•
•
•
•
•

America/Panama
America/Puerto_Rico
Asia/Manila
Atlantic/Bermuda
Australia/Lord_Howe
Pacific/Chatham
Pacific/Enderbury
Pacific/Kiritimati
Pacific/Niue
Pacific/Norfolk
Pacific/Pago_Pago

Salesforce for Outlook Supported Languages
Available in: Group, Professional, Enterprise, Unlimited, Developer, and Contact Manager Editions; and Trial
organizations

Salesforce for Outlook supports these languages.
•
•
•
•
•

Chinese (Simplified)
Chinese (Traditional)
Czech
Danish
Dutch
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English
German
Finnish
French
Hebrew
Hungarian
Italian
Japanese
Korean
Polish
Portuguese (Brazil)
Romanian
Russian
Spanish
Spanish (Mexico)
Swedish
Thai
Turkish
Ukrainian
Vietnamese

The Salesforce for Outlook installer doesn't support:
•
•
•
•
•
•

Hebrew
Portuguese (Brazil)
Romanian
Spanish (Mexico)
Thai
Vietnamese

Salesforce for Outlook Configurations Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

A Salesforce for Outlook configuration is a set of parameters that determine the data that Salesforce for Outlook users can
sync between Microsoft® Outlook® and Salesforce.com. You can create multiple configurations to simultaneously suit the
needs of different types of users. For example, a sales team might want to sync everything, while a manager might only want
to sync events. Users may be able to edit some of their own settings.
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Default configurations are automatically assigned to users of Contact Manager and Group Editions.
To manage your configurations, click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations.
To create a configuration, click New Outlook Configuration.
To change a configuration, click Edit.
To delete a configuration, click Del.
To view details about a configuration, click its name.
To activate a configuration, click Edit next to the configuration, select Active, and click Save.
To deactivate a configuration, click Edit next to the configuration, deselect Active, and click Save. If the configuration's
users are listed on another active configuration through a profile, that configuration is used the next time they open Outlook.
Otherwise, they're unable to use Salesforce for Outlook.

•
•
•
•
•
•

Creating Salesforce for Outlook Configurations
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

1.
2.
3.
4.
5.

Click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations.
Click New Outlook Configuration.
Enter a name for the configuration.
Enter a description of the configuration.
Depending on the configuration, define some or all of these settings.
•
•
•
•
•
•
•
•

Assigned users and profiles
Add email
Sync direction
Conflict behavior
Field mappings
Matching criteria
Whether users can modify
Advanced settings

6. Save the configuration.
7. Define data sets.
8. Select Active to activate the configuration.
When users log in to Salesforce.com from the Salesforce for Outlook setup wizard, these settings take effect immediately. If
you deactivate a configuration and the assigned users are listed on another active configuration through a profile, that
configuration is used the next time they open Outlook. Otherwise, they're unable to use Salesforce for Outlook.
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Assigning Users to Salesforce for Outlook Configurations
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

After you define basic information for a Salesforce for Outlook configuration, you select the Salesforce for Outlook users that
the configuration's settings will apply to.
1.
2.
3.
4.
5.

Click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations.
Click Edit.
In the Assign Users and Profiles section, select either Profiles or Users in the Search drop-down list.
If you don't see the member you want to add, enter keywords in the search box and click Find.
Select members from the Available Members box, and click Add to add them to the group. If all available users are assigned
to this configuration, the Users list is empty and you can only assign profiles.
6. To remove members, select those members and click Remove. If removed users are assigned to another active configuration
through a profile, that other configuration is used the next time they open Outlook. Otherwise, they're unable to use
Salesforce for Outlook.
7. Click Save. All changes take effect the next time data syncs for the users in this configuration. If you assign a user who is
already assigned to a different configuration, that user is removed from the other configuration and assigned to this one.
If an assigned user is also part of a profile assigned to another active configuration, the configuration that lists the user
directly is used.

Defining Data Settings for Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

Data settings control the sync behavior and email functionality of Salesforce for Outlook. You can define the following settings
using the Data Settings fields in a Salesforce for Outlook configuration.
•
•
•

Add email
Sync direction
Conflict behavior
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Field mappings
Matching criteria
Whether users can modify

•
•
•

Enabling Add Email in Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

To enable Add Email

“Customize Application”

Enabling Add Email for your Salesforce for Outlook users adds Add Email and Send and Add buttons to Outlook that let
users add emails to Salesforce.com in a single click.
Emails are saved in Salesforce.com and assigned to other records based on each user's My Email to Salesforce settings. Emails
that can't be associated with other records are assigned to the user as open tasks.
To enable Add Email:
1.
2.
3.
4.
5.

Click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations.
Click Edit.
Select Add Email
Click Save.
If you don't already have Email to Salesforce, click Enable in the popup message to enable both features.

Defining Sync Directions for Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

Sync direction indicates the direction data flows when Salesforce for Outlook syncs data.
1. Click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations.
2. Create or edit a configuration, and select one of these sync directions under Data Settings for each object being synced.
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Don't sync—Outlook and Salesforce.com records aren't synced, and you can't select an Outlook folder to sync
within the setup wizard.
Salesforce.com to Outlook—When data first syncs, a record in Salesforce.com creates or updates a record in
Outlook. During future syncs, changes made to Salesforce.com records appear in Outlook, regardless of whether the
Outlook version of the record has changed. In addition, deleting a synced record in Salesforce.com deletes its Outlook
counterpart. Outlook changes are never sent to Salesforce.com. The required conflict behavior setting for this option
is Salesforce.com always wins.
Outlook to salesforce.com—During its first sync, a record in Outlook creates or updates a record in
Salesforce.com. During future syncs, changes made to Outlook records appear in Salesforce.com, regardless of whether
the Salesforce.com version has changed. In addition, deleting a synced record in Outlook deletes its Salesforce.com
counterpart. Salesforce.com changes are never sent to Outlook. The required conflict behavior setting for this option
is Outlook always wins. This option isn't available for contacts.
Sync both ways—When records sync, changes to Outlook records are reflected in Salesforce.com, and vice versa.
If records conflict, the conflict behavior setting determines which record wins.

3. Click Save. All changes take effect the next time data syncs for the users in this configuration.
4. Define a data set for each object that has a sync direction.

Defining Conflict Behavior for Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

Conflict behavior settings determine what happens when Salesforce for Outlook encounters a conflict when syncing data both
ways. A conflict occurs when the same record is updated in both Salesforce.com and Outlook or when a record is updated on
one side and deleted in the other.
1. Click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations.
2. Edit a configuration, and select a conflict behavior under Data Settings for each object being synced. Possible options are:
•
•

Salesforce.com always wins
Outlook always wins

3. Click Save. All changes take effect the next time data syncs for the users in this configuration.
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Mapping Fields for Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

Field mappings define which Salesforce.com and Outlook fields correspond when records sync with Salesforce for Outlook.
Salesforce.com comes with a set of default mappings. You may be able to change some of them.
To map fields:
1. Click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations
2. Under Data Settings, click Edit Field Mappings to display the list of available fields.
3. Choose a field from the Salesforce.com Field picklist. This list displays the names of all Salesforce.com fields that
haven't yet been mapped.
Caution: If you map a custom field that is universally required, make sure it has a default value to avoid errors.
Also, note that mapping custom fields that require validation by Salesforce.com may cause sync errors. For example,
if you map a custom Salesforce.com field that requires a unique value, you'll get a uniqueness error when you sync
if you enter a non-unique value in the Outlook field.
4. Choose a field from the Outlook Field picklist next to the selected Salesforce.com field. This list displays the names
of all standard Outlook fields that haven't yet been mapped and that match the data type of the corresponding Salesforce.com
field.
5. To map a Salesforce.com field to a custom Outlook field, select Custom Field... from the end of the corresponding
Outlook Field picklist. Enter the field's name and click OK.
The custom field must already exist in Outlook. Letters are not case-sensitive, and these characters aren't allowed: [, ], _,
#. The first sync validates that the custom Outlook field exists and then maps it to the Salesforce.com field. Custom
Outlook fields use a string data type. Note that we only allow custom fields for Salesforce.com text fields and non-restricted
picklists.
6. To remove a field mapping, click the delete icon to the right of the mapping. To redo the mapping, just add a new mapping
to the bottom of the list. To view your mappings, click View under Field Mapping on the detail page.
7. Click Save. All changes take effect the next time data syncs for the users in this configuration.
Note: You can map custom Salesforce.com fields to standard or custom Outlook fields. You can't map picklist values.
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Defining Matching Criteria for Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

If Salesforce for Outlook finds multiple matching contacts when a contact first syncs from Outlook, we pick a Salesforce.com
contact based on the matching criteria you define here.
1. Click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations.
2. Edit a configuration, and select one of these matching criteria options under Data Settings for contacts.
•

Most recent activity—Choose the Salesforce.com contact that shows the most recent activity (such as a phone

•
•

call or email), as shown in the contact's Activity History related list. This is the default matching option.
Last updated—Choose the Salesforce.com contact that was most recently modified.
Oldest—Choose the Salesforce.com contact that has the earliest creation date.

3. Click Save. All changes take effect the next time data syncs for the users in this configuration.
If we don't find a matching contact in Salesforce.com, we create a new contact that syncs with the Outlook contact. We then
either automatically assign the synced contact to a Salesforce.com account, leave it unassigned, or place it in the user's My
Unresolved Items page to be manually assigned.

Letting Users Modify Salesforce for Outlook Settings
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

1. Click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations.
2. Edit a configuration, and select any of the following checkboxes under Data Settings for each object being synced. You
can allow users to modify:
•
•
•
•

Whether object is synced
Sync direction
Conflict behavior
Field mappings
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3. Click Save. All changes take effect the next time data syncs for the users in this configuration.
You can overwrite users' modifications any time by selecting Overwrite configuration changes made by users
in a configuration. After you save the updated configuration, the new settings replace the existing settings for users of the
configuration the next time their data syncs.

Defining Advanced Settings for Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

Use advanced settings in a Salesforce for Outlook configuration to customize the default behavior of Salesforce for Outlook,
such as setting the maximum size of the sync log. Click Edit to change the value of an advanced setting or Remove to remove
it from the configuration.
1.
2.
3.
4.

Click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations.
Click Edit.
Click Add Advanced Setting in the Advanced Settings section of an Outlook configuration.
Choose one of these settings and enter a value.
Advanced Setting

Description

HTTPTimeout

Number of seconds Salesforce for Outlook waits while trying to establish an
HTTP connection with Salesforce.com. Value must be between 15 and 360
seconds, and the default is 30.

MaxLogFileSize

Maximum file size of the sync log you'll maintain. Value must be between 1
and 128 MB, and the default is 1.

MaxRetries

Number of times Salesforce for Outlook tries to connect to Salesforce.com.
Value must be between 0 and 10, and the default is 3.

5. Click OK.
6. Click Save. All changes take effect the next time data syncs for the users in this configuration.
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Default Salesforce for Outlook Configuration
Available in: Contact Manager and Group Editions

Because Salesforce for Outlook configurations are only available in Professional, Enterprise, Unlimited, and Developer Editions,
users of Contact Manager and Group Editions are automatically assigned a default configuration so they can use Salesforce
for Outlook. The default configuration has these settings.
Email—Add Email is enabled if Email to Salesforce is turned on.
Contacts

•
•

-

Sync Direction—Sync both ways
Conflict Behavior—Outlook always wins
Filters—Contacts: User's Records AND Contacts on Accounts: User's Records
Field Mapping—Default settings
Matching Criteria—Most recent activity

Events

•

-

Sync Direction—Outlook to salesforce.com
Conflict Behavior—Outlook always wins
Filters—User's Records AND Date greater or equal TODAY
Field Mapping—Default settings

Defining Data Sets for Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

To create, edit, or delete data sets:

Sync Direction can't be Don't sync

Data sets are subsets of the Salesforce.com records that Salesforce for Outlook users can sync. They consist of filters that limit
which records will sync. Each configuration must have a data set in order for users to sync with Outlook.
The Outlook Configuration detail page shows a summary of the configuration's current filters.
1.
2.
3.
4.

Click Your Name ➤ Setup ➤ Desktop Administration ➤ Outlook Configurations.
Click the name of an Outlook configuration.
In the Data Sets related list, click Edit.
Specify filters.
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5. To see how many items will sync, you can check the data set size.
6. Click Save.

Entering Contact Filters for Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

To filter contacts by opportunity teams:

“Opportunity Team Selling”

To filter contacts by account teams:

“Account Teams”

To create, edit, or delete data sets:

Sync Direction can't be Don't sync

Data sets are subsets of the Salesforce.com records that Salesforce for Outlook users can sync. They consist of filters that limit
which records will sync. For example, you may want to let certain users sync all contacts, but let other users sync only contacts
related to their sales teams. In addition, you can filter by the fields in the records, such as letting users sync only contacts related
to specific accounts and opportunities.
The Outlook Configuration detail page shows a summary of the configuration's current filters.
1. Define a data set for a configuration.
2. Under Filter By Record Ownership, specify whether users can sync all contacts or only selected ones.
3. If you click Selected Contacts, you can further limit which contacts users can sync using these checkboxes.
•

Contacts
-

•

User's Records—Syncs all contacts the user owns
User's Team's Records—Syncs all contacts owned by the user and the user's subordinates in the role hierarchy

Contacts on Opportunities
-

User's Records—Syncs contacts related to the user's opportunities
User's Team's Records—Syncs contacts related to opportunities owned by the user and the user's subordinates

in the role hierarchy
-

User's Sales Teams' Records—Syncs contacts related to opportunities the user is a sales team member of

but not opportunities the user owns
•

Contacts on Accounts
-

User's Records—Syncs contacts related to the user's accounts
User's Team's Records—Syncs contacts related to accounts owned by the user and the user's subordinates in

the role hierarchy
-

User's Account Teams' Records—Syncs contacts related to accounts the user is a team member of but not

accounts the user owns
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4. Under Filter By Additional Objects and Fields, add any field-level filters you need.
a. Select an object and a field within that object.
b. Select the correct filter operator.
c. Enter a value for the selected field.
5. Click Add Row to add a new filter or Remove Row to delete the last one in the list.
6. You can use the Get Record Count button to check how many records will sync for a sample Salesforce for Outlook user
based on the configuration's filters.
Note: If you remove access to certain objects by deselecting the Selected Contacts checkboxes, filters for those
objects will be marked with a warning icon indicating that they're no longer valid. All marked filters are removed when
you save.

Tips on Entering Salesforce for Outlook Contact Filters
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Contact filters control the number of records that Salesforce for Outlook users can sync between Outlook and Salesforce.com.
Note the following when using contact filters.
•
•
•
•
•

•
•

•
•
•

The criteria you specify are AND based, so if you specify more than one criterion, the result includes only records that
match all of the criteria.
If entering a date, use the format allowed by your Locale setting. You can also use special date values like TODAY,
NEXT WEEK, NEXT YEAR, LAST <number> DAYS, and so on.
When searching for numbers or other data that includes commas, place quotation marks around the data. For example:
Amount equals "10,000" returns records that have an amount of $10,000.
When you use the “less than,” “greater than,” “less or equal,” or “greater or equal” operators on fields that have numeric
values, records with blank or “null” values are returned as if their value is zero (0).
To limit results to records that are blank or contain “null” values for a particular field, choose the field and the “equals” or
“not equal to” operators, leaving the third field blank. For example, Amount equals returns records with blank amount
fields. You can search for blank values or other specified values at the same time. For example, Amount equals 1,,2
returns records where the Amount is blank or contains the value “1” or “2”. For example, if you create a workflow a filter
for accounts with the criteria Annual Revenue less than 100000, account records match if their Annual
Revenue is blank.
To search for phone numbers, you might need to include the exact phone number formatting; for example, Phone starts
with (561).
To create a filter that includes more than one value, enter your search terms, separated by commas, in the corresponding
field. You can enter up to 80 characters, including commas and spaces. For example, to search for accounts in California,
New York, or Washington, use State contains CA, NY, WA.
When you filter on standard long text area fields, such as Description, only the first 1000 characters of the field are
searched.
You can use the Get Record Count button to check how many records will sync for a sample Salesforce for Outlook user
based on the configuration's filters.
If you need to reference user information in your contact filters, you can add the following merge fields to them.
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Merge Field

Description

$User.ID

References the ID of the current user. This merge field can
be applied to fields that contain a user lookup. The valid
operators for this merge field are Equals and Not Equal To.
When creating mobile view filters that reference an owner
field, you can only use the $User.ID merge field.

$User.Username

References the username of the current user. This merge
field can be applied to any text or lookup field, except
picklists. The valid operators for this merge field are Equals,
Not Equal To, Greater Than or Equal, Less Than or Equal,
Contains, Does Not Contain, and Starts With.

$User.Firstname

References the first name of the current user. This merge
field can be applied to any text or lookup field, except
picklists. The valid operators for this merge field are Equals,
Not Equal To, Greater Than or Equal, Less Than or Equal,
Contains, Does Not Contain, and Starts With.

$User.Lastname

References the last name of the current user. This merge
field can be applied to any text or lookup field, except
picklists. The valid operators for this merge field are Equals,
Not Equal To, Greater Than or Equal, Less Than or Equal,
Contains, Does Not Contain, and Starts With.

$User.Fullname

References the first and last name of the current user. This
merge field can be applied to any text or lookup field, except
picklists. The valid operators for this merge field are Equals,
Not Equal To, Greater Than or Equal, Less Than or Equal,
Contains, Does Not Contain, and Starts With.

Entering Event Filters for Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view configurations:

“View Setup and Configuration”

To create, edit, or delete configurations:

“Manage Email Client Configurations”

To create, edit, or delete data sets:

Sync Direction can't be Don't sync

Data sets are subsets of the Salesforce.com records that Salesforce for Outlook users can sync. They consist of filters that limit
which records will sync. For example, most users may sync only current and future events, while some users may need to also
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sync past events. Salesforce for Outlook syncs events based on their end dates rather than their start dates. For example, if
you're syncing current and future events only, a two-day event that started yesterday still syncs.
The Data Sets section of the Outlook Configuration detail page shows a summary of the configuration's current event filters.
1. Define a data set for a configuration.
2. Under Events, enter one of these filters in the Greater or equal to field.
•
•
•

TODAY—Syncs only events that end on or after today. The start time is 12:00 a.m.. This option is displayed by default.
LAST MONTH—Syncs only events that ended on or after the first day of last month.
LAST N DAYS—Syncs only events that ended on or after a specified number of days ago, such as LAST 10 DAYS.

3. You can use the Get Record Count button to check how many records will sync for a sample Salesforce for Outlook user
based on the configuration's filters.
4. Save the data set.
Note: The following items don't sync: events with locations longer than 80 characters, recurring events, all-day events
beginning on the first day you're configured to sync, and event attendees. Multiday events sync as single events in
either direction. Multi-day events do sync.

Sample Salesforce for Outlook Data Sets
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Because Salesforce for Outlook users with the same role usually have similar data requirements, many administrators create
Outlook configurations based on the positions in their organization. Below are sample data sets for common Salesforce.com
groups. Your Outlook users have unique needs, but you can use these examples as a reference to help you get started with
Outlook configurations.
Sales Manager
Sales managers usually need to see records they own and the records of the users who report to them. They also need to
see the latest contact information for anyone associated with large deals in the pipeline and any upcoming meetings that
might be related to these deals.
Sample Outlook Configuration for Sales Managers:
Contacts
Contacts: User's Records, User's Team's Records
Contacts on Opportunities: User's Team's Records
Contacts on Accounts: User's Team's Records
Events
Events: User's Records
Date greater or equal TODAY

Sales Engineer
Sales Engineers often only need the contacts owned by them and the other members of their sales teams. They may also
want a record of the past month's meetings and a schedule of all future meetings.
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Sample Outlook Configuration for Sales Engineers:
Contacts
Contacts: User's Records
Contacts on Opportunities: User's Sales Teams' Records
Events
Events: User's Records
Date greater or equal LAST MONTH

Account Executive
Account executives need to see contacts related to their accounts and opportunities. The opportunities are filtered so
only contacts related to open opportunities with a probability over 40% sync. They'd also like to sync all future meetings
and all meetings from the last two months.
Sample Outlook Configuration for Account Executives:
Contacts
Contacts on Opportunities: User's Records
(Probability (%) greater than 40) AND (Stage not equal to Closed Won,Closed Lost
Contacts on Accounts: User's Records
Events
Events: User's Records
Date greater or equal LAST 60 DAYS

Checking the Size of Salesforce for Outlook Data Sets
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view Outlook data sets:

“View Setup and Configuration”

To test Outlook data sets:

“Manage Email Client Configurations”

You can use the Get Record Count button to check how many records will sync for a sample Salesforce for Outlook user
based on the configuration's filters. If the numbers are too high or low, you can adjust the filters and check the size again. The
maximum record count is 5000 per object.
1. Define a data set for a configuration.
2. Under Data Set Size, click the lookup icon next to the User field.
3. Select a user. To test maximum size, choose a user who owns a lot of records, even one who may not be currently assigned
to the configuration.
4. Click Get Record Count. The number of records that would sync between Outlook and Salesforce.com for that user
appear.
5. Adjust the filters or selected user and retest the data set as needed. Nothing is saved until you click Save.
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Installing Salesforce for Outlook
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To install Salesforce for Outlook:

Assigned to an active configuration
AND
Valid data set for each object being synced

To change sync folders:

Your Outlook profile set as the default in your Mail Settings

1. Close Outlook.
2. In Salesforce.com, click Your Name ➤ Setup ➤ Desktop Integration ➤ Salesforce for Outlook.
3. If you want to see the email and sync settings your administrator has defined for you before you install, click View My
Configuration.
4. Click Download. Then click Save, open the saved file, and complete the installation wizard. If needed, you can use the
.msi on page 33 version of the installer.
5. Open Outlook. The setup wizard opens, and the Salesforce for Outlook icon ( ) appears in your system tray. To resume
a cancelled installation, right-click this icon and click Settings.
6. In the Connect to field, keep the default https://www.salesforce.com or enter the URL for another Salesforce.com
site.
If your organization uses a custom domain name for its Salesforce.com URL, you should still use www and not the domain
name for this login.
7. Enter your Salesforce.com username and password, and click Login. This creates a connection between Outlook and
Salesforce.com. You won't have to log in again until prompted.
Note: If your organization restricts IP addresses, logins from untrusted IPs are blocked until they're activated.
Salesforce.com automatically sends you an activation email that you can use to log in. The email contains a security
token that you must add to the end of your password. For example, if your password is mypassword, and your
security token is XXXXXXXXXX, you must enter mypasswordXXXXXXXXXX to log in.
8. Click Next, and choose the folders you want to sync. You can use your default folders or click Change Folder and select
or create a folder that's within your default folders or the main Mailbox folder.
Important: All data in these folders will sync with Salesforce.com. If you're syncing from Salesforce.com to
Outlook or syncing both ways and delete a record in Salesforce.com, that record is automatically deleted in Outlook.
Click the configuration link to see more details about how you're configured to sync.
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9. Click Next, and then click Done. A welcome message appears at the system tray icon ( ), which is now active. If you're
configured to sync Outlook items, all data in your selected folders syncs automatically. The icon spins to let you know
when data is syncing.
During active use, all updates sync automatically every ten minutes. If we detect no keyboard or mouse activity for 30
minutes, we change the sync frequency to 30 minutes. After two hours of inactivity, we sync hourly, and after four hours,
we sync every four hours.

Managing Your Salesforce for Outlook Configuration
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To access your configuration

Assigned to an active configuration

Your version of Salesforce for Outlook has been configured with certain functions, like syncing contacts or events or adding
emails to Salesforce.com. These settings are saved in a Salesforce for Outlook configuration in Salesforce.com.
1. Access your configuration in any of these ways.
•

Click Your Name ➤ Setup ➤ Desktop Integration ➤ Salesforce for Outlook in Salesforce.com. Then click View
My Configuration.

•

Right-click the system tray icon ( ) on your desktop, and select Salesforce.com ➤ Outlook Configuration.

•

Right-click the system tray icon ( ), and select Settings.... Then click Next and click configuration in the second
step of the wizard.

2. Depending on your permissions, you may be able to:
•
•
•
•
•
•

Edit your email settings
Edit your sync settings
Edit your sync direction
Edit your conflict settings
View your matching criteria
Edit your field mappings

3. Click Save. All changes take effect the next time your data syncs. Return to your original settings any time by clicking
Revert to default at the top of your modified configuration. Your administrator may change your settings as needed.
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Editing Your Salesforce for Outlook Email Settings
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To access your configuration

Assigned to an active configuration

To edit email settings

“Add Email”

The Email Settings section of your Salesforce for Outlook configuration shows you whether you're allowed to add emails to
Salesforce.com from Outlook. Emails that you add using Salesforce for Outlook are saved in Salesforce.com and assigned to
other records based on your My Email to Salesforce settings. Emails that can't be associated with other records are assigned
to you as open tasks.
1. Access your configuration in any of these ways.
•

Click Your Name ➤ Setup ➤ Desktop Integration ➤ Salesforce for Outlook in Salesforce.com. Then click View
My Configuration.

•

Right-click the system tray icon ( ) on your desktop, and select Salesforce.com ➤ Outlook Configuration.

•

Right-click the system tray icon ( ), and select Settings.... Then click Next and click configuration in the second
step of the wizard.

If Add Email is selected, you'll see Add Email and Send and Add buttons in Outlook.
2. Click Email to Salesforce Settings.
3. In My Acceptable Email Addresses, enter any email addresses you will use to send email. Separate multiple email
addresses with commas.
4. Configure Email to Salesforce to add emails as activities to matching opportunities, leads, contacts, or all three.
If you configure Email to Salesforce to associate emails to matching leads or contacts, Salesforce.com searches the To and
CC fields for the email addresses of your leads or contacts. If any leads or contacts are found, Salesforce.com saves the
email to the Activity History related list on the appropriate record.
If you selected leads or contacts, choose how Email to Salesforce should process emails containing lead or contact information
that matches duplicate records. Email to Salesforce can add the email activity to all matching records, to the oldest duplicate
record, or to the record that has greatest number of activities.
5. Select the option to create a task if no matching records are found. If this option isn't selected and Salesforce.com can't
identify the sender's email address, the email won't be saved in Salesforce.com.
6. Select the option to receive a confirmation email.
7. Click Save.

50

Sales Cloud

Using Salesforce for Outlook

Editing Your Salesforce for Outlook Sync Settings
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To access your configuration

Assigned to an active configuration

To disable sync:

“Whether object is synced”

The Sync Settings section of your Salesforce for Outlook configuration tells you which objects you're allowed to sync and the
direction data syncs. To view or edit these settings:
1. Access your configuration in any of these ways.
•

Click Your Name ➤ Setup ➤ Desktop Integration ➤ Salesforce for Outlook in Salesforce.com. Then click View
My Configuration.

•

Right-click the system tray icon ( ) on your desktop, and select Salesforce.com ➤ Outlook Configuration.

•

Right-click the system tray icon ( ), and select Settings.... Then click Next and click configuration in the second
step of the wizard.

2. Hover over filter icons ( ) to see which kinds of records sync.
3. Deselect a checkbox to stop an item from syncing. All fields related to that item are disabled on the page.
4. Click Save. All changes take effect the next time your data syncs. Return to your original settings any time by clicking
Revert to default at the top of your modified configuration. Your administrator may change your settings as needed.

Editing Your Salesforce for Outlook Sync Direction
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To access your configuration

Assigned to an active configuration

To change sync direction

“Sync direction”

Sync direction indicates the direction data flows when Salesforce for Outlook syncs data.
1. Access your configuration in any of these ways.
•

Click Your Name ➤ Setup ➤ Desktop Integration ➤ Salesforce for Outlook in Salesforce.com. Then click View
My Configuration.

•

Right-click the system tray icon ( ) on your desktop, and select Salesforce.com ➤ Outlook Configuration.
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Right-click the system tray icon ( ), and select Settings.... Then click Next and click configuration in the second
step of the wizard.

2. Select one of these options under Sync Direction for a particular object.
•

•

•

Outlook to salesforce.com—During its first sync, a record in Outlook creates or updates a record in
Salesforce.com. During future syncs, changes made to Outlook records appear in Salesforce.com, regardless of whether
the Salesforce.com version has changed. In addition, deleting a synced record in Outlook deletes its Salesforce.com
counterpart. Salesforce.com changes are never sent to Outlook. The required conflict behavior setting for this option
is Outlook always wins. This option isn't available for contacts.
Salesforce.com to Outlook—When data first syncs, a record in Salesforce.com creates or updates a record in
Outlook. During future syncs, changes made to Salesforce.com records appear in Outlook, regardless of whether the
Outlook version of the record has changed. In addition, deleting a synced record in Salesforce.com deletes its Outlook
counterpart. Outlook changes are never sent to Salesforce.com. The required conflict behavior setting for this option
is Salesforce.com always wins.
Sync both ways—When records sync, changes to Outlook records are reflected in Salesforce.com, and vice versa.
If records conflict, the conflict behavior setting determines which record wins.

3. Click Save. All changes take effect the next time your data syncs. Return to your original settings any time by clicking
Revert to default at the top of your modified configuration. Your administrator may change your settings as needed.

Editing Your Salesforce for Outlook Conflict Settings
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To access your configuration

Assigned to an active configuration

To change conflict behavior

“Conflict behavior”

Conflict behavior settings determine what happens when Salesforce for Outlook encounters a conflict when syncing data both
ways. A conflict occurs when the same record is updated in both Salesforce.com and Outlook or when a record is updated on
one side and deleted in the other.
1. Access your configuration in any of these ways.
•

Click Your Name ➤ Setup ➤ Desktop Integration ➤ Salesforce for Outlook in Salesforce.com. Then click View
My Configuration.

•

Right-click the system tray icon ( ) on your desktop, and select Salesforce.com ➤ Outlook Configuration.

•

Right-click the system tray icon ( ), and select Settings.... Then click Next and click configuration in the second
step of the wizard.

2. Under Conflict Behavior for each object you're syncing, select one of these options.
•
•

Salesforce.com always wins
Outlook always wins
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3. Click Save. All changes take effect the next time your data syncs. Return to your original settings any time by clicking
Revert to default at the top of your modified configuration. Your administrator may change your settings as needed.

Viewing Your Salesforce for Outlook Matching Criteria
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To access your configuration

Assigned to an active configuration

To view your configuration

Assigned to a configuration

If Salesforce for Outlook finds multiple matching contacts when a contact first syncs from Outlook, we pick a Salesforce.com
contact based on the matching criteria defined by your administrator.
Access your configuration in any of these ways.
•

Click Your Name ➤ Setup ➤ Desktop Integration ➤ Salesforce for Outlook in Salesforce.com. Then click View My
Configuration.

•

Right-click the system tray icon ( ) on your desktop, and select Salesforce.com ➤ Outlook Configuration.

•

Right-click the system tray icon ( ), and select Settings.... Then click Next and click configuration in the second step
of the wizard.

Then review the matching preference assigned to you. Options are:
•

Most recent activity—Choose the Salesforce.com contact that shows the most recent activity (such as a phone call

•
•

or email), as shown in the contact's Activity History related list. This is the default matching option.
Last updated—Choose the Salesforce.com contact that was most recently modified.
Oldest—Choose the Salesforce.com contact that has the earliest creation date.

Editing Your Salesforce for Outlook Field Mappings
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To access your configuration

Assigned to an active configuration

To change field mappings

“Field mappings”

Field mappings define which Salesforce.com and Outlook fields correspond when records sync with Salesforce for Outlook.
1. Access your configuration in any of these ways.
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•

Click Your Name ➤ Setup ➤ Desktop Integration ➤ Salesforce for Outlook in Salesforce.com. Then click View
My Configuration.

•

Right-click the system tray icon ( ) on your desktop, and select Salesforce.com ➤ Outlook Configuration.

•

Right-click the system tray icon ( ), and select Settings.... Then click Next and click configuration in the second
step of the wizard.

2. Click Edit Field Mappings.
3. Choose a field from the Salesforce.com Field picklist. This list displays the names of all Salesforce.com fields that
haven't yet been mapped.
Caution: If you map a custom field that is universally required, make sure it has a default value to avoid errors.
Also, note that mapping custom fields that require validation by Salesforce.com may cause sync errors. For example,
if you map a custom Salesforce.com field that requires a unique value, you'll get a uniqueness error when you sync
if you enter a non-unique value in the Outlook field.
4. Choose a field from the Outlook Field picklist next to the selected Salesforce.com field. This list displays the names
of all standard Outlook fields that haven't yet been mapped and that match the data type of the corresponding Salesforce.com
field.
5. To map a Salesforce.com field to a custom Outlook field, select Custom Field... from the end of the corresponding
Outlook Field picklist. Enter the field's name and click OK.
The custom field must already exist in Outlook. Letters are not case-sensitive, and these characters aren't allowed: [, ], _,
#. The first sync validates that the custom Outlook field exists and then maps it to the Salesforce.com field. Custom
Outlook fields use a string data type. Note that we only allow custom fields for Salesforce.com text fields and non-restricted
picklists.
6. Click Save. All changes take effect the next time your data syncs. Return to your original settings any time by clicking
Revert to default at the top of your modified configuration. Your administrator may change your settings as needed.
To remove a field mapping, click the delete icon to the right of the mapping. To redo the mapping, just add a new mapping
to the bottom of the list. You can map custom Salesforce.com fields to standard or custom Outlook fields. You can't map
picklist values.

Using the Salesforce for Outlook System Tray Application
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

After you install Salesforce for Outlook, a new application icon ( ) appears in your Microsoft® Windows system tray. You
can use this application to:
•
•
•
•
•
•
•
•

Sync Outlook and Salesforce.com items
View your sync log
Resolve your unresolved synced items
Manage your Salesforce for Outlook configuration
Change your login information
Hide alerts
View errors
Change your sync folders
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Access the Salesforce for Outlook online help

Accessing the System Tray Application
•

If you don't see the icon, just restart the application by double-clicking the Salesforce for Outlook shortcut on your
desktop or the application in your computer's Programs directory (Start ➤ All Programs ➤ salesforce.com ➤
Salesforce for Outlook).

•

If the icon is disabled ( ), you may need to start Outlook.
If you're using Microsoft Windows 7, you may need to click the arrow next to the notification area and drag the
Salesforce for Outlook icon to the system tray.

•

Viewing the Salesforce for Outlook Sync Log
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

The sync log records troubleshooting information for Salesforce for Outlook, including the number of records that had errors
and the number of records that were created, updated, or deleted during sync.
To view this log, right-click the system tray icon ( ) and click Sync ➤ View Sync Log.

Changing Your Salesforce for Outlook Sync Folders
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To change sync folders:

Assigned to an active configuration
AND
Your Outlook profile set as the default in your Mail Settings

To disable sync:

“Whether object is synced”

Salesforce for Outlook uses Outlook folders to limit which records sync with Salesforce.com. Before you complete the Salesforce
for Outlook setup wizard, make sure the folders you want to sync contain the right records. If you're syncing both ways or
syncing Outlook to Salesforce.com, moving a record out of a synced Outlook folder deletes that record in Salesforce.com. If
you're syncing both ways or syncing Salesforce.com to Outlook, removing a record from Salesforce.com deletes that record in
Outlook.
To change your sync folders after your initial setup:
1. Right-click the system tray icon ( ) on your desktop and select Settings....
2. Click Next, and choose the folders you want to sync. You can use your default folders or click Change Folder and select
or create a folder that's within your default folders or the main Mailbox folder.
3. Click Next, and then click Done. Salesforce for Outlook starts syncing with the new folders immediately.
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Changing Your Salesforce for Outlook Login Information
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To log in to Salesforce for Outlook

Assigned to an active configuration

If your Salesforce.com username or password changes, you'll need to update your login information in Salesforce for Outlook.
1. Right-click the system tray icon ( ) on your desktop and select Settings...
2. Enter your correct Salesforce.com username and password, and click Login. This creates a connection between Outlook
and Salesforce.com. You won't have to log in again until prompted.
3. Click Next, click Next again, and then click Done.
Note: If your organization restricts IP addresses, logins from untrusted IPs are blocked until they're activated.
Salesforce.com automatically sends you an activation email that you can use to log in. The email contains a security
token that you must add to the end of your password. For example, if your password is mypassword, and your security
token is XXXXXXXXXX, you must enter mypasswordXXXXXXXXXX to log in.

Hiding Salesforce for Outlook Alerts
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Salesforce for Outlook automatically displays system tray alerts about issues like sync errors and unresolved synced records.
To hide these alerts, right-click the system tray icon ( ) and click Hide Alerts. Click Hide Alerts again to show them.

Viewing Salesforce for Outlook Errors
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Whenever Salesforce for Outlook has problems syncing your data, the system tray icon changes to an error icon ( ), and the
status text at the top of the system tray shortcut menu displays the number of errors.
To view these errors, double-click the system tray icon or click the text in the shortcut menu to open the Salesforce for Outlook
Error dialog box. If an error relates to a specific Outlook record, you can click the record's link to edit that record in Outlook.
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Adding Email with Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To add Outlook emails to Salesforce.com:

“Email to Salesforce.com”
AND
“Add Email”

To save an existing email in Salesforce.com, select a sent or received email and click Add Email.
To save a new email in Salesforce.com:
1. Open an email folder in Outlook and click New.
2. Add the recipients.
3. Write the email and click Send and Add.
Emails are saved in Salesforce.com based on your Email to Salesforce settings as follows.
•
•

The email is sent to the recipients and saved in Salesforce.com. The text Sent to salesforce.com appears at the
top of the email, and you receive a confirmation email in Outlook.
If you configure Email to Salesforce to associate emails to matching leads or contacts, Salesforce.com searches the To and
CC fields for the email addresses of your leads or contacts. If any leads or contacts are found, Salesforce.com saves the
email to the Activity History related list on the appropriate record.

•

If you configure Email to Salesforce to associate emails to matching opportunities, Salesforce.com searches the To and
CC fields for the email addresses of your contacts. If contacts are found, Salesforce.com saves the email to the Activity
History related list on all open opportunities for which the contact is assigned a contact role.

•

If Email to Salesforce matches an email address to multiple lead or contact records in Salesforce.com, you can choose to
associate the email with all matching records, the oldest record, or the record with the most activity.
Email attachments aren't added to Salesforce.com.
With Salesforce for Outlook, you add emails using the Add Email and Send and Add toolbar buttons instead of the BCC
field.

•
•
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Syncing with Salesforce for Outlook
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To sync data

Sync enabled for contacts or events

Salesforce for Outlook offers a seamless sync experience, where data syncs automatically without interrupting your work. Here
are some guidelines to keep in mind as you sync data with Salesforce for Outlook.
•

•
•

•
•
•
•

Salesforce for Outlook uses Outlook folders to limit which records sync with Salesforce.com. Before you complete the
Salesforce for Outlook setup wizard, make sure the folders you want to sync contain the right records. If you're syncing
both ways or syncing Outlook to Salesforce.com, moving a record out of a synced Outlook folder deletes that record in
Salesforce.com. If you're syncing both ways or syncing Salesforce.com to Outlook, removing a record from Salesforce.com
deletes that record in Outlook.
Your data syncs automatically after you set up Salesforce for Outlook.
During active use, all updates sync automatically every ten minutes. If we detect no keyboard or mouse activity for 30
minutes, we change the sync frequency to 30 minutes. After two hours of inactivity, we sync hourly, and after four hours,
we sync every four hours.
You can force a sync at any time by right-clicking the system tray icon ( ) and clicking Sync ➤ Sync Now.
Your Outlook configuration defines which items are set to sync, which direction the data flows between Outlook and
Salesforce.com, and what happens when data conflicts.
Outlook and Salesforce.com must be configured to sync before you can see the Sync ➤ Sync Now menu item.
If data is undeleted in Salesforce.com or becomes available due to a change in sharing permissions, it will show up in
Outlook within 24 hours or when you manually sync from the system tray.
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Syncing Events with Salesforce for Outlook
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To sync events from Outlook to Salesforce.com:

“Read” and “Edit” on events, and event sync direction set to
Outlook to salesforce.com

To sync events from Salesforce.com to Outlook:

”Read” and “Edit” on events, and event sync direction set to
Salesforce.com to Outlook

To sync events both ways:

”Read” and Edit” on events, and event sync direction set to
Sync both ways

To sync multiday events:

“Enable Multiday Events” on activities

You can easily keep your Outlook and Salesforce.com events in sync using Salesforce for Outlook. Once an event is in
Salesforce.com, you can assign it to related records, like contacts, accounts, opportunities, and so on. Syncing events also lets
you maintain an accurate view of your availability when you create events and request meetings from your Salesforce.com
calendar.
Which Events Sync
Your Outlook configuration defines which items are set to sync, which direction the data flows between Outlook and
Salesforce.com, and what happens when data conflicts. The event filters in your configuration determine which events
sync. The possible filters are:
•
•
•

TODAY—Syncs only events that end on or after today.
LAST MONTH—Syncs only events that ended on or after the first day of last month.
LAST N DAYS—Syncs only events that ended on or after a specified number of days ago, such as LAST 10 DAYS.

Event updates stop syncing once the event falls outside of the range you're configured to sync.
The following items don't sync: events with locations longer than 80 characters, recurring events, all-day events beginning
on the first day you're configured to sync, and event attendees. Multiday events sync as single events in either direction.
Salesforce for Outlook syncs events based on their end dates rather than their start dates. For example, if you're syncing
current and future events only, a two-day event that started yesterday still syncs.
How We Match Events
When events first sync, we either link them with existing events that have the same subject and time or create new events
if nothing matches.
How You Assign Events to Salesforce.com records
After an event is added to Salesforce.com, you can assign it to other records using the My Unresolved Items page or the
Related To and Name fields on the event record. The event is added to the associated record's Activity History or
Open Activities related list. You can't save changes if your events have a required custom field or an activity custom field
becomes required after items are added to your unresolved events list.
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Who Sees Synced Events in Salesforce.com
Events that aren't marked as private are visible Salesforce.com to you, those above you in your role hierarchy, and anyone
who has access to the records they're associated with. You can also grant access to view your calendar to other users,
personal and public groups, roles, or roles and subordinates.

Syncing Contacts with Salesforce for Outlook
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To sync contacts from Salesforce.com to Outlook:

“Read” on contacts
AND
Contact sync direction set to Salesforce.com to
Outlook

To sync contacts both ways:

“Read” and “Edit” on contacts, and “Read” on accounts
AND
Contact sync direction set to Sync both ways

You can easily keep your important Outlook and Salesforce.com contacts in sync using Salesforce for Outlook. When contacts
initially sync, Salesforce for Outlook checks to see whether a contact with the same email address exists in both Outlook and
Salesforce.com. If a matching email address exists, the two contacts are synced. If it doesn't exist, Salesforce for Outlook checks
to see whether a contact with the same first name, last name, and company name exists. If it doesn't exist, a new contact is
created and the two are synced.
Your Outlook configuration defines which items are set to sync, which direction the data flows between Outlook and
Salesforce.com, and what happens when data conflicts. The supported sync directions are Salesforce.com to Outlook
and Sync both ways. You can't currently sync contacts from Outlook to salesforce.com. Salesforce for Outlook
isn't case-sensitive when matching contacts.
This diagram shows how contacts sync.
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How contacts sync when the sync direction is Salesforce.com to Outlook:
If

Then

A contact already exists in Outlook

The Salesforce.com contact replaces the Outlook contact and
the two are synced.

A contact doesn't exist or has been deleted in Outlook

The contact is automatically created in Outlook and the two
are synced.

Multiple matching contacts exist in Outlook

We select one of them.

A contact is updated

The Salesforce.com contact always overwrites the Outlook
contact, regardless of which one was updated.

61

Sales Cloud

Using Salesforce for Outlook

If

Then

A Salesforce.com contact is deleted

The Outlook counterpart is also deleted. If the Outlook
contact is deleted and the Salesforce.com contact is updated,
the contact is recreated in Outlook.

How contacts sync when the sync direction is Sync both ways:
If

Then

A contact exists on one side only

The contact is automatically created on the other side and the
two are synced.

A matching contact exists

One contact record replaces the other one, and the records
are synced. If your Outlook configuration specifies that
Outlook contacts win, the Outlook version replaces the
Salesforce.com version, and vice versa if Salesforce.com is set
to win. Any change to either record is automatically reflected
in the other. If records conflict, the conflict behavior setting
determines which record wins.

Multiple matching Salesforce.com contacts exist

As long as there's only one version of the Outlook contact and
that contact has an email address, we sync the Outlook contact
with aSalesforce.com contact based on your matching
preference, such as the contact that was most recently updated.

A contact is updated

Both contacts are updated with the latest changes. If records
conflict, the conflict behavior setting determines which record
wins.

A Salesforce.com contact is deleted and the Outlook contact The Outlook counterpart is deleted if Salesforce.com is set to
is updated
win, and the contact is recreated in Salesforce.com if Outlook
is set to win.
An Outlook contact is deleted and the Salesforce.com contact The Salesforce.com counterpart is deleted if Outlook is set to
is updated
win, and the contact is recreated in Outlook if Salesforce.com
is set to win.

Note: If person accounts have been implemented in your organization, Salesforce for Outlook can sync person accounts
between your Accounts tab in Salesforce.com and your contacts folder in Outlook. You can create new person accounts
in Salesforce.com and view, edit, and delete synced person accounts in Outlook or Salesforce.com. Contacts synced
from Outlook to Salesforce.com may be matched to person accounts.
A deleted person account will be recreated as a contact in Salesforce.com if:
•
•

You update the related Outlook contact before the next sync, and
Your configuration is set to sync both ways with Outlook wining.
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Automatic Account Assignments for Synced Contacts
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To assign accounts:

“Read” on accounts and “Edit” on contacts

To create new accounts:

“Create” on accounts and “Edit” on contacts
AND
“Show Quick Create”

After syncing contacts from Outlook, Salesforce for Outlook tries to automatically assign them to accounts, as shown in this
diagram.
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This table describes the account assignment process.
If

Then

A contact's company matches a single Salesforce.com account The contact is assigned to that account.
A contact's company matches many Salesforce.com accounts The contact is sent to My Unresolved Items in Salesforce.com,
or none
which you can access from the Contact home page or the
Salesforce for Outlook system tray application. You can use
this list to manually assign contacts to existing accounts, create
new accounts, or confirm that contacts are private.
A contact doesn't have a company name

The contact is treated as a private contact and is not sent to
My Unresolved Items.

A contact's company changes in Outlook

If a matching account is found in Salesforce.com, the contact
is assigned to that account. Otherwise, the contact is sent to
My Unresolved Items to be resolved.
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If

Then

An unresolved contact is deleted in Outlook

The contact is removed from My Unresolved Items the next
time you open the list.

An unresolved contact is changed in Outlook

The contact record is updated in My Unresolved Items. If the
contact's company changes, Salesforce.com checks to see if
that information matches any existing accounts and assigns it
to an account if it finds a match.

My Unresolved Items Overview
Available in: Contact Manager, Personal, Group, Professional, Enterprise, Unlimited, and Developer Editions

My Unresolved Items is a list of contacts and events that have synced from Outlook but haven't been assigned to Salesforce.com
records. Use this list to assign items to Salesforce.com records or confirm that you want to leave items unassigned.
You can access this list in any of these ways:
•
•
•
•

Right-click the Salesforce for Outlook system tray icon and click Salesforce.com ➤ My Unresolved Items...
Click the popup message that appears at the system tray icon ( ) when items are added to My Unresolved Items.
Click unresolved contacts list in the banner on your Contacts home page if you have unresolved contacts.
Click unresolved events list in the banner on your Salesforce.com calendar if you have unresolved events.

Resolving Your Synced Outlook Contacts
Available in: Contact Manager, Personal, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view or edit unresolved contacts:

“Edit” on contacts and “Read” on accounts
AND
Sync enabled for contacts

To create new accounts:

“Edit” on contacts and “Create” on accounts
AND
“Show Quick Create”

When contacts sync from Outlook with Salesforce for Outlook, some are automatically assigned to accounts based on their
company. The rest are added to My Unresolved Items, where you can either assign contacts to Salesforce.com accounts or
confirm that you want to leave them unassigned.
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1. Access your unresolved contacts in any of these ways.
•

Right-click the Salesforce for Outlook system tray icon and click Salesforce.com ➤ My Unresolved Items.... If you
sync both contacts and events, click the Contacts tab.

•

Click the popup message that appears at the system tray icon ( ) when items are added to My Unresolved Items.
Click unresolved contacts list in the banner on your Contacts home page if you have unresolved contacts.

•

2. Resolve each contact in any of these ways.
•

Assign an account.
-

•

•

•

Select an account under Choose Suggested Account in the drop-down list. We suggest accounts only if we detect
possible matches based on the contact's company. Suggested accounts always show the Account Name field and
the first three additional fields defined in your account search layout. If your organization has contact lookup filters
that prevent certain accounts from being assigned to contacts, those accounts won’t appear as suggested accounts
and can’t be assigned to contacts.
Select Search Salesforce.com.... In the lookup, either click New, enter account information, and click
Save, or enter search criteria, click Go!, and click the right account.

Leave unassigned—Select Don't Assign New Account from the drop-down list if you want to confirm that a
contact with no account should remain unassigned. Unassigned contacts aren't related to Salesforce.com records and
are visible to you and your administrator only.
Choose an account if there's a conflict—If the Outlook and Salesforce.com contacts' companies are different, click
Don't Assign New Account in the drop-down list to overwrite one with the other. The Salesforce.com account
overwrites the Outlook company if Salesforce.com is set to win, and Outlook overwrites the Salesforce.com account if
Outlook is set to win.
Cancel a selection—Select —None Selected— from the drop-down list.

3. Click Save to save your changes. All modified items are removed from the list. Remaining items continue to sync, and you
can return any time to resolve them. Clicking Cancel cancels all changes on the page. Every contact assigned to an account
now appears on the Contacts related list for that account.
Note: You can also resolve a contact from the contact record by marking it private or by assigning it to an account.
Your unresolved contacts list works like a standard list view. Click Edit or Create New View to define filters and
customize columns.
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Resolving Your Synced Outlook Events
Available in: Contact Manager, Personal, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To view or edit unresolved events:

“Edit” on events and “Read” on the objects you assign to events
AND
Sync enabled for events

To create new Salesforce.com records:

”Edit” on events
AND
“Show Quick Create” and “Create” on those objects

To see recently used data in the related records fields:

“Lookup Auto-Completion”

When events sync from Outlook with Salesforce for Outlook, they appear in your Salesforce.com calendar and on the My
Unresolved Items page. Use this page to either assign events to related Salesforce.com records or confirm that you want to
leave them unassigned.
1. You can access your unresolved events in any of these ways:
•

Right-click the Salesforce for Outlook system tray icon and click Salesforce.com ➤ My Unresolved Items.... If you
sync both contacts and events, click the Events tab.

•

Click the popup message that appears at the system tray icon ( ) when items are added to My Unresolved Items.
Click unresolved events list in the banner on your Salesforce.com calendar if you have unresolved events.

•

2. Depending on how you want to resolve an event, choose either of these actions.
•

•

Assign to related records—Enter a related record in one or both fields. If you need to, first select the correct record
type from the drop-down list. If you assign a lead, you can't assign additional records. Clear an entry to cancel an
assignment.
Leave unassigned—Click Don't Assign. Unassigned events, such as internal meetings or personal appointments, aren't
linked to any other records and are visible to you only.

3. Click Save to save your changes. All modified items are removed from the list. Remaining items continue to sync, and you
can return any time to resolve them. Clicking Cancel cancels all changes on the page. The event is added to the associated
record's Activity History or Open Activities related list. You can't save changes if your events have a required custom field
or an activity custom field becomes required after items are added to your unresolved events list.
Note: You can also resolve an event from the event record by marking it private or by assigning it to other Salesforce.com
records using the Related To and Name fields. Assigned and private events are automatically removed from your
unresolved events list. Click next to the subject to see an event's description.
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Quote Templates—Generally Available
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Quote templates is generally available in the Winter '11 release. We've included new features you asked for, including repeating
headers and footers, field alignment, and rich text. We've made it easier to add graphics to your templates, and you can now
preview your templates as you're creating them. You can also control which templates are available for use by activating or
deactivating them.

Implementation Tip
If you used quote templates during the Summer '10 beta release, you'll notice a change in how template logos and signature
blocks work. The first time you create a template in the Winter '11 release, if you add any content to the header or footer, the
logo and signature block you previously used won't be displayed. If the new template's header and footer have no content, the
original logo and signature block will appear.

Using Headers and Footers on Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To create quote templates:

"Customize Application"

To view quote templates:

"View Setup and Configuration"

Use headers and footers to show standard, repeating information on your quote template, such as your company logo, your
company address, the date the quote was created, or the quote number. Headers and footers can span the width of the template
or be divided into two equal columns.
A header or footer is essentially a section: you can add fields to it and show or hide its title. You can't remove a header or
footer or add more sections to it.
Note:
In some cases, a field may not appear on the quote templates palette or on a PDF created from a template.
•
•
•

•

If a user is unable to view or update a field because of field-level security settings, that field won't appear on PDFs
created from a template, even if the template includes that field. Read-only fields will appear on PDFs.
A field that appears on a quote page layout but does not have a value for a given quote will appear on the quote
templates palette, but won't appear on PDFs created from that quote.
Quote line item fields that don't contain data won't appear as columns in a list when a PDF is created, even if the
template includes that field. For example, if no quote line items offer a discount, the Discount column won't
appear, even if the list includes the Discount field.
If a related list is not included on a quote page layout, it won't appear on the template palette or any PDFs for
quotes that use that page layout.
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1. If you need to change the number of columns in your header or footer, click
you want.

and select the number (one or two) that

Tip: To display an image that spans the width of a page, use a one-column header or footer. For terms and
conditions text, use a one-column footer.
2. Select an object and drag the fields you want into the header or footer. Press CTRL+click to select multiple fields and
SHIFT+click to select a range.
If you want to use an image, such as your company logo, or include extended information, such as terms and conditions,
use a Text/Image Field.
3. If you need to change field alignment within a column, click
and select left or right alignment.
4. If you want to hide field labels, click
and select the Hide checkbox.
5. Select Hide Title if you don't want the title to appear on the template or PDF.
6. Click OK.

Adding Rich Text to Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To create quote templates:

"Customize Application"

To view quote templates:

"View Setup and Configuration"

Use the quote templates text/image field to add text you can format, such as your organization's address or terms and conditions.
You can also insert images, like your company logo. You can use text/image fields in the body of your template, and also in
the header and footer.
Rich Text Restrictions
Text formatting is not available in the Text/Image Field for Unicode languages such as Arabic and Japanese.
The maximum number of characters you can use in the quote templates Text/Image Field is 32,000, which includes
the hidden HTML characters used to format text.
1. Drag a Text/Image Field into place in the header, the footer, or any section in the body.
2. Type or paste your text into the field, then format it however you like.
3. Click OK.
Tip: Use a text/image field to create a signature block.
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Adding Images to Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To create quote templates:

"Customize Application"

To view quote templates:

"View Setup and Configuration"

Use the quote templates text/image field to insert images, like your company logo. You can use text/image fields in the body
of your template, and also in the header and footer.
You can store images for uploading in either your own file system or in Salesforce CRM Content.
If you store images on the Documents tab or the Static Resources page, you'll get a Web address you can use to insert the
image.
Note: If you need to insert an image from a public Web address outside the Salesforce.com application (such as your
company's website), contact Salesforce.com and ask to have the public URL whitelisted for your organization.
Image Size Considerations
If you insert an image that's too large, it will be cropped when users create quote PDFs from the template. To prevent
cropping, click Save and Preview after you insert an image, then resize the image if you need to.
Inserting an Uploaded Image
1. If you want to use an image stored in Salesforce CRM Content, locate the image and download it to your local file
directory.
2. Drag a Text/Image Field into place in the header, the footer, or any section in the body.
3. Select Hide Title if you don't want the title to appear on the template or PDF.
4. Click the image icon, then click Browse... and locate the image in your file directory.
5. Click Open and the image appears in the field. You can resize it by dragging the sizing handles, which show the
image's height and width in pixels.
6. Click OK.
7. Click Save and Preview to see how the image will look in PDFs created from the template.
Inserting an Image from a Salesforce.com Web Address
1.
2.
3.
4.
5.

If you need to, upload the image to the Documents tab or define a static resource.
Drag a Text/Image Field into place in the header, the footer, or any section in the body.
Select Hide Title if you don't want the title to appear on the template or PDF. Click OK.
On the Documents tab or the Static Resources page, open the image's detail page, click View File, and copy its URL.

Return to the quote template editor and click
in the title bar of the text/image field.
6. Click the image icon, then click the Web Address tab.

70

Sales Cloud

Quote Templates—Generally Available

7. Paste the URL into the URL field, then click Insert. The image appears in the field. You can resize it by dragging
the sizing handles, which show the image's height and width in pixels.
8. Click OK.
9. Click Save and Preview to see how the image will look in PDFs created from the template.
Important: If the image is removed from the Documents tab or Static Resources page, where it is stored, the
template displays a message that the image is not available. Restore the image, then open the template, delete
the error message image, and repaste the URL.

Previewing Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To create quote templates:

"Customize Application"

To view quote templates:

"View Setup and Configuration"

Preview your quote templates to make sure the quote PDFs users create will look the way you want them to.
Note: Preview shows templates in system administrator profile view. The preview and the template show any rich
text and images you've added. Other data is simulated.
1. Open the template you want to preview. Edit the template if you need to.
2. Click Save and Preview.
Important: Save and Preview saves changes to your template, so after you preview, you can't undo them.

3. In the Template Preview overlay, verify that the content and layout are correct.
4. Click Close.
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Additional Sales Cloud Enhancements
Activity Enhancements
Event and Task Subject Limits Increased

You asked for it! This enhancement is from an idea on the IdeaExchange.
Available in: All Editions

The character limit for the Subject field on the Event and Task objects increased from 80 to 255.
Attachments on Activities

You asked for it! This enhancement is from an idea on the IdeaExchange.
Available in: All Editions

You can now add attachments to events and tasks. After you add the Attachments related list to the Activity page layout,
your organization can attach files using the task and event edit pages. Activity attachments can't be private and don't
sync to Outlook.

Notes and Attachments Enhancements
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Link to File Detail Page for Chatter Feed Attachments on Notes and Attachments
A file attached to a Chatter feed on a record is added to the record's Notes and Attachments related list as a Feed
Attachment. You can now click on the title of the Feed Attachment to see its detail page. From a file detail page you
can see file details and perform actions on the file depending on your level of access. For more information about the
file detail page, see Viewing the File Detail Page on page 16.
“View” is Now “Preview” for Chatter Feed Attachments on Notes and Attachments
Feed Attachments now have “Preview” listed as an action instead of “View”. Clicking Preview next to a Feed Attachment
on a Notes and Attachments related list displays a preview of that file. Not all files can be previewed, such as copy-protected
PDFs, unknown file types, and any file larger than 25 MB. For files that can't be previewed, the Preview option isn't
available on feeds or list views, and files appear as generic file type icons in the feed. Some Microsoft Office 2007 features
don't display correctly in previews. For more information on file previews see, “Downloading and Previewing a File in
a Chatter Feed” in the Salesforce.com online help.
Note: On some objects, the Notes and Attachments related list is titled Attachments because the object does not
offer notes. Also, the same related list may be titled Google Docs, Notes, and Attachments or Google Docs and
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Attachments depending on the setting in your organization. References to the Notes and Attachments related list
include all versions of the related list, regardless of title.

Salesforce to Salesforce Enhancements
Available in: All Editions

Caching for Salesforce to Salesforce
In Winter '11, we implemented a caching system to support larger transaction volumes and reduce the number of API
calls that count against your organization's limits. To provide these improvements, we now cache the following events:
•
•
•
•

Selection of the Auto-Accept checkbox
Changes to field mappings
Changes to picklist value mappings
Adding currencies

Salesforce.com refreshes the cache every 15 minutes. As a result, changes to cached events may take up to 15 minutes
to show up in your partner connection.
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Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

With Winter '11, you can dramatically speed up support, sales, and telemarketing functions with the Service Cloud console.
The Service Cloud console is designed for users in fast-paced environments who need to find, update, and create records
quickly. It improves on the Console tab by letting you:
•
•
•
•
•
•

Work with fewer clicks and less scrolling
Limit switching between pages
Easily spot important fields on records
See records and their related items as tabs on one screen so that you never lose context or navigate too far from a record
Jot notes on each record in an interaction log
Access a SoftPhone for Salesforce CRM Call Center in a footer instead of a sidebar

Implementation Tips
•
•
•
•
•
•

•
•
•

Only users assigned to the Service Cloud User feature license can use the Service Cloud console. See “Viewing Feature
Licenses” in the Salesforce.com online help.
The Service Cloud console respects all of the security and sharing settings in your Salesforce.com organization.
You can review an out-of-the box Service Cloud console by selecting Sample Console from the Force.com app menu.
Administrators can customize the Sample Console and give users access to it at Your Name ➤ Setup ➤ Create ➤ Apps.
Users see the new user interface theme on all pages in the Service Cloud console even if the theme isn't enabled for your
organization (the new user interface isn't applied to any pages outside of the Service Cloud console unless it's enabled)
The number of Service Cloud console apps you can create is based on your custom app limits. See “Salesforce.com Editions
and Limits” in the Salesforce.com online help.
The interaction log only displays on items that have an Activity History related list, such as accounts and contacts. The
interaction log isn't available for items like reports, dashboards, Salesforce CRM Content, the Article Management tab,
or Visualforce pages that display as primary tabs.
You must refresh your browser to see any setup changes to the Service Cloud console.
You can't add the Service Cloud console to partner portals or customer portals.
Advanced administrators and developers can use the Service Cloud Console Integration Toolkit to implement custom
functionality for the Service Cloud console. For example, you can use the Service Cloud Console Integration Toolkit to
display Visualforce pages or third-party content as tabs in the Service Cloud console. The Service Cloud Console Integration
Toolkit is an API that uses browsers as clients to display pages in the console. For more information, see the Service Cloud
Console Integration Toolkit Developer's Guide on the Developer Force Documentation page.

Best Practices
•

So that users can easily recognize the correct console, we recommend naming Service Cloud console apps after their
function. For example, Customer Service Desk.
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When setting up the Service Cloud console, pick the center of your business process as a primary tab and related items as
subtabs. For example, you can set account as a primary tabs and cases and contacts as subtabs.
Call Center users can use the interaction log to write notes in call logs while using the Service Cloud console. A call log
is an activity record that automatically generates when you use the SoftPhone; it tracks the phone number, caller, date,
time, and duration of the call. You can view call logs in the Activity History related list of any record associated with the
call.

Limitations
•
•
•
•
•
•
•
•
•
•

The Service Cloud console is only available in Internet Explorer 7 or 8 and Firefox 3.5 and above.
Visualforce pages might not display correctly in the Service Cloud console unless they're updated to show in it.
Google AdWords might not display correctly in the Service Cloud console.
All Salesforce CRM Content items display as primary tabs in the Service Cloud console.
Call center users can only use a SoftPhone in the Service Cloud console if they're using a CTI adapter built with version
3.0 of the CTI Toolkit.
URLs to Service Cloud console pages may not work when pasted into browsers or selected from bookmarks.
The Service Cloud console doesn't meet accessibility requirements.
The Service Cloud console isn't available for AppExchange.
If you refresh the Change Case Status page in the Service Cloud console, an Unable to Access Page error displays.
If you leave the Service Cloud console and return to it, any subtabs that were displayed may not automatically reload. Also,
if you leave the Service Cloud console by selecting an app from the Force.com app menu, your browser's Back and Forward
buttons may not work as expected.

Helpful Service Cloud Console Terminology
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

The following terms are used when describing Service Cloud console features and functionality.
Navigation Tab
A tab with a drop-down button. Select an object to view its home page without leaving the Service Cloud console.
Primary Tab
A tab that displays the main item to work on, such as an account. The selection you make from the navigation tab or
search results displays as a primary tab.
Subtab
A tab that displays content related to the item on a primary tab. For example, a primary tab showing an account might
have subtabs for cases and contacts.
Highlights Panel
A customizable table of up to four columns and two rows that appears at the top of every primary tab. It lets you view
key information about records at a glance.
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Interaction Log
An area where you can jot notes about the main record you're working on without clicking a button, viewing a new tab,
or scrolling to the Notes & Attachments related list. Interaction logs are archived on the Activity History related list for
easy review and retrieval. Administrators can customize interaction logs to include task fields.

Setting Up a Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed
To set up a Service Cloud console:

“Customize Application”

To set up the Service Cloud console:
1.
2.
3.
4.

Customize highlights panels for all objects.
Create an app for your Service Cloud console and assign it to user profiles.
Set up interaction logs and assign them to user profiles.
Set up call center with version 3.0 of the CTI Toolkit. Call center users can only use a SoftPhone in the Service Cloud
console if they're using a CTI adapter built with version 3.0 of the CTI Toolkit.
5. Assign users the Service Cloud User feature license:
a.
b.
c.
d.

Click Your Name ➤ Setup ➤ Manage Users ➤ Users.
Click Edit next to a user's name.
Select Service Cloud User.
Click Save.

Tips on Setting Up a Service Cloud Console
•
•
•
•

The new user interface theme automatically displays for all pages in the Service Cloud console. It's not applied to any pages
outside of the Service Cloud console unless you enable it.
You can review an out-of-the box Service Cloud console by selecting Sample Console from the Force.com app menu.
Administrators can customize the Sample Console and give users access to it at Your Name ➤ Setup ➤ Create ➤ Apps.
You must refresh your browser to see any setup changes to the Service Cloud console.
Advanced administrators and developers can use the Service Cloud Console Integration Toolkit to implement custom
functionality for the Service Cloud console. For example, you can use the Service Cloud Console Integration Toolkit to
display Visualforce pages or third-party content as tabs in the Service Cloud console. The Service Cloud Console Integration
Toolkit is an API that uses browsers as clients to display pages in the console. For more information, see the Service Cloud
Console Integration Toolkit Developer's Guide on the Developer Force Documentation page.
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Customizing Highlights Panels
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed
To customize page layouts:

“Customize Application”

To view page layouts:

“View Setup”

View key information at a glance—the highlights panel is a table of up to four columns at the top of every primary tab in the
Service Cloud console. Each column has one or two fields that you can customize to suit your business needs.
Highlights Panel Fields and Format
The Highlights panel displays standard and custom fields, and columns. The following formatting rules apply:
•

Standard and custom fields
-

•
•

Fields must also be on the detail page layout
Fields can appear once per highlights panel

Columns—minimum one, maximum four. Column widths resize automatically.
Fields per column—one or two, in top or bottom positions.
When users see the highlights panel:
-

Top fields appear in bold and in a larger font than bottom fields.
Blank fields appear as follows:
-

•

Top fields—appear blank (except when top fields are blank because users don't have permission to view them).
Bottom fields—the top field expands to fill the column
Both fields—the column appears blank

Users see only the fields that they have permission to view.
If users can't see:
-

Top fields—the bottom field replaces the top field and expands to fill the column
Bottom fields—the top field expands to fill the column
Any fields in a column—the column is removed

Editing the Highlights Panel
Hover over the highlights panel on any page layout and click
•

(or double-click the highlights panel) to edit.

To add or change fields, click the appropriate column and select fields from the Top Field and Bottom Field
lists:
-

Fields must also be on the detail page layout. If fields you want to add aren't listed, add them to the detail page
layout.
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•
•
•
•

Rich text area (RTA) and custom long-text area fields are not supported in the highlights panel, even if they are
included in the detail page layout.
Fields can appear once per highlights panel. Fields already in use appear grey in the field-selection lists.

To remove fields, click the appropriate column and select -None- from the field-selection lists.
To add columns, click Add Column.
To remove columns, hover over the column and click
.
To save highlights panel changes, click OK in the Highlights Panel Properties dialog box. When you've finished
editing the page layout, click Save. Don't navigate away from the page layout before clicking Save or you'll lose your
changes.

Creating a Service Cloud Console App
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed
To view apps:

“View Setup and Configuration”

To manage apps:

“Customize Application”

You create the Service Cloud console as a custom app that users select from the Force.com app menu. The number of Service
Cloud console apps you can create is based on your custom app limits.
1.
2.
3.
4.

Click Your Name ➤ Setup ➤ Create ➤ Apps.
Click New.
Select Service Cloud console and click Next.
Specify a label for the app. The label can have a maximum of 40 characters, including spaces. This label is the app's name
in the Force.com app menu.
5. Optionally, enter a description of the app.
6. Click Next.
7. Select the items to include in the navigation tab. For example, if you want users to choose accounts from the navigation
tab, move Accounts from Available Navigation Tab Items to Selected Navigation Tab Items.
•
•

Click the left and right arrow buttons to add or remove items.
Click the up and down arrow buttons to define the order in which items display on the navigation tab when it's clicked.
Note: You can't add forecasts, ideas, answers, connections, portals, console, home, or buttons for customizing
your organization to the navigation tab. You can add Google AdWords to the navigation tab, but it might not
display correctly in the Service Cloud console.

8. Click Next.
9. Choose how items display in the Service Cloud console when they're not selected from a primary tab or subtabs. For
example, when users select cases from list views, search results, or screen pops, you can choose whether cases display as
primary tabs or as subtabs on parent records.
Next to an object, click:
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As a primary tab to display the object's records as primary tabs.
As a subtab of to display the object's records as subtabs. From the drop-down list, choose the parent record where

the subtabs will appear. For example, if you want cases to appear as subtabs on contacts, select Contact Name (Contact)
in the Cases row. If parent records don't apply, subtabs appear as primary tabs. For example, if you make campaigns a
subtab of leads but a lead doesn't belong to a campaign, that campaign appears as a primary tab.
10. Click Next.
11. Assign the Service Cloud console to user profiles:
a. Check the Visible box to choose the user profiles for which the app will be available.
b. Check the Default box to set the app as that profile’s default app. This means that new users who have the profile
will see this app when they log in for the first time. Profiles with limits are excluded from this list.
12. Click Save.
Tip: You must refresh your browser to see any setup changes to the Service Cloud console.

Setting Up Interaction Logs
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed
To set up interaction logs:

“Customize Application”

The Service Cloud console lets users write notes on records that appear on primary tabs. A set of notes is called an interaction
log.

Creating Interaction Logs
You can create multiple interaction logs and customize them to display specific task fields for different users to update.
1.
2.
3.
4.

Click Your Name ➤ Setup ➤ Create ➤ Interaction Log Layouts.
Click New.
Name the interaction log.
Select task fields to add to the interaction log and click Add.
•
•
•

* indicates required fields.
You can only add editable task fields to interaction logs.
The Enter your notes here... field is automatically added to all interaction logs; you can't remove it.

5. If you want this interaction log to be the default for all users, select Set as default layout.
You can't delete a default interaction log; you must first mark another interaction log as the default for your organization.
6. Click Save.
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Tip: You can create custom fields for tasks and add them to interaction logs. For example, you can create a Caller
Disposition picklist with values of Angry, Neutral, and Satisfied.

Assigning Interaction Logs
After you set up or customize interaction logs, you can assign them to different user profiles.
1.
2.
3.
4.

Click Your Name ➤ Setup ➤ Create ➤ Interaction Log Layouts.
Click Log Layout Assignment.
Choose an interaction log to assign to each user profile.
Click Save.
Note: You can't assign interaction logs to portal user profiles because the Service Cloud console isn't available to
portal users.

Using the Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Unlike standard Salesforce.com pages, all items you click in the Service Cloud console display as tabs. Tabs let you quickly:
•
•
•

Find, update, and create records
Review and update records from lists
Display all the information you need on one screen without losing context

When you select a Service Cloud console from the Force.com app menu, the navigation tab appears. Use the navigation tab
to select an object and view its home page. Click any record in the home page to open the record as a primary tab. Primary
tabs display the main work item, such as an account. Related items on a primary tab are subtabs. In the example below, the
Acme, Inc. account is the primary tab and the Carole White contact is its subtab.

Figure 1: Service Cloud Console Tabs
1. Navigation tab
2. Primary tab
3. Subtab
With the Service Cloud console, you can:
•
•

Work with tabs
Search for records
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View and edit record details
Jot notes on records using the interaction log
Follow records using Chatter
Use a Salesforce CRM Call Center SoftPhone

Working with Tabs in the Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

All items you click on in the Service Cloud console display as tabs. Tabs let you see all the information you need on one screen
without losing context.

Navigation Tab
•
•
•
•

The Service Cloud console displays one navigation tab.
Your Salesforce.com administrator determines the list of objects you can choose in the navigation tab.
Most object home pages selected from the navigation tab display list views. Views automatically display as enhanced lists.
The navigation tab doesn't display forecasts, ideas, answers, connections, portals, console, home, or buttons for customizing
your organization. Administrators can add Google AdWords to the navigation tab, but it might not display correctly in
the Service Cloud console.

Primary Tab and Subtabs
•

•
•
•
•
•
•
•
•
•

displays on tabs where you haven't saved changes, except for tabs that display reports, Visualforce pages, or your
organization's setup pages. It also displays on tabs where you haven't saved changes to the interaction log. We recommend
that you save your changes often so that you don't lose any updates if your session ends. If you click and select Save all
changes, only tabs with save changes.
displays on tabs where you need to fix errors.
Salesforce.com doesn't limit the number of tabs you can display.
The tab's name lets you see at a glance its contents. If a name is truncated to fit a tab, you can hover over the tab to view
the item's full name. A tab that displays a page outside of Salesforce.com is named External Page.
To return to any item, click on its tab (tabs don't close until you close them).
To clear your Service Cloud console of all tabs and start fresh, click and select Close all primary tabs or Close all
subtabs.
A new tab doesn't display when you click a custom button or change a record's type, owner, or territory. Instead, the current
tab goes to the item you selected.
If you click Cancel on a newly created item that you haven't saved, the item and its tab are deleted and not sent to the
Recycle Bin.
All Salesforce CRM Content items display as primary tabs in the Service Cloud console.
If you click a custom link or a link in a text field, such as http://www.salesforce.com/ in a case Description, the link
displays in a popup window instead of a tab.
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Searching for Records in the Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

To search for records while using a Service Cloud console, type keywords in the Search box in the header and click Go!.
Search in the Service Cloud console matches the capabilities of sidebar search and advanced search or global search if it's
enabled.
Note: Articles and solutions aren't searched with sidebar search or advanced search.

Viewing and Editing Details on the Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Under every primary tab in a Service Cloud console, a highlights panel displays a subset of detail fields. When you change
those fields, the highlights panel updates automatically. You can't directly edit details in the highlights panel.
•

•
•
•
•

If your organization enabled inline editing, you can edit fields directly on the detail page. Alternatively, to display the page
in edit mode, click Edit, make your changes, and click Save. To save the current record and create another one, click Save
& New.
To quickly create a related item on the current record, click Create... and select the item.
To display or hide the highlights panel, click
.
To specify different fields for the highlights panel, ask your Salesforce.com administrator.
To display:
-

A link to the record in an email, click

-

The record and its URL in a new browser window, click

.

-

A printable view of the record in a popup window, click

.

-

“Customize the display” in the Salesforce.com online help of related lists in the detail view of the record, click

-

An online help page for the record, click

.

.

.
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Jotting Notes on Records in the Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed
To save notes in the interaction log:

“Edit Tasks”

The interaction log lets you jot notes on records that display on primary tabs in the Service Cloud console. You can access the
log from the footer of the Service Cloud console if you're assigned to an interaction log layout.
•

To add notes to a record, type your notes in the Enter your notes here... field, update any other fields as necessary,
and click Save Log. Optionally, click Save & New Log to save your notes and start a fresh interaction log. If you use a
SoftPhone, you can click End Call to end a call and save any updates you've made to the interaction log for screen pops
from inbound calls.
Last Saved shows when you saved notes during your current session.

•
•
•

•
•

To show or hide the interaction log, click
or . The log only displays in the footer of the console.
You can drag the bar in between the interaction log and a detail page to resize the height of either one.
The interaction log only displays on items that have an Activity History related list, such as accounts and contacts. The
interaction log isn't available for items like reports, dashboards, Salesforce CRM Content, the Article Management tab,
or Visualforce pages that display as primary tabs.
Interaction logs are archived as tasks on the Activity History related list for easy review and retrieval.
Administrators can customize interaction logs to include task fields.

Following Records in the Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

If you're using a Service Cloud console, and Chatter is enabled, you can display or hide a Chatter feed with comments and
posts about a record.
•
•

To follow a record, meaning you'll see updates to the record in your Chatter feed, click
Follow. To stop following,
click Following .
Show or hide Chatter feeds using the Show Chatter and Hide Chatter links at the top of a feed.
Note: Your administrator determines which Chatter tabs you can choose in the navigation tab, such as People or
Groups.
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Using a SoftPhone with the Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed
To view and use the SoftPhone:

Member of a call center

Click
to display a SoftPhone from the footer of the Service Cloud console. You can access the SoftPhone if you're assigned
to a call center using a CTI adapter built with version 3.0 of the CTI Toolkit.
The SoftPhone lets you:
•
•
•
•
•
•
•

Make calls by dialing a number in the SoftPhone, choosing a number in an online directory, or clicking a phone number
in any record
Receive calls
Quickly view all records related to a call, such as contacts, cases, or accounts
Transfer calls
Initiate conference calls
Put callers on hold
Attach records to calls

Use the interaction log to write notes in call logs while using the Service Cloud console. A call log is an activity record that
automatically generates when you use the SoftPhone; it tracks the phone number, caller, date, time, and duration of the call.
You can view call logs in the Activity History related list of any record associated with the call.
Important: Data might not save properly if you:
•
•

Refresh your browser during a call.
Use the SoftPhone in multiple browsers simultaneously. For example, if you use the SoftPhone in a browser with
the Service Cloud console and switch to a SoftPhone in a browser without the Service Cloud console, any changes
you made with the SoftPhone might not save.

Tips on Using a SoftPhone with the Service Cloud Console
•
•

When you leave the Service Cloud console, the SoftPhone displays in the sidebar of every Salesforce.com page.
You can't move the SoftPhone away from the footer of the Service Cloud console, but you can drag the bar on top of it to

•

resize its height or hide the SoftPhone by clicking
.
You can click End Call on the SoftPhone to end a call and save any updates you've made to the interaction log.
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About CTI 3.0 SoftPhones
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

A SoftPhone is a customizable call-control tool that appears to users assigned to a call center with machines on which CTI
adapters have been installed. SoftPhones built with version 3.0 of the CTI Toolkit display in the footer of the Service Cloud
console or in the sidebar of every Salesforce.com page. Although administrators and developers can customize CTI 3.0
SoftPhones, they usually include the following components:

Call center state area
Includes a drop-down list that lets you specify whether you're ready to receive calls. See “Changing Your Call Center
State” in the Salesforce.com online help.
Phone line header
Shows the status of the phone line. A status icon changes colors and blinks ( ), and provides a text description. You
can click the name of the line (Line 1) to show or hide the line's dial pad and call information area.
Call information area
Shows data related to the call, such as the phone number the customer used to dial, the duration of the call, and links
to any records associated with the call.
Call button area
Shows buttons that let you make call commands, such as dialing, hanging up, putting a caller on hold, transferring,
conferencing, and opening a second line while on a call. See “Using the SoftPhone” in the Salesforce.com online help.
My Calls Today report
Opens a report of all the calls you've made or received in the last day.
SoftPhone logo
Displays a customizable logo for each CTI adapter.
Note: Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.
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Computer-Telephony Integration (CTI) 3.0: Service Cloud
Console Integration
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Salesforce CRM Call Center seamlessly integrates Salesforce.com with third-party computer-telephony systems. With Winter
'11, developers and partners can use a new CTI Developer's Toolkit to build CTI adapters for call center users working with
the Service Cloud console.

Implementation Tips
•
•

Call center users can only use a SoftPhone in the Service Cloud console if they're using a CTI adapter built with version
3.0 of the CTI Toolkit. A SoftPhone is a customizable call-control tool.
You can't move the SoftPhone away from the footer of the Service Cloud console.

Best Practices
•

•

Although developers and partners with Professional, Enterprise, Unlimited, and Developer Editions can build CTI adapters
with version 3.0 of the CTI Toolkit, we recommend they purchase the Service Cloud so that they can use and test CTI
adapters with the Service Cloud console.
Inform call center users that:
-

They can click
to display a SoftPhone from the footer of the Service Cloud console
When they leave the Service Cloud console, the SoftPhone displays in the sidebar of every Salesforce.com page

Salesforce.com CTI Toolkit Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Developers use a CTI (computer-telephony integration) toolkit provided by salesforce.com to build CTI adapters that integrate
Salesforce.com with third-party CTI systems. The CTI Toolkit helps developers build CTI adapters that Salesforce CRM
Call Center users install on their machines so they can use the features of a CTI system through the Salesforce.com SoftPhone.
There are three versions of the CTI Toolkit. Each version provides users with different Salesforce CRM Call Center
functionality. However, salesforce.com only distributes CTI Toolkit version 3.0 or higher. The following table lists the
functionality available in CTI adapters built with each CTI Toolkit:
Functionality

Version 1.0 or Higher

Version 2.0 or Higher

Version 3.0 or Higher

Change the fields and order
of fields that display in a
SoftPhone
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Version 1.0 or Higher

Version 2.0 or Higher

Version 3.0 or Higher

Change the objects and order
of links to objects that display
in a SoftPhone
Specify the fields that display
in the SoftPhone if a single
record for a particular object
is found
Specify screen pop settings for
inbound calls with single,
multiple, or no record matches
Specify screen pops for
inbound calls to display in
browser windows that are
already open, or in new
browser windows or tabs
Specify screen pops to
Visualforce pages for inbound
calls
Specify screen pops to search
pages for inbound calls with
multiple record matches
View a call center's version in
a Version field (click Your
Name ➤ Setup ➤ Customize
➤ Call Center ➤ Call
Centers and choose a call
center)
View an enhanced SoftPhone
user-interface in the footer of
the Service Cloud console
Log calls in the customizable
interaction log of the Service
Cloud console

For information on customizing and building CTI adapters, see the CTI Toolkit Developer's Guide.
Partners and developers can download the CTI Toolkit by visiting developer.force.com. The CTI Toolkit provides you with
all of the source code, libraries, and files you need to develop your own custom CTI adapter.
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About CTI 3.0 SoftPhones
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

A SoftPhone is a customizable call-control tool that appears to users assigned to a call center with machines on which CTI
adapters have been installed. SoftPhones built with version 3.0 of the CTI Toolkit display in the footer of the Service Cloud
console or in the sidebar of every Salesforce.com page. Although administrators and developers can customize CTI 3.0
SoftPhones, they usually include the following components:

Call center state area
Includes a drop-down list that lets you specify whether you're ready to receive calls. See “Changing Your Call Center
State” in the Salesforce.com online help.
Phone line header
Shows the status of the phone line. A status icon changes colors and blinks ( ), and provides a text description. You
can click the name of the line (Line 1) to show or hide the line's dial pad and call information area.
Call information area
Shows data related to the call, such as the phone number the customer used to dial, the duration of the call, and links
to any records associated with the call.
Call button area
Shows buttons that let you make call commands, such as dialing, hanging up, putting a caller on hold, transferring,
conferencing, and opening a second line while on a call. See “Using the SoftPhone” in the Salesforce.com online help.
My Calls Today report
Opens a report of all the calls you've made or received in the last day.
SoftPhone logo
Displays a customizable logo for each CTI adapter.
Note: Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.
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Checking the Version of Your CTI Adapter
Available in: Professional, Enterprise, Unlimited, and Developer Editions

To check which version of the CTI adapter you've installed on your machine:
1. Run the CTI adapter from where it's installed. For example, from the Start menu, select All Programs ➤ salesforce.com
➤ CTI Adapter 2.0 ➤ Salesforce.com Adapter 2.0.
2. Right-click the icon in the system tray of your computer. The system tray is located next to the clock in the lower-right
corner of your screen.
3. Click About...
The version of your CTI adapter displays under CTI Connector.

Salesforce Knowledge Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

Salesforce Knowledge enhancements in Winter '11 include:
Chatter Feeds on Articles
If Salesforce Knowledge article types are enabled for Chatter feed tracking, knowledge base users can follow a published
article and see updates in their Home tab feed when the article is removed from publication, republished, or archived.
New in Winter '11, enabling an article type for feed tracking also creates a Chatter feed in published articles. The feed
allows readers to get a sense of the article's history, contribute comments, and see comments from other readers.
New Visualforce Components for Improving Custom Article-Type Templates
Two new Visualforce components, knowledge:articleRendererToolbar and knowledge:articleCaseToolbar, allow users
who are viewing articles with custom templates to rate the articles or view case details. Previously, these functions were
only available for articles assigned to standard article-type templates. For a detailed description of each component, see
the Visualforce Developer's Guide. For an example of creating a custom template using a Visualforce page, see “Creating
Custom Article-Type Templates” in the Salesforce.com online help.
New Apex Option for Automatically Filling Article Fields
If your organization allows agents to create articles while closing cases, the Use Apex customization option on the Your
Name ➤ Setup ➤ Customize ➤ Knowledge ➤ Settings page lets you customize the field values that agents see in draft
articles. For example, you can decide that a specific data category should be selected by default on all draft articles created
from cases.
First, define how the article-type fields should be modified by creating a new Apex class that uses the
KnowledgeArticleVersionStandardController class as its only argument. For a detailed example, see “Example Apex
Customization for Submitting Articles from Cases” in the Salesforce.com online help. After creating your custom class,
select it from the Use Apex customization field on the Knowledge Settings page. Agents who click the Save and
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Create Article button when closing a case will now see your customizations on their draft articles. For step-by-step
instructions on integrating cases with your knowledge base, refer to the Salesforce Knowledge Implementation Guide.
Improved PDF Generation on Case Emails
By default, when a case user automatically creates an article PDF on an email, the PDF includes all the fields visible to
that user. If you want PDFs to be generated according to a different profile, for example, a profile that hides certain
fields from customers, you now have the Use a profile to create customer-ready article PDFs on
cases option on the Your Name ➤ Setup ➤ Customize ➤ Knowledge ➤ Settings page. For more information, see
“Sending Articles from Cases” in the Salesforce.com online help.
New API Object for Article Views
With KnowledgeArticleViewStat you can now retrieve the average number of views for a specified article across all article
types. Alternatively, you can use the article type API Name followed by the __ViewStat extension to query() or
retrieve() most viewed articles from a specific article type. Users must have access to the published version of an
article to retrieve its views. For more information, see the Web Services API Developer's Guide.
New API Object for Article Votes
The KnowledgeArticleVoteStat object provides the average rating for the specified article on a scale of 1 to 5 across all
article types. You can also use the article type API Name followed by the __VoteStat extension to query() or
retrieve() best rated articles from a specific article type. Users must have access to the published version of an article
to retrieve its views. For more information, see the Web Services API Developer's Guide.
Weekly Export Includes Salesforce Knowledge Articles
If your organization is signed up to receive backup files of your data, those files can now include Salesforce Knowledge
articles. You can generate backup files manually once every six days or schedule them to generate automatically at weekly
or monthly intervals. To sign up for data export, contact salesforce.com.
New Fields on Custom Report Types
In article reports created from custom report types, you can now include the Summary and URL Name fields.

Additional Service Cloud Enhancements
Dynamic Milestones for Entitlement Processes
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed
To add milestones to entitlement processes:

“Manage Entitlements”

Milestones are required steps in your support processes, such as first response times on cases. Now you can set a new Start
Time field on milestones to create more complex support processes. For example, after you add a milestone to an entitlement
process (support timeline), you can choose when the milestone starts.
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Select

To

Use If

Milestone Criteria

Calculate the milestone Target Date A milestone's Target Date is based on
when the milestone is applied to a case when it's applied to a case. For example,
(matches case criteria).
reassigning a case to development when
support believes the problem is a defect.
This may or may not match the
This could occur at any time and it's not
Entitlement Process start time, which is
based on the start of the entitlement
usually when a case is created.
process (timeline).

Entitlement Process

Calculate the milestone Target Date A milestone's Target Date is based on
when the entitlement process starts (by the start of the entitlement process
default, when a case is created).
(timeline). For example, first response
and resolution times on a case, which
always calculate their Target Date
when the entitlement process starts.

For more information, see “Adding Milestones to Entitlement Processes” in the Salesforce.com online help.

High Volume Customer Portal User License—Generally Available
Available in: Enterprise, Unlimited, and Developer Editions

In Winter '11, the High Volume Customer Portal User license is generally available. After you purchase the license, you can
assign it to Customer Portal-enabled contacts so that large numbers of users can log in to a Customer Portal without affecting
its performance.

Security Sharing Sets
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To grant high-volume portal users access to records:

“Customize Application”

With the generally available release of the High Volume Customer Portal User license, we've made sharing for these users
more flexible. In Winter '11, administrators can create security sharing sets to group high-volume portal users by their profiles
and target them with different levels of access to records. This lets you implement business models that require users within
the same account to have different levels of access. For example, a service and support customer can give management or
specialist users the ability to see all cases under an account, while still assuring that most users see only their own cases.
Note: High-volume portal users include both the High Volume Customer Portal User and Authenticated Website
User license types.
A sharing set allows high-volume portal users to access any record that has a lookup field to an account or contact that matches
the user's account or contact. To create a sharing set:
1. Click Your Name ➤ Setup ➤ Customize ➤ Customer Portal ➤ Settings.
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2. In the Sharing Settings for High-Volume Portal Users related list, click New to create a sharing set, or click Edit next to
an existing sharing set.
3. In the Sharing Set Edit page, enter a name and description.
4. Select the profiles of the users you want to have access.
5. Select the objects you want to grant access to.
The Available Objects list excludes:
•
•
•

Objects with an organization-wide sharing setting of Public Read/Write
Custom objects that aren't specified as available for Customer Portal
Custom objects that don't have an account or contact lookup field

6. In the Configure Access section, click Set Up or Edit next to an object name to configure access for the selected profiles,
or click Del to remove access settings for an object.
Note: Objects with Set Up in the Action column aren't configured for high-volume portal user access. Until you
configure an object, high-volume portal users have limited or no access to its records. For more information on
access, see “About High-Volume Portal Users” in the Salesforce.com online help.
7. Grant access based on an account or contact lookup:
•

•

Select All records where the high-volume portal user's account matches to give high-volume
portal users access to all records associated with their account. For example, choosing this option for cases would give
users access to all cases associated with their account.
Select Only records where the high-volume portal user's contact matches to give high-volume
portal users access only to the records that are associated with their own contact. For example, choosing this option for
cases would give users access only to the cases that they filed, or cases that were filed on their behalf by a support
representative.
Note: One of these options may be unavailable if the object doesn't contain the relevant fields.

8. Choose an access level of Read Only or Read/Write. (If the object's organization-wide sharing setting is Public Read Only,
then only Read/Write is available.)
9. Click Update, then click Save.
Your settings apply to all of your organization's Customer Portals or sites.
For more information, see “About High-Volume Portal Users” in the Salesforce.com online help.

Portal Usage Analytics
Available in: Enterprise, Unlimited, and Developer Editions

With Winter '11, organizations that have Customer Portals or partner portals enabled can set up workflow site usage rules on
the User License object, allowing you to set up an email alert to warn you when your monthly portal logins reach a certain
number or percentage of their total limit.
The User Licenses related list on the company information detail page has two new columns:
•

Monthly Logins Used indicates the number of successful logins for all users associated with a customer or partner

•

portal user license for the month.
Monthly Logins Allotted shows the maximum number of customer or partner portal logins allowed per month.
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For more information, see “Creating Workflow Rules” and “Using Workflow for Sites” in the Salesforce.com online help.

Service Contract Fields Available in Custom Report Types
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed
To create or update custom report types:

“Manage Custom Report Types”

To delete custom report types:

“Modify All Data”

Custom report types allow you to define report criteria from which users can run and create custom reports. With Winter '11,
you can add the following fields to custom report types for service contracts (agreements between you and your customers for
a type of support):
•
•
•

Discount
Grand Total
Status

For more information, see “Setting Up Custom Report Types” in the Salesforce.com online help and “Entitlement Management
Overview” in the Salesforce.com online help.

Updated Status Icons for Entitlements, Service Contracts, and Contract Line Items
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Now, the following status icons appear for entitlements, service contracts, and contract line items if the Status Icon field
is added to their page layouts:
•
•
•

Active
Expired
Inactive

For more information, see “Customizing Page Layouts” in the Salesforce.com online help and “Entitlement Management
Overview” in the Salesforce.com online help.

Users Field Removed from Customer Portal Settings
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To set up and update the Customer Portal:

“Customize Application”

Previously, you could view the number of active users associated with each profile assigned to a Customer Portal by clicking
Your Name ➤ Setup ➤ Customize ➤ Customer Portal, selecting a portal, and viewing the Users field on the Assigned
Profiles section. In Winter '11, the Users field was removed to display the Customer Portal Settings page faster. You can
still view the number of active users associated with each profile assigned to a portal by creating a custom summary report and
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adding Profile to your report columns. For more information, see “Administrative Reports” in the Salesforce.com online
help.

Web-to-Case Limit Increased
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To set up Web-to-Case:

“Customize Application”

Web-to-Case automatically transforms support requests from your company's website to new cases. Now, you can generate
up to 5000 new cases a day using Web-to-Case. Previously, you could generate up to 500 cases a day. For more information,
see “Setting Up Web-to-Case” in the Salesforce.com online help.

Daily Limit for On-Demand Email-to-Case Updated
On-Demand Email-to-Case uses Apex email services to convert email to cases, without you having to download and install
an agent behind your network's firewall. Previously, On-Demand Email-to-Case processed up to 2500 email messages per
day. Now, Salesforce.com limits the total number of messages that all email services combined, including On-Demand
Email-to-Case, can process daily. Salesforce.com calculates the limit by multiplying the number of user licenses by 1,000. For
example, if you have ten licences, your organization can process up to 10,000 email messages a day. For more information,
see “Enabling and Configuring On-Demand Email-to-Case” in the Salesforce.com online help.
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New User Interface Header
Available in: All Editions

Winter '11 introduces a restyled user interface header with new functionality and look and feel, including:
•

Global Search, if you have Chatter

•

A new location for the Setup and Logout links and a new link for your Chatter profile under your name

•

A restyled Force.com app menu

Enabling the New User Interface Header
User Permissions Needed
To modify user interface settings:

“Customize Application”

Enabling or disabling the new user interface theme in your organization automatically enables or disables the new user interface
header. If you previously enabled the new user interface theme, you automatically get the new user interface header with Winter
'11.
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To enable the new user interface theme:
1. Click Your Name ➤ Setup ➤ Customize ➤ User Interface.
2. Select Enable New User Interface Theme.
3. Click Save.
Note: Disabling the new user interface theme also disables Chatter and Global Search.

The new user interface theme updates the look and feel of Salesforce.com and moves user links, such as Setup and Logout,
under the user name for all users in your organization. The new user interface theme is not supported in Portals, Console tab,
or Help & Training.
Only users with supported browsers see the new user interface theme. See “Supported Browsers” in the Salesforce.com online
help.

Global Search
You asked for it! Global Search addresses these ideas on the IdeaExchange: include advanced search function and
content in the standard search.
Available in: All Editions

From the header search box you can search more records, including articles, documents, products, solutions, and Chatter feeds,
files, groups, and people. You can also search more fields, including custom fields, and long text fields such as descriptions,
notes, and task and event comments. You can use wildcards, operators, and filters to refine your search.

Implementation Tips
•
•
•
•

Enabling and disabling Chatter in your organization automatically enables and disables Global Search.
Enable Chatter by clicking Your Name ➤ Setup ➤ Customize ➤ Chatter ➤ Settings, then clicking Edit and selecting
Enable.
Global Search is not supported in partner portal or Customer Portal.
Only users with supported browsers can use Global Search. See “Supported Browsers” in the Salesforce.com online help.

How Global Search Works
Available in: All Editions

How your Global Search works depends on your search options, search terms, and the use of wildcards and operators.
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Search Options
Global Search searches more record types, including articles, documents, products, solutions, and Chatter feeds, files,
groups, and people. Global Search also searches more field types, including custom fields and long text fields such as
descriptions, notes, and task and event comments.
Search options let you choose one or more items, including tags and specific objects, by which to limit your search. You
can also restrict your search to records for which you are the owner and to divisions, if your organization uses them.
Search options aren't available to Chatter Only users.
Search Terms
Search terms are treated as separate words and may be found in different searchable fields within a record. For example,
searching for bob jones returns items with Bob Jones, as well as a contact named Bob Smith whose email address is
bsmith@jones.com.
Search terms are separated by letter, number, and punctuation boundaries. For example, searching for acct!4 returns
items with Acct, !, and 4, even if those terms are in separate places in the item.
Wildcards and Operators
You can use the * (asterisk) and ? (question mark) wildcards to refine results. Use * to match one or more characters, or
? to match a single character. For example, searching for bob jo* finds items with Bob Jones and Bob Johnson, and
searching for jo?n finds items with john and joan. You can also use the AND, OR, AND NOT, ( ) (parentheses), and
" " (quotation marks) operators to refine results.

Changing Global Search Options
Available in: All Editions

1. Click the header search box and select Search Options....
Search options aren't available to Chatter Only users.
2. Refine your search results by:
Choosing which objects to search
In the Records section, select the objects for which you want to return search results. If you don't select any objects,
your search returns all possible objects. Select All or click Clear All to quickly select all or no objects.
Note: When All is selected, the search results don't return article management and content records. You
can search for these records on their respective tabs.

Searching only items you own
In the More Options section, select Limit to items I own.
Note: When Limit to items I own is selected, the search results don't return article, asset, idea, invoice,
order, people, product, question, quote, and reply records because these records don't have owners.
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Searching for an exact phrase
In the More Options section, select Exact phrase. This is the same as using quotation marks around your search
string.
Searching within a division
If you have the “Affected by Divisions” permission, specify which divisions you want to search. If your organization
uses divisions but you don't have the “Affected by Divisions” permission, your search results include records in all
divisions.
3. Click Search.
If you restrict your search options, the options you select appear under the header search text box. Click your selected
options to change your search options again. Click to clear your search terms and restricted options.

Search Results
Available in: All Editions

The Search Results page displays items in related lists for each object, custom object, and tag that you have permission to view.
From this page:
•

Jump directly to an object's results—click a related list item on the left side of the page if you're using Global Search or at
the top of the page if you're using Sidebar Search or Advanced Search.
The number of results for each object is displayed. For example, Contacts [25+] means there are more than 25 contacts
that match your search criteria. If your search returns a large number of results for a particular object, click Next Page or
Previous Page to view the results.

•
•
•
•
•
•

View or edit items—click an item to open it or click Edit, if available.
Jump to Chatter feed results—click Chatter Feed Results at the top of the page, if available.
Customize columns in your search results.
Filter your search results.
Customize filters for all users' search results, if you're an administrator.
Refine your search—click the search box and select Search Options... if you're using Global Search or click Advanced
Search... if you're using Advanced Search.
Search options aren't available to Chatter Only users.

Chatter Feed Search Results
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Chatter feed Search Results page displays Chatter users' posts and comments that include your search terms.
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Note: Feed-tracked changes on records and fields aren't included in search results. For example, if you've enabled
feed tracking on the Billing Address field for the Acme account and modified the Acme billing address, search
results for Acme include Acme — Suzanne Powell Looking for volunteers to help with the Acme account but don't include
Acme — Suzanne Powell changed Billing Street to 10 Main Road.
•
•
•
•

To view the detail pages for Chatter files, groups, and people, click the respective name in the update.
To view a single feed update, click the timestamp below the update, for example, Yesterday at 12:57 AM.
To download or preview files, click Download or Preview next to the file. Preview lets you see the file without downloading
it.
To refine your search, click the search box and select Search Options....
Search options aren't available to Chatter Only users.

To view search results for records, such as accounts, contacts, and Chatter files, groups, and people, click Record Results at
the top of the page.

Analytics Enhancements
Salesforce.com analytics enhancements in Winter '11 include:
Real-Time Report Builder—Generally Available

You asked for it! Report builder addresses the following ideas on the IdeaExchange: drag-and-drop report
columns, display report type on report, show long report type names, easier customization, better sorting, and consistent
button placement.
First introduced in Spring '10 as a Developer Preview release, report builder—the powerful new visual editor for reports—is
now generally available! The “Report Builder” permission is turned on automatically for the System Administrator profile;
administrators can turn it on for other profiles. See the following topics for details:
•
•
•
•
•
•
•

Report Builder Overview
Working with Report Builder
Working with Fields in Report Builder
Working with Summary Fields in Report Builder
Working with Groupings in Report Builder
Working with Formulas in Report Builder
Creating Charts

Dashboard User Switching

You asked for it! This enhancement is from an idea on the IdeaExchange.
Now, authorized users can switch the running user from the view page of dynamic dashboards. Dynamic dashboards run
using the security settings of the logged-in user, but users with the “View My Team's Dashboards” or “View All Data”
permission can change the running user to view data from the perspective of someone else on their team or organization.
The “Manage Dynamic Dashboards” and “View My Team's Dashboards” permissions are turned on automatically for
the System Administrator profile; administrators can turn them on for other profiles.
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See Setting Up Dynamic Dashboards for details.
Reports and Dashboards Chatter

You asked for it! This enhancement is from an idea on the IdeaExchange.
In Winter '11, reports and dashboard have Chatter feeds! Follow posts, comments, files, and links, as well as field updates
for your favorite report or dashboard. See Chatter Feeds Enhancements on page 22 for details.
Chatter Analytics
You can now create custom report types on the following Chatter objects:
•
•
•
•

Users | Followers
Users | User Feed | Comments
Chatter Groups | Members
Chatter Groups | Chatter Group Feed | Comments

Users and Chatter Groups are the primary objects. See “Defining Custom Report Types” in the Salesforce.com online
help.
API Access for Reports and Dashboards
The following new objects have been added to API version 20.0:
•
•
•
•
•
•

Dashboard
DashboardFeed
DashboardTag
Report
ReportFeed
ReportTag

See Web Services API Enhancements on page 116 for details.
Click-to-Detail for Dashboard Components
We've added a new option to the Drill Down to field for dashboard components. With this option, when users click
chart or table elements, axis values, or legend entries, they are taken to the detail page for that record.
To select this option:
1. Edit a dashboard component.
2. Set the Drill Down to option to Record Detail Page.
You can only choose this option for tables and charts that use a source report grouped by record name, record owner, or
feed post.
Metric Inline Editing
Now you can edit metric labels directly on metric components using dashboard builder, much like component titles,
headers, and footers. Just click the empty text field next to the grand total. The “Drag-and-Drop Dashboard Builder”
permission is turned on automatically for the System Administrator profile; administrators can turn it on for other
profiles.
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Improved Chart Validation on Reports
We've made enhancements to chart validation for reports. When you change the report format, chart settings are validated
and updated accordingly.

About Analytics Enhancements
Report Builder Overview
Available in: All Editions

Report builder is a visual editor for reports. The report builder interface consists of three panes: Fields, Filters, and Preview.
Talk to your administrator to enable report builder.
Note: To optimize screen real estate, report builder uses a compressed page header. To view your application tabs,
simply close the builder or click the Salesforce.com logo.
Fields Pane
The Fields pane lists all accessible fields in the selected report type, organized by the sections defined in the page layout.
Find the fields you want using the Quick Find search box and field type filters, then drag them into the Preview pane
to add them to the report.
Create, view, edit, and delete your custom summary formulas in the Fields pane as well.
Filters Pane
Set the view, time frame, and custom filters to limit the data shown in the report.
Preview Pane
The dynamic preview makes it easy for you to customize your report. Add, reorder, and remove columns, summary fields,
formulas, and groupings. Change the report format and display options, or add a chart.
The preview shows only a limited number of records. Run the report to see all your results.
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Working with Report Builder
Available in: All Editions

User Permissions Needed
To create, edit, and delete reports:

“Create and Customize Reports”

To create, edit, and delete reports using the report builder
interface:

“Report Builder”

To customize an existing report using report builder, click the name of a report and click Customize. Talk to your administrator
to enable report builder.
Note: To optimize screen real estate, report builder uses a compressed page header. To view your application tabs,
simply close the builder or click the Salesforce.com logo.
Using the report builder, you can:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Click Close to exit the report builder.
Save or run the report.
Click Report Properties to change a report's name, description, or folder.
Find fields using Quick Find and field-type filters.
Add fields to the report by double-clicking or dragging them into the Preview pane.
Summarize fields on reports.
Add and reorder groupings on summary and matrix reports.
Add custom summary formulas to summary and matrix reports.
Set report filters in the Filters pane.
Click the Format drop-down to choose between tabular, summary, and matrix formats.
Click the Show drop-down to toggle the Details, Drop Zones, and Chart options, and edit Conditional Highlighting
and Display Currencies Using.
Click Add Chart to define a chart for the report.
Reorder columns by dragging them.
Sort the report by a particular column.
Maximize the Preview pane by resizing or collapsing the Fields and Filters panes.
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Working with Fields in Report Builder
Available in: All Editions

User Permissions Needed
To create, edit, and delete reports:

“Create and Customize Reports”

To create, edit, and delete reports using the report builder
interface:

“Report Builder”

The Fields pane lists all accessible fields in the selected report type, organized by the sections defined in the page layout. It
also lists custom summary formulas, which you can create, edit, and delete. Talk to your administrator to enable report builder.
Finding Fields
Find a field by typing its name into the Quick Find search box. You can also filter the list by type:
•

Click

to see all field types, as well as custom summary formulas.

•

Click

to see just text fields.

•

Click

to see just number fields (numeric, percentage, or currency).

•

Click

to see just date fields.

Adding and Removing Fields
To add a field to your report, double-click it or drag it into the Preview pane. Drag an entire folder to add all its fields.
To remove a field, grab its column header and drag it back to the Fields pane. You can also click the column menu and
choose Remove Column, or click Remove All Columns. While Show ➤ Details is disabled, you can only add summary
fields.
Ordering and Sorting Fields
Reorder report columns by grabbing a column header and dragging it to a new location. To sort your report by a column,
click its column header. You can also click the column menu and choose Sort Ascending or Sort Descending from the
drop-down list. Sort is disabled when Show ➤ Details isn't selected
Changing the Currency Displayed
If your organization has enabled multiple currencies, you can change the currency shown for all currency fields. Click
Show ➤ Display Currencies Using, then select an active currency to display.
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Working with Summary Fields in Report Builder
Available in: All Editions

User Permissions Needed
To create, edit, and delete reports:

“Create and Customize Reports”

To create, edit, and delete reports using the report builder
interface:

“Report Builder”

The Fields pane lists all accessible fields in the selected report type, organized by the sections defined in the page layout.
A summary is the Sum, Average, Max, or Min for a number field. (Use the
filter to find them faster.) Summary fields
show at all grouping levels and the grand total level for summary and matrix reports.
To add a summary field:
•
•

•

Double-click a number field in the Fields pane.
Drag a number field into the preview. For matrix reports, there are drop zones before, between, and after sets of summaries.
For example, the sum, average, max, and min of Annual Revenue are a set, and you can't drop a new summary field
between them.
Choose Summarize this Field in the menu for a field already in the report.

To change an existing summary field, or add other summaries on that same field, click
and choose Summarize this Field.

button next to the summary field

To remove a summary field:
•
•
•

Click its menu and choose Summarize this Field and deselect all options.
Click its menu and choose Remove Summary.
Drag the summary set back to the Fields pane. Note that all summaries for that field are removed.

Reorder sets of summary fields in matrix reports by dragging them. The summaries for each field move together when dragged.
For example, if your report contains the sum and average of Annual Revenue, and the max and min of Probability,.you
can drag the Probability summaries before or after the Annual Revenue summaries, but not between. Summaries can't
be placed after custom summary formulas or Record Count.
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Working with Groupings in Report Builder
Available in: All Editions

User Permissions Needed
To create, edit, and delete reports:

“Create and Customize Reports”

To create, edit, and delete reports using the report builder
interface:

“Report Builder”

The Fields pane lists all accessible fields in the selected report type, organized by the sections defined in the page layout. A
report grouping determines how report data is aggregated for columns or rows for summary and matrix reports.
Add a group by dropping a field onto a drop zone. Click Show ➤ Drop Zones to make them visible. You can also click a
column menu for a field in the report and choose Group by this Field.
Note: Summary reports can have up to three grouping levels. Matrix reports can have two row and two column
groupings. For matrix reports, you can't use the same field for both row and column groupings.
To remove a group, click the group menu and choose Remove Group. You can also grab the group and:
•
•

Drag it to the column bar to remove the group, but keep the field as a column in the report.
Drag it back to the Fields pane to remove the group and the field from the report.

Drag groups to change their order, or click the group menu and choose Move Group Up or Move Group Down for column
groupings, or Move Group Left or Move Group Right for row groupings.

Working with Formulas in Report Builder
Available in: All Editions

User Permissions Needed
To create, edit, and delete reports:

“Create and Customize Reports”

To create, edit, and delete reports using the report builder
interface:

“Report Builder”

The Fields pane lists all accessible fields in the selected report type, organized by the sections defined in the page layout.
Formulas let you create custom summaries based on calculated values using report data. These formulas can then be used as
columns in your report.
To add a new formula to a summary or matrix report, double-click Add Formula. Once you define it and click OK, it's
automatically added to the preview as a column for summary reports, and a summary field for matrix reports. To edit a formula,
hover over the name in the Fields pane and click .
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To remove a formula from the preview, grab its header and drag it back to the Fields pane, or click its menu and choose
Remove Formula. Removing a formula from the preview doesn't delete it. To delete a formula, hover over the name and click
, or click Delete Formula from the field menu.

Creating Charts
Available in: All Editions

User Permissions Needed
To create, edit, and delete reports:

“Create and Customize Reports”

To create, edit, and delete reports using the report builder
interface:

“Report Builder”

To add or edit a chart:
1. Click Add Chart in report builder. Your report must have at least one grouping before you can add a chart. For existing
charts, click Edit Chart.
2. Select a chart type.
3. Enter the appropriate settings on the Chart Data tab for the chart type you selected.
4. Enter the appropriate settings on the Formatting tab.
5. Click OK.

Chart Considerations
•

•
•
•
•

•

You can't have more than 250 groups or 4000 values in a chart. If you see an error message saying that your chart has too
many groups or values to plot, adjust the report filters to reduce the number. In combination charts, all groups and values
count against the total.
If you lose access to a field used in a chart, another field may be used in its place. If no other fields are available, record
count is used.
Decimal-place precision on charts is not customizable. Numeric and currency values round to two decimal places. Percentage
values round to one decimal place.
If numeric values are too large or too small, they are shown in scientific notation. For example, the number 5,750,000,000
is displayed as 5.75E9; -0.0000000061 is displayed as -6.1E-9.
Negative values are displayed on all line charts and non-stacked bar and column charts. Negative values on pie, donut,
funnel, and stacked charts are not displayed. Groupings containing negative values are displayed in the legend, and negative
values are reflected in the calculation of all summary values, including the total for donut charts.
When creating charts, don't group by a field on a child object then sum by a field on the parent object. It's not good practice.
If you do this with a donut chart, the total shown may not match the sum of the wedges.
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Setting Up Dynamic Dashboards
Available in: Unlimited and Developer Editions

User Permissions Needed
To create, edit, and delete dynamic dashboards:

“Run Reports”
AND
“Manage Dynamic Dashboards”

To create, edit, and delete dashboards using the dashboard
builder interface:

“Drag-and-Drop Dashboard Builder”

To enable choosing a different running user for the dashboard: “View My Team's Dashboards”
OR
“View All Data”

Your organization can have up to three dynamic dashboards. You can't schedule refreshes for dynamic dashboards. They must
be refreshed manually.
Before you get started, create folders accessible to all dashboard viewers to store dynamic dashboards and corresponding
component source reports.
To create dynamic dashboards:
1. From the Dashboards tab, create a new dashboard or edit an existing one.
2.
Click the
button next to the View dashboard as field.
3. Select Run as logged-in user.
4. Optionally, select Let authorized users change running user to enable those with permission to change the
running user on the dashboard view page, as follows:
•
•

Users with “View My Team's Dashboards” can view the dashboard as any user below them in the role hierarchy.
Users with “View All Data” can view the dashboard as any user in their organization.

5. Click OK.
6. In the View dashboard as field, enter a running user. Enter “*” to see all available users.
7. Save your dashboard.

Tips for Source Reports for Dynamic Dashboards
•
•

Set the appropriate View option on the report run page. For example, if you choose “My Team's Opportunities,” each
dynamic dashboard viewer can see all opportunities for the team.
To avoid restricting the dashboard's view of the data:
-

Make sure advanced filters don't include specific record owners (for example, Opportunity Owner equals
Frank Smith).
Don't click Save Hierarchy Level when saving opportunity reports.
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Force.com Flex Framework—Generally Available
Available in: Enterprise, Unlimited, and Developer Editions
Available for an additional cost in: Professional Edition

The Force.com Flex framework is generally available in Winter '11. The framework facilitates the development of Flex-based
desktop and Web applications that leverage Salesforce.com logic, data, and security. It provides:
•
•
•
•
•
•

Seamless handling of connected and disconnected states for desktop apps, including the detection of Internet connectivity
Adobe’s Data Management Services (DMS), which creates and manages local databases for desktop applications that
operate online and offline
Data synchronization between Salesforce.com and desktop applications
Generated ActionScript classes that mirror your Salesforce.com enterprise WSDL and provide access to Salesforce.com
objects
MXML components to simplify the implementation of user interfaces that render Salesforce.com data, a specialized status
bar, and popup notifications called toasts
An engine and user interface for resolving data conflicts and errors in desktop applications

Force.com Flex is intended for developers with a working knowledge of MXML (Adobe's user interface markup language),
ActionScript (Adobe's scripting language), Adobe Flash Builder 4, and the Force.com API.
To develop in the Force.com Flex Framework, download and install Adobe Flash Builder for Force.com—an enhanced version
of Adobe's Eclipse-based integrated development environment (IDE) with additional features for developing in Force.com
Flex. Adobe Flash Builder for Force.com is available at http://developer.force.com/flashbuilder.

Visual Process Manager—Pilot
Available in: Enterprise and Unlimited Editions

With Winter '11, you can now upload and manage business flows in Salesforce.com. Visual Process Manager, also known as
Force.com Flow, and formerly known as Firefly, provides a robust business-friendly call scripting screen interface on the
Force.com platform.
Force.com Flow gives you the tools to create an application for easily navigating users through a series of screens, and querying
and updating Salesforce.com data, without writing any code. The Flow Designer lets administrators or business analysts quickly
build the flow to connect screens together. It also allows you to execute logic and provides branching capability based on user
input which can be used to build dynamic applications.
Note: Force.com Flow is currently available through a pilot program. For information on enabling Force.com Flow
for your organization, contact salesforce.com.
Force.com Flow features in Winter '11 include:
•
•

Uploading a New Flow or Flow Version
Managing Your Flows
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Editing a Flow

Force.com Flow Overview
Available in: Enterprise and Unlimited Editions

User Permissions Needed
To view a flow:

“View Setup and Configuration”

To upload, activate, deactivate, edit, and delete flows:

“Manage Force.com Flow”

To run a flow from the flow detail page, or to run an inactive “Manage Force.com Flow”
flow:
AND
Force.com Flow User field enabled

To run a flow from a custom link, tab, or URL:

Force.com Flow User field enabled

Note: Force.com Flow is currently available through a pilot program. For information on enabling Force.com Flow
for your organization, contact salesforce.com.
Force.com Flow gives you the tools to create an application for easily navigating users through a series of screens, and querying
and updating Salesforce.com data, without writing any code. The Flow Designer lets administrators or business analysts quickly
build the flow to connect screens together. It also allows you to execute logic and provides branching capability based on user
input which can be used to build dynamic applications.
Popular uses of Force.com Flow:
•
•
•

Call scripting in a customer-support center: Troubleshooting complex customer problems
Telesales: Call scripting, cross-selling, up-selling and dynamic generation of quotes in real-time
Insurance companies: Executing complex and dynamic insurance premium calculations

You can have several different versions of a single flow in Salesforce.com, but only one version of each flow can be active at a
time.
Tip: To ensure the latest version of your flow is active, select the “out of date” filter in the menu to see what version
is running
To get started using flows, click Your Name ➤ Setup ➤ Create ➤ Workflow & Approvals ➤ Flows. From the list page,
you can:
•
•
•

Upload a flow file.
Click the name of a flow to view its details.
Edit the name or description of a flow.

Consider the following when working with flows in Salesforce.com:
•

A flow can't have more than 10 versions in Salesforce.com at a time.
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The maximum number of active flows per organization is 500.
The maximum number of total flows per organization is 1000.
A flow can have a maximum of 2000 steps.
You can't upload a flow larger than 3MB.

Managing Your Flows
Available in: Enterprise and Unlimited Editions

User Permissions Needed
To view a flow:

“View Setup and Configuration”

To upload, activate, deactivate, edit, and delete flows:

“Manage Force.com Flow”

To run a flow from the flow detail page, or to run an inactive “Manage Force.com Flow”
flow:
AND
Force.com Flow User field enabled

To run a flow from a custom link, tab, or URL:

Force.com Flow User field enabled

Note: Force.com Flow is currently available through a pilot program. For information on enabling Force.com Flow
for your organization, contact salesforce.com.
To manage a flow, go to Your Name ➤ Setup ➤ Create ➤ Workflow & Approvals ➤ Flows and click the name of a flow.
On the flow detail page you can:
•

Delete a flow or flow version:
-

Click Delete to delete the flow completely, including all versions.
Click Del in the Spark Versions list to delete inactive versions of the flow.
Note: You can't delete a whole flow or flow version until 12 hours after deactivating it. This ensures that flows in
progress have time to complete. Flows that have never been activated can be deleted immediately.

•

Click the Run button to run the currently active version of the flow. If there is no version of the flow activated, the Run
button runs the latest version of the flow. Alternately, to run an individual flow version, click Run next to the version
name. Only users with both the “Manage Force.com Flow” permission and the Force.com Flow User field enabled
may run inactive flows.
Note: To allow other Salesforce.com users to run active flows, create a custom tab, link, or button pointing to the
flow URL. Users running flows this way must have Force.com Flow User enabled on their user profile. For
more information, see “User Fields” in the Salesforce.com online help.

•
•

Edit the name or description of the flow.
View a list of all versions of the flows that you've uploaded. Flow versions are sorted by Created Date by default.
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Activate a different version of the flow.

•

Note: When you activate a new version of a flow, the previous version is automatically deactivated. Flow processes
currently running continue to run using the version with which they were initiated.
Deactivate the active version of the flow.

•

Uploading a New Flow or Flow Version
Available in: Enterprise and Unlimited Editions

User Permissions Needed
To view a flow:

“View Setup and Configuration”

To upload, activate, deactivate, edit, and delete flows:

“Manage Force.com Flow”

To run a flow from the flow detail page, or to run an inactive “Manage Force.com Flow”
flow:
AND
Force.com Flow User field enabled

To run a flow from a custom link, tab, or URL:

Force.com Flow User field enabled

Note: Force.com Flow is currently available through a pilot program. For information on enabling Force.com Flow
for your organization, contact salesforce.com.
The upload feature is the same whether you're uploading a whole new flow or just a new flow version. How does Salesforce.com
know which is which? When you upload a flow file, Salesforce.com looks at the Unique Name of the file and does a match
for it against any other flows in your organization. If there's a match, the file uploads as a new version of the flow it was
matched with. If there's no Unique Name match, the file uploads as a new flow.
Tip: If you need to upload both a flow and its subflow, upload the subflow first, then the main flow.

To upload a new flow file, go to Your Name ➤ Setup ➤ Create ➤ Workflow & Approvals ➤ Flows.
1.
2.
3.
4.

On the flow list page, click Upload.
Click Browse... to select a flow to upload.
Click Upload.
Click Save.
Important: Only files with the .flow extension can be uploaded into Salesforce.com. To convert .spark files into
.flow files, download the latest version of the Flow Designer from the flow list page, open your file, and save it with
the .flow extension.
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Editing a Flow
Available in: Enterprise and Unlimited Editions

User Permissions Needed
To view a flow:

“View Setup and Configuration”

To upload, activate, deactivate, edit, and delete flows:

“Manage Force.com Flow”

To run a flow from the flow detail page, or to run an inactive “Manage Force.com Flow”
flow:
AND
Force.com Flow User field enabled

To run a flow from a custom link, tab, or URL:

Force.com Flow User field enabled

Note: Force.com Flow is currently available through a pilot program. For information on enabling Force.com Flow
for your organization, contact salesforce.com.
When you upload a new flow, its name and description in Salesforce.com are taken from the name and description fields
within the flow file. However, if you haven't edited them yourself, the content of the name and description fields can fluctuate.
Here's how:
•
•

If you haven't edited the name and description, and there is no version activated, the name and description fields reflect
those of the most recently-uploaded version.
If you haven't edited the name and description, and you activate a version of your flow, the name and description fields
update to reflect those of the active version.
Important: Once you edit the name and description of your flow in Salesforce.com, those fields no longer update
when you upload or activate a new version.

To edit the name or description of a flow, go to Your Name ➤ Setup ➤ Create ➤ Workflow & Approvals ➤ Flows and
click Edit next to a flow name.

Force.com Apex Code Enhancements
Available in: Unlimited, Developer, and Enterprise Editions

Force.com Apex code includes the following enhancements in Winter '11. Refer to the Force.com Apex Code Developer's
Guide for complete information about Apex.
The following enhancements are generally available:
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New isRunningTest method for System
Returns true if the currently executing code was called by code contained in a method defined as testMethod, false
otherwise. Use this method if you need to run different code depending on whether it was being called from a test.
New Extension for KnowledgeArticleVersionStandardController
In Winter '11 you can extend the functionality of KnowledgeArticleVersionStandardController by using the new
selectDataCategory or getSourceId method. After creating the class, assign it to the Use Apex customization
option on the Your Name ➤ Setup ➤ Customize ➤ Knowledge ➤ Settings page. For a detailed example, see
“KnowledgeArticleVersionStandardController class” in the Force.com Apex Code Developer's Guide
New createPersonAccountPortalUser Method for the Site class
Use createPersonAccountPortalUser to create a person account using either the default record type defined on
the guest user's profile or a specified record type, then enable it for the site's portal.
New REQUIRED_FEATURE_MISSING Exception
A new exception message has been added. You can download packages from the AppExchange that contain Apex code
that relies on Chatter being enabled in your organization. If Chatter isn't enabled, or if you disable it, and this code runs,
you receive this error message. This provides managed package developers with a way to catch exceptions related to
Chatter being disabled, and gracefully degrade the behavior of their application appropriately.
Void No Longer Accepted as Variable Type

Prior to Winter '11, you could assign void as a variable data type. While void is still an acceptable return type, you
can no longer use it as a data type. For example, for all Apex code saved using Salesforce.com API version 20.0 or higher,
the following is no longer valid:
Public class ooga{
Void v;
Public void booga(void arg1){
}
}

Improved System Log Console
The improved System Log console is now generally available.
The System Log console is a separate window that displays debugging information, as well as its cumulative limits and source
code. It can be considered a context-sensitive execution viewer, showing the source of an operation, what triggered that
operation, and what occurred afterward. Use the System Log console to view debug logs that include database events, Apex
processing, workflow, and validation logic. Access the System Log console from the Salesforce.com user interface by clicking
Your Name ➤ System Log in the upper right corner of any page.
New for Winter '11:
•
•
•

A Limits tab was added to the Executed Units section. Use the Limits tab to track your governor limits. The limits are
listed by name and amount.
Additional filters to control the logs displayed in the log list.
View logs already generated and monitored, instead of just logs created after the System Log console is open.
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Best Practices
•
•
•

When viewing the debug log in the Execution Log section, click Executable. This filters out all of the non–executable
steps, as well as cumulative limits information.
Use the stack to track the steps of your process.
If your logs are over 2 MB and too large to be displayed, add System.Debug statements to your code, set the debug log
filter for Apex Code to Info and run your transaction again. See “Using the System Log Console” in the Salesforce.com
online help for more information and for additional scenarios on how to use the System Log console.

Revised Governor Limits
For Winter '11, Salesforce.com is reducing the number of items limited by the Apex governor limits. In addition, many of
the remaining items have had their limits increased.
Tests no longer run in a separate context: Prior to Winter '11, governor limits worked with three different contexts, with
different amounts of resources allocated for each context. For Winter '11. tests no longer have specific limits. Instead, they've
been included with triggers, anonymous blocks, Visualforce controllers, and WSDL methods.
Removed limits:
•
•

Total request time for one callout (HTTP request or Web services call) has been removed.
Maximum size for a callout (HTTP request or Web services call) has been removed.

Increases to existing limits:
•
•
•
•

General heap size has been raised from 2 MB to 3 MB, with no scaling. In addition, batch Apex heap size is 6 MB.
Apex classes and triggers have been raised from 100,000 characters and 32,000 characters, respectively, and can now be 1
million characters long, not counting comments, test methods, and classes defined with @isTest.
Maximum amount of Apex code allowed in an organization has been raised from 1 MB to 2 MB.
Total number of ChildRelationship, RecordTypeInfo and PicklistEntry objects allowed and total number of fields calls
allowed has been raised from 10 to 100.

Visualforce Enhancements
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions
Custom controllers and standard controller extensions are not supported in Group or Professional Editions.

Winter '11 introduces several new features that enhance the capabilities of previous versions of Visualforce. For detailed
information on these new features, see the Visualforce Developer's Guide.
The following enhancements are now available in Visualforce:
View State Inspector Available
This View State tab in the development footer is no longer in pilot. The View State tab lists which Visualforce elements
are contributing to the size of your view state. You can use this tab to monitor the performance of Visualforce pages
where users submit data using forms. By minimizing your view state size, you can reduce load times.
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The “Tools for Visualforce Development” chapter contains more information about the View State tab.
Visualforce Support for Record Types
Starting with the Winter '11 release, Visualforce pages now support record types. Record types allow you to offer different
business processes, picklist values, and page layouts to different users based on their profiles.
Your record type definitions affect the rendering of <apex:inputField> tags in the following ways:
•

If the <apex:inputField> tag refers to a picklist field that's filtered by a record type:
-

•

The rendered <apex:inputField> component only displays options compatible with that record type.
If the <apex:inputField> component is bound to a dependent picklist with a rendered and editable controlling
field, only options compatible with both the record type and the controlling field value display.

If the <apex:inputField> tag refers to a record type field:
-

If the user can change the field’s record type, or select a record type for the new field, the <apex:inputField>
component renders as a drop-down list. Otherwise, it renders as read-only text.
It's the developer's responsibility to either refresh the page or rerender filtered picklists when the list changes.

In addition, the <apex:outputField> tag's support for record types is identical to a read-only implementation of the
<apex:inputField> behavior.
Visualforce Components for Chatter
Visualforce now supports the following Chatter components:
•
•
•
•

<chatter:feed>: Displays the Chatter feed for a record.
<chatter:feedWithFollowers>: An integrated UI component that displays the Chatter feed for a record, its

list of followers, and optionally, a header bar that allows users to show or hide the Chatter feed and subscribe to it.
<chatter:follow>: Renders a button for a user to follow or unfollow a Chatter record.
<chatter:followers>: Displays the list of Chatter followers for a record.

In addition, the <apex:detial> component has a new showChatter attribute that specifies whether to display the
Chatter feed, followers list, and header bar for the record.
Note: Chatter components don't render for organizations that aren't Chatter enabled. Chatter components
don't render for Visualforce pages using Force.com sites.

New Visualforce Components for Salesforce Knowledge
Visualforce now supports the following Salesforce Knowledge components:
•

•

knowledge:articleCaseToolbar: Allows custom article-type templates to include case detail information. If

an article is assigned to a custom article-type template that uses this component, knowledge base users who open the
article from a case see case detail information at the same time they're viewing the article's contents. Previously, this
ability was only available on articles that use standard article-type templates.
knowledge:articleRendererToolbar: Allows custom article-type templates to include voting capability. If
an article is a assigned to a custom article-type template that uses this component, knowledge base users viewing the
article see the same header (toolbar) information that appears in articles with standard article-type templates.
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The <apex:inputField> Tag Keeps Default Values
As of Salesforce.com API 20.0, if an object has a field with a default value, and a Visualforce page is constructed using
an <apex:inputField> tag that points to that field, the Visualforce page will be rendered with the default value
already set.
Note: Clearing a field's default value in the constructor of a custom Apex controller or extension won't work.
For example:
public MyConstructor {
account = new Account();
account.myFieldWithDefault__c = 'override the default!'’;
// this works
}
public MyOtherConstructor {
account = new Account();
account.myOtherFieldWithDefault__c = null;
// this doesn't work
}

You must clear a field's value after the page has been loaded, either conditionally or explicitly.
Changes to Date/Time Evaluations in Formula Expressions
All formula expressions and functions that rely on the date/time data type evaluate as date/time types as of Salesforce.com
API version 20.0. Previously, they may have been incorrectly interpreted as just a date type.

Web Services API Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

The Web services API version 20.0 contains new features and bug fixes that improve the capabilities of applications that
leverage the Force.com platform. Considerable effort has been made to ensure backwards capability for applications that have
been written against previous versions of the API, starting with API 2.5.
The new API provides a number of powerful enhancements that further improve any integration already in place between
Salesforce.com and your other systems.

Generally Available Enhancements
The Web services API has been improved for Winter '11 (API version 20.0):
New Objects
The following new objects have been added in API version 20.0:
•
•
•
•
•

The CaseArticle object represents the association between a case and an article.
The ContentDocumentFeed object represents a single feed item in a content document record feed.
The Dashboard object shows data from custom reports as visual components. Access is read-only.
The DashboardFeed object represents a single feed item in the feed displayed on a dashboard. It shows changes to
dashboard fields tracked in feeds, as well as posts and comments about the dashboard.
DashboardTag associates a word or short phrase with a dashboard.
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•
•
•
•
•
•
•

The EventFeed object represents a single feed item in the feed on an event.
The KnowledgeArticleViewStat object provides statistics on the number of views for the specified article across all
article types.
The KnowledgeArticleVoteStat object provides the weighted rating for the specified article on a scale of 1 to 5 across
all article types.
The Report object represents a set of data that meets certain criteria and is displayed in an organized way. Access is
read-only.
The ReportFeed object represents a single feed item in the feed displayed on a report.
The ReportTag object associates a word or short phrase with a report.
The TaskFeed object represents a single feed item in the feed on a task.

Changed Objects
The following objects have been changed in API version 20.0:
•
•

•
•

•
•

The CaseMilestone object includes a StartDate field, which displays the date and time a milestone started on a
case.
The character limit for the Subject field on the Event and Task objects increased from 80 to 255. This change
requires you to update any triggers or other platform validation tools that assume event or task subjects are limited
to 80 characters. If you prefer, you can create a validation rule on the Event or Task Subject field to artificially
limit the subject length.
The FeedComment and FeedPost objects now support search().
The UserLicense object includes two new fields: MonthlyLoginsUsed, which increments whenever a successful
login occurs for any user associated with a customer or partner portal user license, and MonthlyLoginsEntitlement,
which contains the maximum number of customer or partner portal logins allowed per month.
The User object includes a new UserPermissionsSupportUser field, which indicates if a user can use the Service
Cloud console.
The User object includes new fields if Chatter is enabled:
-

•
•

The TerritoryId field in the UserTerritory object is now required for create().
The Attachment object includes these changes.
-

•
•
•

Attachments on tasks or events can't be marked private.
The owner of an attachment on a task or event must be the same as the owner of the task or event.

The ContentVersion object includes a new Origin field, which is the source of the content version.
The P value's label in the PublishStatus field on the ContentDocument and ContentVersion objects, has changed
from Public Workspace to Public.
The CollaborationGroup object includes new fields:
-

•

FullPhotoUrl—The URL for a user's profile photo.
SmallPhotoUrl—The URL for a thumbnail of a user's profile photo.
DigestFrequency—The frequency at which Salesforce.com sends the user’s Chatter personal email digest.

FullPhotoUrl—The URL for the group's profile photo.
MemberCount—The number of members in the group.
SmallPhotoUrl—The URL for a thumbnail of the group's profile photo.

The CollaborationGroupMember object includes a new NotificationFrequency field which is the frequency
at which Salesforce.com sends Chatter group email digests to this member.
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Changed Calls
With API version 20.0, you can process records for multiple object types, including custom objects, in one create()
or update() call. For example, you can create a contact and an account in one call. Previously, you could only process
records for one object type in a call. You can process records for up to 10 objects types in one call.
New AllOrNoneHeader SOAP Header
The AllOrNoneHeader header allows the create(), delete(), undelete(), update(), and upsert() calls to
roll back all changes unless all records are processed successfully. The default behavior is to allow partial success of a call:
records without errors are committed, while records with errors are marked as failed in the call results. This new header
gives you more transactional control over commitment of changes.
Increased Number of Relationships Allowed in a SOQL Query
With Winter '11, you can include 25 relationships in a SOQL query in all API versions. Previously, there was a limit
of 20 relationships. A custom object allows up to 25 relationships, so you can now reference all the relationships in one
query.

API Migration Issues
The following technical notes are available to assist you in migrating from earlier versions:
•
•
•
•
•
•
•

Release 19.0: Web Services API Developer's Guide Version 19.0
Release 18.0: Web Services API Developer's Guide Version 18.0
Release 17.0: Web Services API Developer's Guide Version 17.0
Release 16.0: Web Services API Developer's Guide Version 16.0
Release 15.0: Web Services API Developer's Guide Version 15.0
Release 14.0: Web Services API Developer's Guide Version 14.0
Release 13.0:
http://wiki.developerforce.com/index.php/What%27s_New_in_Force.com_Web_Services_API_Summer_%2708

•

Release 12.0:
http://wiki.developerforce.com/index.php?title=What%27s_New_in_Force.com_Web_Services_API_Spring_%2708

•

Release 11.0:
http://wiki.developerforce.com/index.php/What%27s_New_in_Force.com_Web_Services_API_Winter_%2708

•

Release 10.0:
http://wiki.developerforce.com/index.php/What%27s_New_in_Apex_Web_Services_API_Summer_%2707

•

Release 9.0:

•
•
•
•
•

http://wiki.developerforce.com/index.php/What%27s_New_in_Apex_Web_Services_API_Spring_%2707
Release 8.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-19
Release 7.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-17
Release 6.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-15
Release 5.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-13
Release 4.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-10

Documentation for these earlier versions is also available. See
wiki.developerforce.com/index.php/Earlier_Reference_Documentation on Developer Force for links to

online and PDF versions.
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Bulk API Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

The REST-based Bulk API is optimized to process a large number of records asynchronously. It allows you to load large
batches of data that are processed in the background. The Bulk API has been improved for API version 20.0:

Support for Binary Attachments
With API version 20.0, you can submit batches containing binary attachments, such as Attachment records or Salesforce
CRM Content.

Uploading Binary Attachments in Data Loader
You can now use the Bulk API to upload binary attachments in Data Loader by enabling the Upload Bulk API Batch
as Zip File (enable to upload binary attachments) setting.
For more information about the Data Loader, see “Data Loader Overview” in the Salesforce.com online help.

Increased Number of Daily Batches Allowed
The limit of batches allowed per rolling 24–hour period has been increased from 500 to 1000.

Force.com Development as a Service
Available in: Enterprise, Unlimited, and Developer Editions

Force.com Development as a Service (DaaS) provides the tools and technologies used by professional developers who build
applications for the Force.com platform, as well as those who migrate application changes between development organizations
and production. The DaaS feature area includes support for creating, retrieving, and deploying changes to your organization's
metadata.

Updated Metadata
The following metadata fields have been added or changed in Metadata API version 20.0:
Metadata Type or Related
Object

Field

Change

Description

CustomObject

recordTypeTrackFeedHistory New

CustomObject

recordTypeTrackHistory

New

Indicates whether history tracking is enabled for
this record type (true) or not (false).

CustomSite

siteRedirectMappings

New

An array of all URL redirect rules set for your site.

Indicates whether the record type is enabled for
feed tracking (true) or not (false).
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Metadata Type or Related
Object

Field

Change

Description

Dashboard

dashboardType

Updated

A new valid value has been added:
MyTeamUser—Managers can choose to view the

dashboard from the point of view of their
subordinates in the role hierarchy.
Dashboard

drillToDetailEnabled

New

When enabled, users are taken to the record detail
page when they click a record name, record owner,
or feed post in a table or chart. When set to true
users can click axis and legend values, chart
elements, and table entries. The drillDownUrl
and drillEnabled fields override this field.

Force.com IDE
Available in: Enterprise, Unlimited, and Developer Editions

Winter '11 includes new enhancements to the Force.com IDE. For complete details, visit the Force.com IDE release notes
page at http://wiki.developerforce.com/index.php/Force.com_IDE_Release_Notes.
Note: The Force.com IDE for Winter '11 will be released after all instances have been upgraded. Release notes and
downloads are not available until that time.

Sandbox Enhancements
Available in: Enterprise and Unlimited Editions

Winter '11 includes the following enhancements to sandbox:
Daily Sandbox Refresh
Developer and configuration-only sandboxes can be refreshed every day. The refresh interval for full-copy sandboxes
remains every 29 days.
Sandbox Delete
In previous releases you could only delete sandboxes that exceeded your sandbox limit. Starting in Winter '11 you can
delete sandboxes at any time. Note that you can't create a new sandbox to replace the deleted sandbox until the refresh
interval has passed. For full-copy sandboxes, you can create a replacement sandbox after 29 days. For configuration-only
sandboxes, you can create a replacement sandbox the next day.

Change Sets-Beta
Winter '11 includes the following enhancements to change sets:
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Add Profiles
You can now add profiles settings to change sets. On the detail page of an outbound change set, click Add Profiles.
Component Inspection
Before you upload or deploy a change set, you can view an XML representation of the components. In the case of a
profile, the contents of the profile represented depend on the contents of the change set. For example, profiles only
contain field-level security for fields included in the custom object that are part of the change set.
Validate Deployment
You can perform a test deployment of an inbound change set to view the success or failure messages that would occur
with an actual deployment. This is a good idea if you are planning a deployment on a schedule (for example during
low-use hours) and want to determine if the deployment will succeed ahead of time. You do not need to perform a test
deployment before every time, as this process takes time to complete. To test deploy an inbound change set, click its
name and then click Validate.

Identity Providers and Service Providers
An identity provider is a trusted provider that enables you to use single sign-on to access other websites. A service provider is a
website that hosts applications. You can enable Salesforce.com as an identity provider, then define one or more service providers,
so your users can access other applications directly from Salesforce.com using single sign-on. This can be a great help to your
users: instead of having to remember many passwords, they will only have to remember one. Plus, the applications can be
added as tabs to your Salesforce.com organization, which means users won't have to switch between programs.

Implementation Tips
•
•

You must setup a domain before you can enable Salesforce.com as an identity provider. See “My Domain Overview” in
the Salesforce.com online help.
Salesforce.com uses the SAML 2.0 standard for single sign-on and generates SAML assertions when configured as an
identity provider.

Using Identity Providers and Service Providers
Salesforce.com supports the following:
•
•

Identity-provider-initiated login—when Salesforce.com logs into a service provider at the initiation of the end-user
Service-provider-initiated login—when the service provider requests Salesforce.com to authenticate a user, at the initiation
of the end-user

The following is the general flow when Salesforce.com as an identity provider logs into a service provider.
1. User tries to access a service provider already defined in Salesforce.com.
2. Salesforce.com sends a SAML response to the service provider. The following is an example of a response (you might want
to share this with your service provider):
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3. Service provider identifies the user and authenticates the certificate.
4. If the user is identified, they are logged into the service provider.
The following is the general flow when a service provider initiates login and uses Salesforce.com to identify the user.
1. The service provider sends a valid SAML request. The endpoint is automatically generated when the service provider is
defined—the SP-Initiated POST Endpoint.
2. Salesforce.com identifies the user included in the SAML request.
<samlp:AuthnRequest ID="bndkmeemcaamihajeloilkagfdliilbhjjnmlmfo" Version="2.0"
IssueInstant="2010-05-24T22:57:19Z"
ProtocolBinding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST"
ProviderName="google.com" IsPassive="false"
AssertionConsumerServiceURL="https://www.google.com/a/resp.info/acs">
<saml:Issuer>google.com</saml:Issuer>
<samlp:NameIDPolicy AllowCreate="true"
Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified"/>
</samlp:AuthnRequest>

If a certificate was included as part of the definition, Salesforce.com authenticates the certificate.
Note: If a certificate is included in the service provider definition, and the SAML request does not contain a
certificate, the request fails, and the user is not logged in using Salesforce.com. If the definition does not include
a certificate, and the request includes one, the request succeeds if the user is identified correctly.
3. If the user isn't already logged into Salesforce.com, they are prompted to do so.
4. Salesforce.com sends a SAML response to the service provider.
5. The service provider authenticates the SAML response sent by Salesforce.com. If the user has been authenticated, they
are logged into the service provider. The user is also logged into Salesforce.com.
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Important: Salesforce.com doesn't provide any mechanism for automatically logging the user out of Salesforce.com
when they log out of the service provider.

The following is an example of the SAML response from Salesforce.com. You might want to share this information with your
service provider.
<samlp:Response Destination="https://www.google.com/a/resp.info/acs"
ID="_50ee78c999045eae2d52c58b918f04181274741839516"
InResponseTo="bndkmeemcaamihajeloilkagfdliilbhjjnmlmfo"
IssueInstant="2010-05-24T22:57:19.516Z" Version="2.0">
<saml:Issuer
Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity">wwilber.salesforce.com
</saml:Issuer>
<ds information>
<samlp:Status>
<samlp:StatusCode Value="urn:oasis:names:tc:SAML:2.0:status:Success"/>
</samlp:Status>
−
<saml:Assertion ID="_c460711296b2ad1a139ef55efff2523d1274741839516"
IssueInstant="2010-05-24T22:57:19.516Z" Version="2.0">
<saml:Issuer
Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity">wwilber.salesforce.com
</saml:Issuer>
−
<saml:Subject>
<saml:NameID
Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified">adminqa@resp.info
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</saml:NameID>
−
<saml:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
<saml:SubjectConfirmationData NotOnOrAfter="2010-05-24T23:02:19.516Z"
Recipient="https://www.google.com/a/responder.info/acs"/>
</saml:SubjectConfirmation>
</saml:Subject>
−
<saml:Conditions NotBefore="2010-05-24T22:57:19.516Z" NotOnOrAfter="2010-05-24T23:02:19.516Z">
−
<saml:AudienceRestriction>
<saml:Audience>google.com</saml:Audience>
</saml:AudienceRestriction>
</saml:Conditions>
−
<saml:AuthnStatement AuthnInstant="2010-05-24T22:57:19.516Z">
−
<saml:AuthnContext>
<saml:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:unspecified
</saml:AuthnContextClassRef>
</saml:AuthnContext>
</saml:AuthnStatement>
−
<saml:AttributeStatement>
−
<saml:Attribute Name="userId"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">005D0000001AfDg
</saml:AttributeValue>
</saml:Attribute>
−
<saml:Attribute Name="username"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">admin@wwilber-NR.com
</saml:AttributeValue>
</saml:Attribute>
−
<saml:Attribute Name="email"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">wwilber@salesforce.com
</saml:AttributeValue>
</saml:Attribute>
−
<saml:Attribute Name="is_portal_user"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">false
</saml:AttributeValue>
</saml:Attribute>
</saml:AttributeStatement>
</saml:Assertion>
</samlp:Response>

OAuth Version 2.0 Supported
Starting in Winter '11, Salesforce.com supports version 2.0 of the OAuth protocol for authenticating Web applications that
access data in a Salesforce.com instance.
Salesforce.com supports a number of authentication flows for OAuth 2.0, so you can authenticate users of web applications
using JavaScript, redirects, or mobile applications.
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Implementation Tips
•

Select the appropriate authentication flow for your applications:
-

-

-

Web server flow—The Web server authentication flow is used by applications that are hosted on a secure server. A
critical aspect of the Web server flow is that the server must be able to protect the consumer secret.
User-agent flow—The user-agent authentication flow is used by client applications (consumers) residing in the user's
device. This could be implemented in a browser using a scripting language such as JavaScript, or from a mobile device
or a desktop application. These consumers cannot keep the client secret confidential.
SAML assertion flow—The SAML assertion flow is an alternative for organizations that are currently using SAML
to access Salesforce.com using single sign-on, and want to access the Web services API the same way. The SAML
assertion flow can only be used inside a single organization. You do not have to create a remote access application to
use this assertion flow.
Username-password flow—The username-password authentication flow can be used as a replacement for an existing
login when the consumer already has the user's credentials.
Caution: This authentication flow involves passing the user's credentials back and forth. Salesforce.com
recommends using this authentication flow only when necessary.

•

After the consumer has been authorized for access, they can use a refresh token to get a new access token (session ID.)
This is only done after the consumer already has received an access token using either the Web server or user-agent flow.

Best Practices
•
•

Only use the username-password authentication flow when absolutely necessary.
In the user-agent flow, if you are authenticating using JavaScript, Salesforce.com recommends calling
window.location.replace(); to remove the callback from the browser’s history.

Force.com Sites Enhancements
Available in: Developer, Enterprise, and Unlimited Editions

Winter '11 includes new features that improve the capabilities of Force.com sites. To access these features, sites must be
enabled for your organization. Winter '11 enhancements for sites include:
Sites URL Redirects
If you move or reorganize pages on your Force.com site, search engines may have trouble finding the new page locations.
To avoid this, set up site URL redirects to inform users and search engines that site content has moved.
Sites Self-Registration
You can create and enable a person account as a Customer Portal user using the createPersonAccountPortalUser
Apex method. Use createPersonAccountPortalUser to create a person account using either the default record
type defined on the guest user's profile or a specified record type, then enable it for the site's portal. Person Accounts
can only be enabled as high-volume portal users. For more information, see the Force.com Apex Code Developer's
Guide. For more information on high-volume Customer Portal users, see “Granting High-Volume Portal Users Access
to Records” in the Salesforce.com online help.
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Customizable My Profile Page
The My Profile page is a new Visualforce page for your Force.com site and Customer Portal. The My Profile page
enables users logged into either your Force.com site, or your Customer Portal from Force.com sites, to update their own
contact information. When they make changes to this page, the corresponding portal user and contact records are
updated.

About the Sites Enhancements
Sites URL Redirects
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed
To create and edit site URL redirects:

“Customize Application”

To view site URL redirects:

“View Setup”

If you move or reorganize pages on your Force.com site, search engines may have trouble finding the new page locations. To
avoid this, set up site URL redirects to inform users and search engines that site content has moved.
Consider the following while implementing site URL redirects:
•
•
•
•

You can't redirect error pages.
Each site can have a maximum of 1,000 redirect rules.
Query parameters in site URL redirects are matched exactly.
If you have URL rewriting enabled on your site, it runs after any site page redirects. For more information about the
Site.UrlRewriter Apex interface, see the Force.com Apex Code Developer's Guide.

To assign a redirect to a site page:
1.
2.
3.
4.

Click Your Name ➤ Setup ➤ Develop ➤ Sites.
Click a site label.
Click URL Redirects on the site detail page.
Specify the former page location in the Source URL field. The page location must:
•
•

Be a relative URL. It can have any valid extension type, such as .html or .php.
Not contain anchors, such as /siteprefix/page.html#target.
Note: Organizations that use sites with prefixes must manually add the prefix to the Source URL and Target URL
fields. Also, if your organization has a root level site and one with a prefix, and you want to redirect a page in your
prefixed site but don't include the prefix in the redirect rule, Salesforce.com will default to looking for the rule in
your root site instead, resulting in a 404 error.

5. Specify the Redirect Type:
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•

•

Permanent (301)—Select this option if you want users and search engines to update the URL in their systems when
visiting the page. Users visiting a page redirected with this type are sent seamlessly to the new page. Using a permanent
redirect ensures that your URLs retain their search engine popularity ratings, and that search engines index the new
page and remove the obsolete source URL from their indexes.
Temporary (302)—Select this option if you want users and search engines to keep using the original URL for the page.
Search engines interpret a 302 redirect as one that could change again at any time, and though they index and serve up
the content on the new target page, they also keep the source URL in their indexes.

6. Specify the new page location in the Target URL field. This can be a relative URL or a fully-qualified URL with an
http:// or https:// prefix. Unlike source URLs, target URLs can contain anchors.
7. Click Save.
The Redirect Rules section displays all URL redirect rules you've created for your site. In this section you can:
•
•
•
•

Edit an assigned redirect rule.
Activate or deactivate a redirect rule.
Delete a redirect rule.
Click the Source URL or Target URL column heading to sort the list in ascending or descending order.

Customizable My Profile Page
Available in: All Editions

With Winter '11, the My Profile page is available. It is a new Visualforce page for your Force.com site and Customer Portal.
The My Profile page enables users logged into either your Force.com site, or your Customer Portal from Force.com sites, to
update their own contact information. When they make changes to this page, the corresponding portal user and contact records
are updated.
You can enable the My Profile page in two ways. The first way only enables the page for specific profiles. The second way
enables the page for the entire site:
1. Enable the My Profile page for specific profiles:
a.
b.
c.
d.
e.

Click Your Name ➤ Setup ➤ Manage Users ➤ Profiles.
Click the name of the profile you want to modify.
In the Enabled Visualforce Page Access related list, click Edit.
Select MyProfilePage from the Available Visualforce Pages list and click Add.
Click Save.

For more information, see “Setting Visualforce Page Security” in the Salesforce.com online help.
2. Add the My Profile page to your site's detail page:
a.
b.
c.
d.
e.

Click Your Name ➤ Setup ➤ Develop ➤ Sites.
Click the name of the site you want to modify.
Click Edit on the Site Visualforce Pages related list.
Use the Add button to add the My Profile page to your site.
Click Save.

For more information, see “Managing Force.com Site Visualforce Pages” in the Salesforce.com online help.

127

Force.com

Additional Force.com Enhancements

The My Profile page is also delivered as part of the Customer Portal Welcome component on your home page layout. To
enable the component:
1.
2.
3.
4.
5.
6.
7.

Click Your Name ➤ Setup ➤ Customize ➤ Home ➤ Home Page Layouts.
Click Edit next to the layout you want to add My Profile to.
Select Customer Portal Welcome.
Click Next.
Place the Customer Portal Welcome component where you want it.
Optionally, click Preview to display the home page layout.
Click Save.

For more information, see “Designing Home Tab Page Layouts” in the Salesforce.com online help.

Additional Force.com Enhancements
Browser Support Updates
Available in: All Editions
With Winter '11, Salesforce.com now supports Apple® Safari version 5.0.x and Mozilla Firefox version 3.6.x. For more
information, see “Supported Browsers” in the Salesforce.com online help.

Custom Field Enhancements
Winter '11 includes these enhancements for custom fields:
API Name Shown for Custom Fields
Available in: Enterprise, Unlimited, and Developer Editions

In Winter ‘11, you can view a custom field's API name on the Custom Fields & Relationships related list of the standard
object's fields page or the custom object's detail page.
Rich Text Area Field Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

In Winter ‘11, rich text area fields have two enhancements.
•
•

Inline editing is now supported for rich text area fields on detail pages.
You can upload images to a rich text area field from the Salesforce.com API version 20 or later.
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Changes to rounding in number fields
Available in: Enterprise, Unlimited, and Developer Editions

In Winter ‘11, number fields use the round half up tie-breaking rule. Rounding in Salesforce.com numeric fields are as
follows:
•
•
•

Currency fields use the round half even rule. For example, 23.5 becomes 24, 22.5 becomes 22, −22.5 becomes −22,
and −23.5 becomes −24.
Formula fields with numeric values use the round half up tie-breaking rule for numbers in formula fields. For example,
12.345 becomes 12.35 and −12.345 becomes −12.34.
Number fields use the round half up tie-breaking rule for numbers in formula fields. For example, 12.345 becomes
12.35 and −12.345 becomes −12.34.

Custom Settings Data Limits Change
Available in: Group, Personal, Developer, Enterprise, and Unlimited Editions.

The total amount of cached data allowed for your organization is the lesser of these two values:
•
•

10 MB
1 MB multiplied by the number of full-featured user licenses in your organization

For example, if your organization has 3 full licenses, you have 3 MB of custom setting storage. If your organization has 6 full
licenses, you have 10 MB of storage.
In addition, to see how much custom settings data your organization is using, click Your Name ➤ SetupDevelopCustom
Settings.

Packaging Enhancements
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Winter '11 includes these enhancements for packaging:
API Access Privileges on Unmanaged Packages
In Winter ‘11, API Access Privileges are no longer available on unmanaged packages in development. API Access
Privileges will still be available on existing and newly installed unmanaged packages. API Access Privileges for unmanaged
packages is scheduled to be de-supported entirely in Spring '11. In order to continue to use API Access Privileges, the
unmanaged package must be converted to a managed package by the package developer. Managed packages offer an
increased level of security compared to unmanaged packages.
Article Types
Article Types are now packageable. When adding components to your package, custom fields and the default page layout
are automatically added.
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Field History Tracking Settings
Field History Tracking Settings are now packageable. If tracking is enabled on a field, the tracking history is automatically
packaged.

Language Translation for Force.com
Available in: Enterprise, Unlimited, and Developer Editions

Beginning with this release, platform languages are available for organizations that use Salesforce.com exclusively as a platform.
Platform languages are languages that you can translate your customizations into but Salesforce.com provides no default
translations. Administrators must contact their salesforce.com representative to enable platform languages.
Platform languages are available in all of the places one can select language in the application, but selecting a platform language
will default all labels in the application to English. All customizations made to Salesforce.com can be translated into a platform
language and renaming can be used to provide translations for standard field names on most objects. However, informative
text and non-field label text is not translatable.
English (Australia): en_AU
English (Canada): en_CA
English (India): en_IN
English (Malaysia): en_MY
English (Philippines): en_PH
French (Canada): fr_CA
Georgian: ka
Norwegian: no
Serbian (Latin): sh
Slovak: sk
Serbian (Cyrillic): sr

•
•
•
•
•
•
•
•
•
•
•

Arabic and British English Support
Available in: Enterprise, Unlimited, and Developer Editions

In Winter '11, Salesforce.com implemented two new user languages: English (UK) and Arabic (ar), a language read from right
to left.
Administrators must contact their salesforce.com representative to enable end-user languages. Right-to-left languages must
be specifically requested. Users can update their personal language settings as follows:
1.
2.
3.
4.

Go to Your Name ➤ Setup ➤ My Personal Information ➤ Personal Information.
Click Edit.
Select a language from the Language picklist.
Click Save.

Security Enhancements
Winter '11 includes these security enhancements:
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Configure Start, Login, and Logout Pages Using Single Sign-On
Available in: All Editions

Prior to Winter '11, after an administrator determined the URLs for the start, login, and logout pages for single sign-on,
they had to share that information with their identity provider, who would then use those URLs in the SAML assertion.
Now, for SAML 2.0 only, an administrator can specify those URLs during the single sign-on configuration.
Enforce Password History Now Can Remember Up To 10 Passwords
Available in: All Editions

As part of your organization's password policies, you can now set Enforce Password History to remember up to 10
passwords.
Federation ID Only Displays To Users With Adequate Permission
Available in: All Editions

Prior to Winter '11, the Federation ID field always displayed on the Personal Information page. Now the field only
displays if the current user has permission to edit the field.
Session Time Out Clarification
Available in: All Editions

When you set a time out value for user sessions, note that the session is not updated until half the time is used. For
example, if you set the value for 30 minutes, update a record after 10 minutes, then sit idle, after another 20 minutes the
session times out (total of 30 minutes.) If you update a record after 20 minutes, then sit idle, the session won't time out
for an additional 30 minutes (total of 50 minutes.)
Remote Access Application Logo URL Size Defined
Available in: All Editions

When you define a remote access application, the logo used for Logo Image URL must now be 200x125 pixels, on a
white background.
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User Interface Setting Name Change
Available in: Enterprise, Unlimited, and Developer Editions

In Winter '11, the User Interface setting Enable Enhanced Profile Management has changed to Enable Enhanced
Profile List Views. The functionality has not changed. To access this setting, click Your Name ➤ Setup ➤ Customize
➤ User Interface.
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